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INTRODUCTION 
 
This hydrographic project was completed as specified by Hydrographic Survey Letter Instructions OPR-O168-
FA-07, signed September 25, 2007.  This Data Acquisition and Processing Report includes project level 
information common to sheet A (H11759) and sheet B (H11760).  

All sheets have the general locality of Endicott Arm and are located in the state of Alaska.   
 
Survey specific details will be listed in Descriptive Reports as needed.  Unless otherwise noted, the acquisition 
and processing procedures used and deliverables produced are in accordance with the Standing Instructions for 
Hydrographic Surveys, April 3, 2006, the NOAA Hydrographic Survey Specifications and Deliverables Manual 
(HSSDM) April 2007, and the Field Procedures Manual (FPM), March 2007.  Hydrographic Surveys Technical 
Directives (HTD) 2004-1, and 2007-3 through 2007-9 were followed during the course of this project. 

A EQUIPMENT 
 
Detailed descriptions of the equipment and systems, including hardware and software, used for bathymetric data 
acquisition, horizontal and vertical control operations, shoreline acquisition, and processing are listed below. 
 
1.0 Hardware 
 
The hardware listed in this section was used during project OPR-O168-FA-07. 

1.1 Hardware Systems Inventory 
 
Detailed hardware information, including installation dates and serial numbers, is included in Appendix I of this 
report. Manufacturer’s product specifications are included in Appendix II. 

1.2 Echo Sounding Equipment 

1.2.1 Reson 8111ER Multibeam Echosounder (MBES) 
 
FAIRWEATHER is equipped with a RESON SeaBat 8111 MBES with the Extended Range (ER) and snippet 
options.  The 8111ER is a 100 kHz multibeam system with swath coverage of 150°.  The swath is made up of 101 
discrete beams with an along-track and across-track beamwidth of 1.5°.  The typical operational depth range of 
the 8111ER on the FAIRWEATHER is 20 to 600 meters.  No calibration information was provided by the 
manufacturer for the system. 
 
The 8111ER is hull-mounted within a reinforced projection that extends 27 inches below the keel.  It is located 
39.5” starboard of the centerline at approximately frame 29.  It has a specified depth range of 3 to 1200 meters. 
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Figure 1: RESON SeaBat 8111ER MBES Figure 2: RESON SeaBat 8111ER MBES on 

FAIRWEATHER 
 
 

  
Figure 3: RESON SeaBat 8160    Figure 4: RESON SeaBat 8160 on FAIRWEATHER 

1.2.2 RESON 8160 Multibeam Echosounder (MBES) 
 
FAIRWEATHER is equipped with a RESON SeaBat 8160 MBES with the snippet option.  The 8160 is a 50 kHz 
multibeam system with a swath coverage of greater than 4x water depth.  Each swath is made up of 126 discrete 
beams with an along-track and across-track beamwidth of 1.5°.  It has a specified depth range of 10 to 3000 
meters.  No calibration information was provided by the manufacture for the system. 
 
The 8160 is hull-mounted within a reinforced projection that extends 13.6 inches below the keel.  It is located 54 
inches port of the centerline at approximately frame 29.   

1.2.3 RESON 8101ER Multibeam Echosounder (MBES) 
 
Survey Launches 1010 and 1018 are each equipped with a RESON SeaBat 8101 MBES with the Extended Range 
and snippet option.  The 8101ER is a 240 kHz multibeam system with swath coverage of 150°.  The swath is 
made up of 101 discrete beams with an along-track and across-track beamwidth of 1.5°.  It has a specified depth 
range of up to 500 meters.  The typical operational depth range of the 8101 on launches 1010 and 1018 in 2006 
was 3 to 120 meters.  Under optimal conditions with a hard bottom, high power and high gain, the depth range of 
the 8101 ER was observed to be as deep as 350 m producing a swath of ±45º from nadir.  No calibration 
information was provided by the manufacturer for the system. 
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Each system is attached to a launch using a swing mount which is starboard of the keel and approximately 
centered fore and aft (see Figures 5 & 6).   
 

  
     Figure 5: Launch 1010 with 8101 extended        Figure 6: Launch 1010 with 8101 retracted 

 

1.3 Manual Sounding Equipment – Lead Lines 
 
Vessels 1010, 1018, 1706, and 2302 are each equipped with a lead line.  Lead lines are mainly used for depth 
measurements near shore and for echosounder depth comparison.   
 
Lead lines were created, measured and calibrated according to Section 1.5.3 of the FPM with the exception that 
the lines were calibrated to the meter instead of decimeter.  Calibration was performed during March and April 
2007.  Calibration reports for the lead lines are included in Appendix V.     

1.4 Positioning, Heading, and Attitude Equipment 

1.4.1 TSS Positioning and Orientation System for Marine Vehicles (POS/MV) 
 
FAIRWEATHER and her launches are each equipped with a TSS POS/MV 320 V4, configured with 
TrueHeave™ and Precise Timing.  The POS/MV calculates position, heading, attitude, and vertical displacement 
(heave) of a vessel.  It consists of a rack mounted version 2.12 POS Computer System (PCS), a strap down IMU-
200 Inertial Measurement Unit (IMU), and two GPS antennas corresponding to GPS receivers in the PCS.  The 
port side antenna is designated as the primary receiver, and the starboard side antenna is the secondary receiver.  
Differential correctors are supplied to the POS MV by a CSI wireless MBX-3S Automatic Differential GPS 
receiver. On May 6, 2007 (DN 126) FAIRWEATHER changed the POS MV firmware to version 3.41 and the 
controller software to version 3.4.0.0. 
 
For all multibeam systems aboard FAIRWEATHER and her launches, timing between the sonar swath, position, 
heading and attitude information was synchronized by utilizing the TSS POS/MV 320 v.4’s.  A timing string was 
sent from the POS/MV to the RESON topside unit and to the ISIS computer recording the incoming data.  Vessel 
wiring diagrams are included in Appendix III. 
 
POS/MV controller software was used to monitor position accuracy and quality during data acquisition.  This 
ensured that positioning accuracy requirements were met, as outlined in the HSSDM.  The POS/MV controller 
software provides clear visual indications whenever accuracy thresholds are exceeded.   
 
During acquisition, several IMU failures were noted.  There were no actual IMU failures; instead, problems with 
the POS/MV PCS unit were detected.  Due to the suspected hardware problem on the POS/MV PCS unit in launch 
1018, it was swapped with the ship’s POS/MV PCS on the evening of September 22, 2007.  POS/MV PCS serial 
number 2411 was removed from the ship and installed on Launch 1018, while POS/MV PCS serial number 2560 
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was removed from Launch 1018 and installed on the ship.  On October 29, 2007, two replacement POS/MV 
PCS’s were obtained.  The ship’s original PCS was replaced, 2411.  Launch 1010 received unit 2254 to replace 
unit 2564.  Launch 1018 received unit 2438 to replace unit 2560.  The POS/MV PCS serial number 2560 was later 
confirmed to be malfunctioning and was repaired by Applanix. 

1.4.2 POS/MV GAMS Calibration 
 
GAMS (GPS Azimuth Measurement Sub-system) calibrations were performed on each of the three POS/MV 
units.  The GAMS calibration procedure was conducted in accordance with instructions in chapter 4 of the 
POSMV V4 Installation and Operation Guide, 2005.  Results are included in the individual vessel reports and 
spreadsheets, with calibration details located in Appendix III-5. 
  

 

 
        Figure 7: POS/MV antennas on 1018                           Figure 8: POS/MV antennas on 1010 
 

1.4.3 CCSI Wireless MBX-3S DGPS Receiver 
 
FAIRWEATHER is equipped with commercial grade CSI Wireless MBX-3S DGPS Receivers that are used in 
conjunction with TSS POS/MV to provide vessel positioning during data acquisition.  The DGPS receivers are 
configured in manual mode to allow reception of only one U.S. Coast Guard (USCG) differential GPS beacon 
station.  Beacons used for a given survey will be reported in individual descriptive reports.  Vessel wiring 
diagrams are in Appendix III. 
 
Differential GPS (DGPS) was the sole method of positioning.  Differential corrections from the U.S. Coast Guard 
beacons at Annette Island (323 kHz), Gustavus (288 kHz) and Level Island (295 kHz) were used. 
  

1.4.4 Trimble Backpack 
 
FAIRWEATHER uses two GPS Pathfinder® Pro XRS receivers in conjunction with a field computer to acquire 
detached and generic positions during shoreline verification in the field.  Data can also be collected with a 
handheld TSCe data collector.  FAIRWEATHER’s field computers consist of three Panasonic CF-18 Tuffbooks 
and one CF-29 Tuffbook. The receivers have integrated beacon/satellite differential antennas which allow access 
to digital real-time sub-meter accuracy solutions.  Data quality assurance testing was conducted by 
FAIRWEATHER personnel in April 2007.  The Trimble backpack GPS unit testing was combined with the 
Ashtech testing and the results are located in the Positioning Equipment Confidence Check file in Appendix V.   
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Figure 9: Trimble Backpack Unit 

1.4.5 Impulse LR Hand-held Laser 
 
The Impulse Laser Rangefinder and TruPulse 200 Laser Rangefinder are used in conjunction with the Trimble 
Backpack GPS unit to acquire distances and heights during shoreline verification.  These data are entered directly 
into the TerraSync shoreline acquisition software and annotated on the detached position forms.  The Impulse LR 
and TruPulse 200 Laser Rangefinder do not function properly in low light or in choppy seas when a feature is not 
distinguishable from surroundings.  
 

   
                  Figure 10: IMPULSE LR laser                    Figure 11: TruPulse 200 Laser Rangefinder 
 
Data quality assurance testing was conducted on the Impulse LR on  February 27, 2006 by FAIRWEATHER 
personnel.  Comparison testing among the Laser Rangefinder, the TruPulse 200 Laser Rangefinder and the 
Trimble Backpack units was performed on March 3, 2006.  Vertical and horizontal readings were taken with the 
laser level and compared to measurements taken with a fifteen meter steel tape and a graduated metric staff.  
Three marks were placed on the staff with SOLAS reflective tape in order to get a good fix.  The laser level was 
set up on a bipod at 10, 20, 50 and 100 meter intervals from the staff.  Three horizontal and three vertical readings 
were taken at each interval.  The results of the testing are located in Appendix V. 
 
The laser levels were tested less extensively in 2007 but their accuracy was verified by using them to obtain an 
offset to BM NO 37 at the USCG ISC Ketchikan facility in the horizontal positioning equipment check of the 
Trimble backpack units and the Ashtech Z-Xtreme receiver.  

1.5 Sound Velocity Equipment 

1.5.1 SBE 19plus SEACAT Profiler 
 
FAIRWEATHER is equipped with three SBE 19plus SEACAT sound velocity profilers used to acquire 
conductivity, temperature, and depth (CTD) data in the water column to determine the speed of sound through 
water.  Two of the SBE 19plus profilers have pressure sensors rated to 1000 meters.  The third has a pressure 
sensor rated to 3,500 meters.  
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The SBE 19plus SEACAT sound velocity profilers were calibrated by the manufacturer and current calibration 
files were returned with the units.  Calibration files for 2007 are located in Appendix V.   
 
Periodic quality assurance checks include comparison casts between CTD instruments.  Data quality assurance 
(DQA) checks include comparison casts between two instruments as per section 1.5.2.2 of the FPM for each 
survey.  Results of the comparison casts are located in the SV_Maintenance and Testing_2007.xls file in Appendix 
VI.   

1.5.2 SBE 45 Micro Thermosalinograph (TSG) 
 
FAIRWEATHER is equipped with one SBE 45 MicroTSG.  The SBE 45 uses continuously pumped sea water to 
measure conductivity and temperature near the ship’s hull mounted transducers.  The intake is located 9 feet 
below the DWL (13 ft) between frames 11 and 12.   
 
The conductivity and temperature information is converted to sound velocity and output to the RESON 8160’s 
and 8111’s processing units.  The 8160 requires sound velocity information for beam forming and pitch 
stabilization while the 8111 only requires it for pitch stabilization.  The 8160 cannot be used to acquire data 
without real time sound velocity information.  The calibration report is included in Appendix V. 

1.5.3 Moving Vessel Profiler 200 
 
A Brooke Ocean Technology, Ltd. (BOT) Moving Vessel Profiler 200 (MVP200) is mounted in the aft starboard 
corner of the fantail (see Figure 12).  The MVP200 system is a self contained sound velocity profiling system 
capable of sampling water column profiles to 200m depth from a vessel moving up to 12 knots.  The system is 
configured with a Single Sensor Free Fall Fish (SSFFF) outfitted with an Applied Microsystems Ltd. Sound 
Velocity and Pressure Smart Sensor.  Deeper profiles can be obtained by reducing the vessel speed.  When the 
vessel is holding station, the system is capable of recording casts over 600m in depth. 
 
The MVP system consists of a winch, cable, fish (the towed unit with the sound velocity sensor), support 
assembly, and controlling hardware and software. During ship acquisition, the fish is deployed using the on-deck 
controller and towed with enough cable out to keep the fish 3-5 m below the water surface. A “messenger” (a 
short cable-thickening sleeve) is set to allow the system to keep the appropriate amount of cable out and is reset as 
needed when the ship acquisition speed is altered. 
 
During SVP acquisition, the controlling computer application, BOT MVP version 2.26 is used to control the MVP 
system and to acquire SVP data. MVP allows for three acquisition modes: 1) automatic continuous multiple cast 
freefall casting while at speed, 2) single cast freefall casting while at speed, and 3) single cast winch speed casting 
while stationary. The user limits the depth to which the fish will fall by setting 1) the depth-off-bottom and 2) the 
maximum depth.  Either single, individually initiated casts can be performed at the discretion of the Hydrographer 
or the auto deploy function can be enabled and set with varying intervals (every 2 minutes, for example) for 
deployment. 
 
Periodic quality assurance checks include comparison casts between the MVP and one of the SBE 19plus 
SEACATs.  Data quality assurance (DQA) checks include comparison casts among the instruments as per section 
1.5.2.2 of the FPM for each survey.  A record of the DQA tests performed aboard the ship is kept and is included 
in Appendix VI.   
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Figure 12: FAIRWEATHER’s MVP200 sound velocity system 

1.6 Vertical Control Equipment 

1.6.1 Water Level Gauges 
 
Three Sutron 8210 tide gauges are provided to FAIRWEATHER by the Center for Operational Oceanographic 
Products and Services (CO-OPS).  These gauges are equipped with Paros Scientific Sensors (SDI-12) for pressure 
measurements.  The tide gauges are checked annually by CO-OPS Field Operations Division personnel to ensure 
that their accuracy standards are being met.  
 
CO-OPS does not provide calibration or quality assurance documentation to the FAIRWEATHER.  
FAIRWEATHER personnel are responsible for installation and removal of the water level gauges.  CO-OPS is 
responsible for delivering final approved vertical correctors to the field unit or processing branch for application 
to the hydrographic data set.  As FAIRWEATHER received new gauges, data quality assurance checks were 
conducted to ensure full functionality prior to deployment. 

1.6.2 Leveling Equipment 
 
FAIRWEATHER is equipped with four universal automatic levels (two Zeiss NI2 333 and two Leica NA2 100) 
and graduated metric staffs to assist in leveling tide gauges.   
 
A Kukkamaki procedure is performed prior to leveling in order to verify the collimation error.  Procedures were 
followed as described in the User’s Guide for the Installation of Bench Marks and Leveling Requirements for 
Water Level Stations, October 1987.  Kukkamaki results for 2007 are located in the Tides folder in Appendix V.     

1.7 Horizontal Control Equipment 
 
FAIRWEATHER is equipped with one Ashtech Z-Xtreme dual-frequency GPS receiver used for the positioning 
of tidal benchmarks, aids to navigation and portable DGPS reference stations (Fly-Away).  The Ashtech Z-Xtreme 
12 channel, L1/L2 receiver is connected to 4 Ashtech Geodetic GPS antennas.  
 
The antennas can be equipped with an optional ground plane and mounted on fixed height Seco GPS tripods.    
 
Data quality assurance testing of the Horizontal Control equipment was performed on 14 March 2007 (DN073) by 
FAIRWEATHER personnel. The Ashtech Z-Xtreme GPS receiver (SN ZE1200339016) was set up over 
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Benchmark No. 37 in Ketchikan, AK using a Seco fixed height tripod.  Data was collected for 2 hours 30 minutes 
and submitted to OPUS which returned an ultra rapid solution position the same day.  The OPUS position was less 
than a centimeter off the published NGS Control Point for BM No. 37.   The OPUS solution and a map of the 
results of the test (Positioning Equipment Confidence Check) are located in Appendix V.  Accuracy standards 
have been met according to NOAA Technical Memorandum NOS NGS-58. 
 
Horizontal control equipment serial numbers and installation dates are located in the hardware section of 
Appendix I, System Tracking.   
 
2.0 Software 

2.1 Software Systems Inventory 
 
An extensive software inventory with documentation, of the software systems used by the NOAA ship 
FAIRWEATHER, is maintained as a Survey Software spreadsheet and included in Appendix I.  This spreadsheet 
includes specifics such as software applications, versions, and hot fixes, in addition to dates loaded on specific 
computers within the survey department. 

2.2 Data Acquisition Software  

2.2.1 Isis Sonar/ BathyPro/ DelphMap/ DelphNav 
 
The FAIRWEATHER uses the Triton Imaging Inc. software packages Isis Sonar and Sonar Suite to acquire 
multibeam echo sounder and backscatter data on all of its multibeam platforms.  Sonar Suite has two software 
packages, DelphNav and DelphMap, which work together along with Isis Sonar to produce real time data 
planning, acquisition, and execution.  
 
Triton Imaging BathyPro is an add-on package for Isis Sonar which processes XTF data real-time to produce 
DTMs supported by DelphMap.  Triton Imaging DelphNav is an add-on package to DelphMap used for line 
planning and vessel navigation.  Triton Imaging DelphMap is a stand-alone GIS program which combines 
georeferenced bathymetric digital terrain models and reference files such as raster charts and vector shoreline files 
to display real-time bathymetric bottom coverage.  

2.2.2 TerraSync/ Pathfinder Office 
 
For GPS positioning and shoreline verification FAIRWEATHER uses two Trimble Navigation Limited software 
programs: TerraSync 2.41 and GPS Pathfinder 3.1.   
 
GPS Pathfinder is run on a Microsoft Windows operating system and is used to manage and process Trimble GPS 
data, transfer files to and from GPS receivers and handheld data collectors, and export processed data.   
 
Trimble TerraSync 2.41 supports a data dictionaries built with S57 objects and attributes and georeferenced TIFF 
images. The georeferenced TIFF images are used for reference and navigation purposes as well as for immediate 
S-57 attribution of positions in the field.  TerraSync is installed and configured for data collection on all of the 
Tuffbook field computers, the TuffTab, and the TSCe handheld computer. 
 
GPS precision masks in TerraSync using the following parameters:  

• Horizontal Dilution of Precision (HDOP) ≤ 2.5 
• Signal-to-Noise Ratio (SNR) ≥ 4 
• Elevation Mask ≥ ~8°-15° (varies by location) 

 
Differential GPS correction is applied in real-time, using the unit’s integrated beacon as the first choice corrector, 
and specifying “wait for real-time” as the secondary option.  Positions are filtered so that only those with a 
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minimum of 4 satellites (3D position), and HDOP ≤ 2.5, and Positional Dilution of Precision (PDOP) ≤ 6 will be 
recorded.  

2.3 Data Processing Software 

2.3.1 NOAA Hydrographic Systems and Technology Programs (HSTP) Software 
 
Sound velocity data is processed with Velocwin, in-house software produced and maintained by NOAA’s 
Hydrographic Systems and Technology Programs (HSTP) division.  Velocwin creates and archives water column 
profiles, performs quality assurance, and processes pressure based depth data.  Velocwin creates a standard file 
format across NOAA’s hydrographic fleet for sound velocity profiles applied to shallow water multibeam and 
single beam data.  
 
Pydro, another NOAA program produced and maintained by HSTP, is used to process features such as detached 
positions (DP), generic positions (GP), and Automated Wreck and Obstruction Information System (AWOIS) 
contacts. PYDRO also converts and attributes features according to S-57 standards for insertion into CARIS 
Notebook.  

2.3.2 CARIS 
 
CARIS HIPS™ (Hydrographic Information Processing System) is used to process all shallow water multibeam 
data including data conversion, filtering, sound velocity, tide correcting, merging and cleaning. CARIS HIPS also 
calculates the Total Propagated Error (TPE) used to produce Bathymetry Associated with Statistical Error (BASE) 
surfaces which assist the Hydrographer in data cleaning and analysis.   
 
CARIS Notebook™ is used to compile and display source shoreline, shoreline updates and S-57 features imported 
from Pydro.  The .hob files created in Notebook are the current shoreline deliverables.    

2.3.3 Fledermaus™ 
 
Fledermaus ™, an Interactive Visualization Systems 3D™ (IVS 3D) program, is used for data visualizations and 
creation of data quality control products, public relations material and reference surface comparisons.  As an 
additional data quality assurance check, Fledermaus ™ may be used to examine the CARIS surfaces prior to 
submission.   

2.3.4 MapInfo™ 
 
MapInfo™ is used to review tables and workspaces associated with assigned projects received from Hydrographic 
Survey Division (HSD).  MapInfo may also be used to produce scaled plots produced for public relation purposes.  
HydroMI, an HSTP produced MapBasic program, is used through MapInfo to convert tide and tidal zoning files 
into a format that is useable in CARIS HIPS, and obtain latitude/longitude coordinates for pre-survey planning.  
 
3.0 Vessels  

3.1 Vessel Inventory 
 
The NOAA Ship FAIRWEATHER (S220) and her survey launches 1010 and 1018 are equipped to acquire 
multibeam echosounder (MBES) and sound velocity profile (SVP) data.  Launch 1018 is also the primary vessel 
for dive operations.  The AMBAR (2302) and Monarch (1706) are used during shoreline verification, bottom 
samples, and horizontal and vertical control operations.   All vessels except the ship were used in support of tide 
gauge operations.  See Appendix I for the complete vessel inventory. 
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3.2 Noise Analysis 
 
The FAIRWEATHER sonar system RESON 8111ER underwent noise analysis testing on October 11, 2004.  The 
results are used during acquisition to enhance data quality and are included in Appendix III-S220-7.  Standard 
operating procedures utilizing the RESON 8111ER aboard the FAIRWEATHER have survey speeds set to 
minimize noise based on the noise analysis. 

                 
4.0 Data Acquisition 

4.1 Horizontal Control 
 
A complete description of horizontal control for the project can be found in the OPR-O168-FA-07 Horizontal and 
Vertical Control Report (HVCR), submitted under separate cover. 
 
The horizontal datum for this project is the North American Datum of 1983 (NAD83).   
 
Multibeam and shoreline data were differentially corrected in real time using correctors provided by Coast Guard 
beacons at Gustavus (288 kHz) or Level Island (295 kHz).  If loss of the differential beacon resulted in any data 
being recorded with C/A GPS positions it will be noted in the descriptive report for the survey.   
 
Specific DGPS quality control checks were not performed during this project.  Based on correspondence between 
personnel from the Hydrographic Systems and Technology Program and FAIRWEATHER, system checks were 
deemed unnecessary.  Refer to correspondence included in Appendix VII. 

4.2 Multibeam Echosounder Acquisition and Monitoring Procedures 
 
Methods of acquisition took into consideration system performance limitations, the bottom topography, water 
depth, and the ability of the vessel to safely navigate the area.   
 
All multibeam data were acquired in Triton Elic’s extended transfer format (XTF) and monitored in real-time 
using the 2-D and 3-D data display windows and the on-screen displays for the RESON SeaBat 8101ER and 
8111ER.  Adjustable parameters that were used to control the RESON from the ISIS software include range scale, 
power, gain, and pulse width.  Vessel speed was also adjusted as needed to eliminate noise from the data.  These 
parameters were adjusted as necessary to ensure best data quality.   Additionally, vessel speed was adjusted as 
necessary to ensure the required along-track coverage for object detection in accordance with the HSSDM.  Survey 
personnel follow standard operating procedures documented aboard the FAIRWEATHER while setting and 
utilizing the RESON systems and Isis for acquisition of data. 
 
Mainscheme multibeam sounding lines using the RESON SeaBat 8111ER were generally run parallel to the 
contours at a line spacing approximately three to four times the water depth.  For discrete item developments, line 
spacing was reduced to 2 times water depth to ensure least-depth determination by multibeam near-nadir beams.  
Triton Elic’s DelphMap Real Time Bathy was used in lieu of planned line files.  The Real Time Bathy displayed 
the acquired multibeam swath during acquisition and was monitored to ensure overlap and full bottom coverage.  
If coverage was not adequate, additional lines were run while still in the area. 

4.3 Shoreline Verification 
 
FAIRWEATHER personnel conducted field shoreline verification at times near predicted low water, in 
accordance with the Standing Project Instructions, the FPM (March 2007), and HTD 2007-7.  Standard operating 
procedures on the use of Trimble TerraSync and GPS Pathfinder for shoreline verification were followed by 
survey personnel. 
  
CARIS Notebook 3.0 was used to review the project level composite source (.000) file supplied by HSD and 
described in HTD 2007-7.  The composite source file for OPR-O168-FA-07 contained features from a sole 
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source: Geographic Cell (GC), or Digital Data (DD), shoreline compiled by the Remote Sensing Division (RSD).  
The file was opened in Notebook and copied to a .hob file using the same name.  The project level composite 
source .hob file was edited by the survey manager to include only features within the survey limits and renamed 
according to survey number, HXXXXX_Composite_Source.hob.  A copy was made of the unedited survey level 
composite source .hob file and named HXXXXX_Original_Composite_Source.hob.  All modifications to source 
shoreline features addressed during field verification were made in the HXXXXX_Composite_Source.hob, with 
the original composite source .hob file remaining unedited.  These HOB files are submitted as shoreline 
deliverables. 
 
No AWOIS were assigned to this project. 
 
Shoreline verification was not conducted on this project due to lack of appropriate low water conditions.  
 
No Detached positions (DPs) and generic positions (GPs) were acquired and no DP forms or boat sheets were 
utilized.  

4.4 Shoreline Data Processing 
 
Features imported into Pydro were given short descriptive comments listed under the Remarks tab in Pydro.  
Features were flagged as Primary, unless there were multiple DPs or GPs taken on the same feature.  In that case, 
the most important DP was marked Primary and any associated DPs/GPs were flagged Secondary.  All features 
were S57 attributed.   
 
Significant features that deserved special attention or additional discussion, were flagged Report in Pydro and 
included in the Pydro feature report.  Along with the hydrographer notes and investigation methods provided in 
the Remarks tab, the Hydrographer included recommendations to the cartographer in the Recommendations tab 
when warranted. All features were flagged according to section 4.4.4 of the FPM.  All features flagged as “report” 
in Pydro were included in the Shoreline Feature Report.  
 
Photos labeled and associated with a DP/GP number were included in the Pydro PSS session and stored in a folder 
with the PSS file.   
 
HDCS_DATA lines associated with DPs were tide corrected in CARIS HIPS.  GPs do not have heights associated 
with them and required no additional processing. 
 
All primary and accepted DPs and GPs were exported from Pydro as an .xml to CARIS Notebook 3.0.  Two 
separate stand alone .hob files were created from the Pydro .xml files.  The files are named H#####_Updates.hob 
and H#####_Disprovals.hob.   
 
An original composite source file (H#####_Original_Composite_Source.hob) was saved prior to being edited and 
will be submitted with the survey.  No edits were applied to the H#####_Composite_Source.hob.   
 
The SORIND and SORDAT S57 attribute fields for new features or modified source features were updated to 
reflect the information for their associated survey number and date.  All unmodified source features retain their 
original SORIND and SORDAT values. 
 
The CARIS Notebook files along with CARIS HIPS BASE surface(s) were viewed to compare soundings and 
features simultaneously.  Standard operating procedures, for processing shoreline features in Pydro and CARIS 
Notebook, were followed by survey personnel as documented. 
 
Final Shoreline Deliverables include the Pydro PSS, the Pydro Shoreline Feature Report, and up to four Notebook 
HOB files: 

HXXXXX_Original_Composite_Source  (without edits) 
HXXXXX_Composite_Source (with edits) 
HXXXXX_Updates (Pydro Data Import, if applicable) 
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HXXXXX_Disprovals (Pydro Data Import, if applicable) 
 
5.0 Bottom Sample Acquisition 
 
Bottom samples were conducted according to section 7.1 of the HSSDM.  Bottom samples (GPs) were acquired 
with TerraSync 2.41.  Data were imported into GPS Pathfinder 3.1 and were reviewed for quality.  The line 
features were exported to a Microsoft Access Database file (.mdb) and NALL buffer lines were exported to ESRI 
shape files (.shp).   
 
Bottom samples results are found in the Pydro PSS and the Notebook HOB deliverable layer, 
HXXXXX_Updates. 

B QUALITY CONTROL 
 
The FAIRWEATHER has numerous standard operating procedures (SOPs) that are followed by personnel 
throughout the survey to ensure consistent high quality data and products.   
 
1.0 Uncertainty Modeling 
 
Error values for the multibeam and positioning systems on FAIRWEATHER and her survey launches were 
compiled from manufacturer specification sheets for each sensor (Heave, Pitch, Roll, Position, and Heading) and 
from values set forth in Chapter 4 Appendix of the FPM.   
 
Estimates for the error in measuring vessel offsets, multibeam system biases (timing, pitch, roll and yaw) and 
dynamic draft are the standard deviations of the set of values reached for each of these corrections resulting from 
several people processing the data.   
 
In the specific case of MRU Alignment error; values were set after an email exchange between Rainier, 
Fairweather, HSTP and CO-OPS (see TPE_MRU Alignment.txt email messages in Appendix VII).  The error 
value for MRU alignment deviated from that set in Chapter 4 Appendix of the FPM due to the directive’s value 
for MRU alignment error being set too high (possibly due to a misinterpretation of what the alignment error 
represented).  This error should represent the standard deviation of measurement of the error derived from 
multiple people processing the patch test.  Based on this, the MRU alignment errors were significantly lower than 
the 1 degree value set in Chapter 4 Appendix of the FPM.   
 
An estimate of the total error due to tides was not included in the Letter Instructions for the project, but a value of 
0.09 meters (two sigma - 95% confidence level) was given by CO-OPS in the above noted email exchange. Using 
this value as a reference, tidal errors were set at 0.01 m for the gauge and 0.1 meters for zoning.  The 0.01 meter 
estimate for the gauge is a conservative estimate that can be recalculated based on the sigma values in the final 
approved water levels.  The 0.1 meter estimate for zoning is also a conservative one sigma value based on the total 
two sigma tide error of 0.09 meters. 
 
The final uncertainty values for FAIRWEATHER and her launches, tides, and sound velocity, along with 
information on how the values were derived, are shown in the FA_TPE_Values.xls spreadsheet located in 
Appendix IV.  Uncertainty values relating to vessels and survey systems were entered into the HIPS Vessel File 
(HVF) for each platform.  Uncertainty values for tide and sound velocity were entered during the CARIS 
Compute TPE process. 
  
2.0 Data Processing 

2.1 Multibeam Echosounder Data Processing 
 
Bathymetry processing followed section 4.2 of the FPM unless otherwise noted.  
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Raw XTF multibeam data were converted to Caris HDCS format using FAIRWEATHER documented settings.  
True heave, sound velocity and water level data were then applied to all lines and the lines merged.  Once lines 
were merged Total Propagated Error (TPE) was computed.   
 
Vessel heading, attitude, and navigation data were reviewed in HIPS navigation editor and attitude editor.  Where 
necessary, fliers or gaps in heading, attitude, or navigation data were manually rejected or interpolated for small 
periods of time.  
 
BASE surfaces were created using the Combined Uncertainty and Bathymetric Estimator (CUBE) algorithm and 
parameters contained in the Cubeparams.xml file.  This file contains settings for “Deep” or “Shallow” surveys.  
As stated in HTD 2007-2, the “Deep” setting corresponds to NOAA “Complete” multibeam coverage and 
“Shallow” to NOAA “Object Detection” coverage.  As the Letter Instructions for project OPR-O168-FA-07 
require “complete” multibeam coverage, all BASE surfaces were created using the “Deep” configuration of 
CUBE parameters.   
 
Multibeam data were reviewed and edited in HIPS swath editor and in subset mode as necessary. 
The BASE surface was used for directed data editing in subset editor, to demonstrate coverage, and to check for 
errors resulting from tide, sound velocity, attitude and timing. 
 
Table 1 lists the general resolution and depth ranges used by FAIRWEATHER.  These values will be adjusted by 
sheet managers for individual surveys based on bathymetry and conditions in the survey area.  A detailed listing 
of the actual resolutions and depth ranges used during the processing of each survey, along with the corresponding 
fieldsheet(s), will be provided in the descriptive report of each survey.   
 
 

FAIRWEATHER 
Depth Ranges      Resolutions 

Lo (m) Hi (m) Overlap (m) Res. (m) 
0 40   2 

30 70 10 5 
50 120 20 10 
100 200 20 20 
180 350+ 20 35 

 

Table 1: Resolutions and Depth Ranges 
 
In areas of navigational significance where the BASE surface did not depict the desired depth for the given area, a 
designated sounding was selected.  Designated soundings were selected as outlined in chapter 5 of the HSSDM. 
 
3.0 DATA REVIEW 
 
Specific procedures were used on FAIRWEATHER to ensure quality control of data throughout acquisition, 
processing, and submission.  These procedures are documented and followed by the Hydrographer. A detailed in 
Quality Control Check is preformed by the survey manager.  A detailed Review is conducted by qualified survey 
personnel (FOO, CST, SST, or PS) other than the survey manager as an outside review of the survey data and 
deliverables.  The Data and Analog Submission checklists are used to ensure that all data and deliverables are 
complete and included upon submission.  Documentation of these tasks are completed for every survey but only 
the final processing log, HXXXXX_Data_Log, is submitted with the individual survey data. 
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C Corrections to Echo Soundings 
 
 
1.0 Vessel HVFs 
 
CARIS HIPS Vessel Files (HVF) were created by FAIRWEATHER personnel and used to define a vessel’s 
offsets and equipment uncertainty.  The HVF is used for converting and processing data collected by each survey 
platform.  For each survey platform, an HVF Report, listing specific HVF entries, was produced in the CARIS 
Vessel Editor and is included in Appendix III.  The HVFs used for the current project are included with the digital 
separates submitted with the individual survey data.   
 
2.0 Vessel Offsets  
 
Sensor offsets were measured with respect to each vessel’s reference point.  The reference point for 
FAIRWEATHER and survey launches 1010 and 1018 is the IMU.  Specific offset values were input into the 
POS/MV and the CARIS HIPS Vessel File (HVF).   
 
A ship survey was completed for the FAIRWEATHER by Westlake Consultants, Inc on September 23, 2003 and 
a POS/MV component spatial relationship survey of the FAIRWEATHER was conducted by NGS in February, 
2007.  The results of both of these surveys were used to determine the offsets for ship.  The reports from each 
survey are located in documents in Appendix III-S220-2, and the final values for FAIRWEATHER’s offsets and 
explanations of how they were calculated are located in the S220_Offsets & Measurements spreadsheet in the 
same folder.  
 
Permanent control points were established on launches 1010 and 1018 in July of 2004.  Sensor offsets were 
measured by Fairweather personnel according to documented procedures.  Total stations were utilized for 
positioning the permanent control points.  The total station specifications are located in Appendix II-7, the 
calibration certificates for the Nikon DTM 310 and the Sokkia SET 5F are included in Appendix V.  A steel tape 
was used to verify and update specific vessel offsets in April 2007.  The final offsets for survey launches 1010 and 
1018 were derived from a combination of values from the original full survey and the values updated in the 
verification surveys.  The measurements, derivations, descriptions of methodology used, diagrams, and coordinate 
system references are included in the respective vessel’s Offsets & Measurements spreadsheet in Appendix III. 
 

   
Figure 7: Permanent Control Point "Benchmark C" on launch 1018 
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3.0 Static and Dynamic Draft 
  
Static draft (Waterline Height in the HVF) for launch 1010 and 1018 was calculated based on steel tape 
measurements of the distance from benchmarks on the port and starboard quarter of the vessel to the waterline.  
Although static draft tubes have been installed in launch 1010 and 1018 the tubes have not yet been calibrated, nor 
have procedures for the determination of loading been developed.   
  
The bow and stern draft marks were used to perform a linear interpolation of the static draft at the 
FAIRWEATHER’s IMU.  The static draft was measured multiple times with the vessel under different loading 
conditions: with and without launches on board and with different amounts of fuel.  The final value for the static 
draft was an average of the most likely loading conditions during survey operations.   
 
The values and calculations for static draft are listed in each vessel’s Offsets Measurement spreadsheet (Waterline 
to RP) located in Appendix III. 
 
Dynamic Draft Settlement and Squat (DDSSM) tests were conducted for FAIRWEATHER and survey launches 
1010 and 1018 in April 2007.  The final DDSSM values are the average of results obtained from multiple 
individuals processing the DDSSM data.  Detailed processing spreadsheets of DDSSM results for each vessel are 
located in the respective vessel’s folder in Appendix III.   
 
4.0 Patch Tests 
 
Patch tests were conducted for the multibeam acquisition systems on FAIRWEATHER and survey launches 1010 
and 1018 in April 2007.  The results of the patch tests, along with the acquisition and processing logs, are 
included in the individual MBES Calibration Tables in Appendix III-3. 
 
It was discovered during processing of the 2007 patch tests that the new POS/MV’s for launches 1010 and 1018 
were set to output GPS time instead of UTC time.  This introduced a fourteen second error (the precise difference 
between GPS and UTC time) into the navigation time.  To avoid time spent rerunning the patch tests, the tests 
were processed using a time correction value of fourteen seconds, which effectively canceled out the time error.  
An entry in the HIPS vessel files for launches 1010 and 1018 dated 2007-001 show the fourteen second correction 
in the “Time Correction(s)” column.   The POS/MV units were subsequently changed to output UTC time and a 
second entry in the HIPS vessel files, removing the fourteen second navigation latency value, was entered on 
2007-102.  All data collected for the project took place after the POS/MV’s were corrected to output UTC time.  
 
Additional testing for adjustments were required throughout the field season on both Launch 1010 and 1018 due 
to the instability of the roll arm mount.  Launch 1010 was retested on Dn252 prior to this project due to mount 
tightening.  Launch 1018 was tested and had roll values updated on Dn236 prior to this project.  
 
5.0 Attitude  
 
All attitude corrections were generated by the POS/MV using data from the IMU-200 Inertial Measurement Unit 
(IMU).  IMU values for uncertainty of heave, pitch and roll are included in the manufacturer specification in 
Appendix II and are included in the FA_TPE_Values_2007.xls spreadsheet located in Appendix IV. IMU failures 
noted during this project were actually attributed to faulty POS/MV PCS units as documented in section 
1.4.1above.  IMU correctors applied to the data were not affected and no additional patch testing was required.  

5.1 True Heave 
 
FAIRWEATHER and her launches are equipped with the POS/MV TrueHeave™ (TH) option.  True Heave™ is a 
‘delayed’ heave corrector as opposed to ‘real time’ heave corrector and is fully described in Section 6 of the 
POS/MV Version 4 Installation and Operation Manual.  Daily TH files were logged through the Ethernet Logging 
function in the POS/MV controller software.  To ensure proper calculation of TH, files were logged for at least 
three minutes past the end of each day’s survey operations.   
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In cases where TrueHeave™ could not be applied, real time heave correctors were used.  Real time heave data 
were recorded in Triton Elic’s Isis software, stored in the .xtf format and applied as the heave corrector for 
multibeam data.  Data that does not have TrueHeave™ applied will be listed in the individual Descriptive Report 
for the survey.  
 
6.0 Sound Velocity 
 
Seacat SBE 19plus sound velocity profilers were used to collect sound velocity data for survey launches 1010 and 
1018’s Reson 8101 multibeam systems.  The Brooke Ocean Technology Moving Vessel Profiler (MVP) was used 
to collect sound velocity data to correct data collected with FAIRWEATHER’s Reson 8111 and 8160 multibeam 
systems. 
 
Daily sound velocity profiles from the SBE 19plus were processed with Velocwin and concatenated into a single 
.svp file for the sheet.  Individual .svp files and the concatenated file for the survey will be submitted with each 
survey.    
 
Sound velocity profiles acquired using the Brooke Ocean Technology Moving Vessel Profiler 200 (MVP) are 
stored in files labeled .001, .001c, .001d, and .001e (collectively called BOT files) where the number increments 
by one with each subsequent cast. The .00#c file for each cast was opened with Velocwin and converted into 
CARIS .svp file format.  The individual .svp profiles were concatenated into a single .svp file for the sheet. 
Individual sound velocity profile files taken by the MVP will not be submitted due to the large number of casts 
acquired; however, the daily concatenated files are submitted.   
 
The concatenated sound velocity files were applied to multibeam data in CARIS HIPS during data processing.  
CARIS HIPS uses one of four different algorithms to automatically apply a sound velocity profile stored in the 
concatenated sound velocity file.  They are: “previous in time,” “nearest in time,” “nearest in distance” and 
“nearest in distance within time.”  In general, “previous in time” was the method used for applying sound velocity 
information in HIPS, but the other methods may have been used in certain situations.  The method of applying 
sound velocity is included in the processing logs that are submitted with each survey. 
 
7.0 Water Level 
 
The vertical datum for this project is Mean Lower-Low Water (MLLW).  Predicted water level correctors from 
the primary tide stations at Juneau, Alaska (945-2210) were downloaded from the CO-OPS website and used for 
water level corrections during the course of the project.   
 
The files for the relevant days were collated into a tide station master file which was converted to CARIS .tid file 
format in MapInfo using HydroMI.  Water level data in the .tid files were applied to data using the zone definition 
file (O168FA2007CORP.zdf) supplied by CO-OPS. Upon receiving final approved water level data, all data were 
reduced to MLLW using the final approved water levels (smooth tides) as noted in the Descriptive Report 
included with the survey data. 
 
A complete description of vertical control for the project can be found in the OPR-O168-FA-07 Horizontal and 
Vertical Control Report (HVCR), submitted under separate cover. 
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 Triton Suite 
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 Acrobat Pro 
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Field Unit: 
Effective Date:

Updated Through:

Vessel Name FAIRWEATHER Launch 1010 Launch 1018 Skiff FRB Ambar 700

Vessel Image

Hull Number S 220 1010 1018 1706 2301 2302

Call Letters WTEB

Manufacturer Aerojet-General Shipyards
Jacksonville, FL Jensen Jensen MonArk Zodiak of North America Marine Silverships, Inc

Year of Construction 1967 1973 1973 2004 1998

Type of Construction Welded steel hull -
 ice strengthened Aluminum hull Aluminum Hull Aluminum Hull RHIB RHIB

Length Overall 70.4 m (231 ft) 8.8 m (28ft 10in) 8.8 m (28ft 10in) 5.2 m (17 ft) 6.7 m (22 ft) 7.0 m (23 ft)

Beam 12.8 m (42 ft) 3.3 m (10ft 8in) 3.3 m (10ft 8in) 2.3 m (7ft 2in) 2.6 m (8ft 6in) 2.9 m (9ft 4in)

Draft 4.7 m (15ft 6in) 1.2 m (4 ft) 1.2 m (4 ft) 0.4 m (1ft 3in) 0.6 m (22 in) 0.4 m (17 in)

Date of Effective Full Vessel 
Static Offset Survey

Origninal Survey 9/2003    
POS/MV Offsets Surveyed 

2/2007
2004 2004

Organization which Conducted 
the Effective Full Offset Survey

Original Survey -  Westlake 
Consultants              

POS/MV Survey - NGS

NOAA Personnel           
(Wexler, Sampadian, 

Froelich)

NOAA Personnel           
(Wexler, Sampadian, 

Froelich)
Date of Last Partial Survey or 
Offset Verification & Methods 
Used

April - 2007? April-2007                
Steel Tape

April-2007                
Steel Tape

Date of Last Static Draft 
Determination & Method Used

April-2007
Draft Marks on Hull

April-2007
Draft Marks on Hull

April-2007
Draft Marks on Hull

Date of Last Settlement and 
Squat Measurements & Method 
Used

April-2007
Echosounder Method

April-2007
Echosounder Method

April-2007
Echosounder Method

RED - info needs to be verified

ORANGE - info needs to be found

GREY - info not available

Hydrographic Vessel Inventory

SURVEY VESSELS

FAIRWEATER
June 1, 2006
 April 30, 2007



Field Unit:

Effective Date:

Updated Through:

Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last 

Calibration
Date of last 

Service Additional Information

Processor Reson 81-P (8111) 35652 N/A May-04 S220 N/A Bar Code : CD0001065312

Processor Reson 81-P (8160) 35385 N/A May-04 S220 N/A Bar Code : CD0001065313

Transducer Reson 8111ER unknown Dry: 8111-E209-6114      
Wet: 8111-E101-AFAA Apr-04 S220 4/20/2006

Transducer Reson 8160 unknown Dry: 8160-2.09-7C6D      
Wet: 8160-1.00-E9E1 Apr-04 S220 incomplete

Processor Reson 81-P 34497 N/A Jul-04 1010 N/A Bar Code : CD0001065351

Transducer Reson 8101 ER 2701011 Dry: 8101-2.09-E34D      
Wet: 8101-1.08-C215 Jul-04 1010 4/10/2006 removed 10/6/04 for repair; 

removed 10/1/05 for welding

Processor Reson 81-P 35737 N/A Jul-04 1018 N/A Bar Code : CD0001065349

Transducer Reson 8101 ER 3102026 Dry: 8101-2.09-E34D      
Wet: 8101-1.08-C215 Jul-04 1018 incomplete

Lead Line CST-FA Traditional 10_01_05 N/A N/A any 3/14/2007

Lead Line CST-FA Traditional 10_02_05 N/A N/A any 3/11/2005

Lead Line CST-FA Traditional 20_01_05 N/A N/A any 3/20/2007

Lead Line CST-FA Traditional 20_02_05 N/A N/A Ambar 4/10/2007

Lead Line CST-FA Traditional 20_03_05 N/A N/A any 4/6/2007

Lead Line CST-FA Traditional 30_01_05 N/A N/A any 4/9/2007

Lead Line CST-FA V-100/Non-Traditional pending N/A N/A any incomplete in work

Lead Line CST-FA V-100/Non-Traditional pending N/A N/A any incomplete in work

Divers Least Depth Gauge PTC MODIII 68322 N/A N/A S220 unknown unknown *acquired 5/22/06; stopped 
working 9/1/06

*Klein 3000 *03/21 /07-not yet on the FA

Odom Echotrac CVM Odom Hydrographic ETCVM-A 26034 ET-CVM COM Ver 3.29    
DSPDual Ver 3.28 any ChartView Dongle (100.001.001.098)

Hydrographic Hardware Inventory
FAIRWEATHER

2/10/2007

11/30/2007
SONAR & SOUNDING EQUIPMENT



Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location GAMS 

Calibration
Date of last 

Service Additional Information

POS/MV PCS Applanix 320 V.4 2411 HW2.9-7, SW03.22 Jun-06 S220 3/29/2007 Auth. No. 811025-00534537

POS/MV IMU Applanix LN200 292 N/A Apr-04 S220 Bar Code : CD0001696450

POS/MV Port Ant. Applanix OEM2 3151R SGN 98490013 HW1 Apr-04 S220

POS/MV Stbd Ant. Applanix OEM2 3151R CGN 9620009 HW1 Apr-04 S220

DGPS Receiver CSI Wireless MBX-3S 0426- 16627- 0001 N/A Jul-04 S220

DGPS Ant. CSI Wireless MGL3 N/A Apr-04 S220

POS/MV PCS Applanix 320 V.4 2564 HW 1.9.7, SW 03.26 Jul-06 1010 3/30/2007

POS/MV IMU Applanix LN200 294 N/A Jul-04 1010 Bar Code : CD0001696449

POS/MV Port Ant. Applanix OEM2 3151R S/N 60162863 HW1 Mar-07 1010

POS/MV Stbd Ant. Applanix OEM2 3151R S/N 60145247 HW1 Mar-07 1010

DGPS Receiver CSI Wireless MBX-3S 0331-12579-0008 N/A Jul-04 1010

DGPS Ant. CSI Wireless MGL3 0331-12579-0009 N/A Jul-04 1010

POS/MV PCS Applanix 320 V.4 2560 HW 1.9.7, SW 03.26 Jul-06 1018 3/30/2007

POS/MV IMU Applanix LN200 37 N/A Feb-07 1018 Bar Code : CD0000832907

POS/MV Port Ant. Trimble 39105-00 DC 4618 60145158 N/A Feb-07 1018

POS/MV Stbd Ant. Trimbe 39105-00 DC 4604 60130644 N/A Feb-07 1018

DGPS Receiver CSI Wireless MBX-3S 0328-12362-0001 N/A Jul-04 1018

DGPS Ant. CSI Wireless MGL3 0328-12352-0002 N/A Jul-04 1018

Trimble Backpack 1 Trimble Pathfinder Pro XRS 0224078543 N/A N/A S220

Trimble Backpack 1: Antenna Trimble 33580-50 0220341062 N/A N/A S220

Trimble Backpack 2 Trimble Pathfinder Pro XRS 0224090101 N/A N/A S220

Trimble Backpack 2: Antenna Trimble 33580-50 0220321059 N/A N/A S220

Handheld data collector Trimble TSCe 37318 N/A N/A S220

Laser Laser Tech Inc. Impulse Laser Rangefinder i09290 N/A N/A S220

Laser Laser Tech Inc. TruPulse 200 Laser 
Rangefinder 001481 N/A N/A S220

Laser Laser Tech Inc. TruPulse 200 Laser 
Rangefinder 000676 N/A N/A S220

Antenna cable Trimble S220 P/N22628

Camcorder Batteries Trimble S220 P/N17466

NMEA/RTCM cable Trimble S220 P/N30232-00

data/power cable Trimble                             S220 P/N30231-00

dual battery cable Trimble S220  P/N24333

GPS Pathfinder field device
cable Trimble S220 P/N45052

POSITIONING & ATTITUDE EQUIPMENT



Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last 

Calibration
Date of last 

Service Additional Information

Moving Vessel Profiler winch Brooke Ocean Technology 
Inc. MVP-200-5 10328 S220

Calibration by ACME 
Velocimeters, not 

manufacturer.  Brooke Ocean 
too backed up. 

Moving Vessel Profiler fish Brooke Ocean Technology 
Inc. MVP-FFF-SS-32-1 Spare S220 Spare Fish

Moving Vessel Profiler fish Brooke Ocean Technology 
Inc. MVP-FFF-SS-32-1 10329 S220

Moving Vessel Profiler sensor Brooke Ocean Technology 
Inc. Smart SV +P 5229 S220 Spare Sensor

Moving Vessel Profiler sensor Brooke Ocean Technology 
Inc. AML SV +P 4986 S220 *26 June - lost one fish and 

sensor; 1-166

Penetrometer Brooke Ocean Technology 
Inc. FFCPT-35-2 10416 S220

Penetrometer sensor Brooke Ocean Technology 
Inc. AML SV +P 191-3 S220

SEACAT Profiler Sea-Bird SBE 19plus 19P36026-4585 1.4D S220 Nov-06 N/A CON files: 4585.con

SEACAT Profiler Sea-Bird SBE 19plus 19P36026-4617 1.4D 1010 or 1018 Nov-06 N/A CON files: 4617.con; 
connector pin broke 25 Sept. 

SEACAT Profiler Sea-Bird SBE 19plus 19P36026-4616 1.4D 1010 or 1018 Nov-06 N/A CON files: 4616.con

Micro Thermosalinograph Sea-Bird SBE 45 (TSG) 4536628-0117 N/A N/A S220 Nov-06 N/A P/N 4536628

Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last 

Calibration
Date of last 

Service Additional Information

Level Carl Zeiss N12 333 100056 N/A N/A S220 Mar-07

Level Carl Zeiss N12 333 103567 N/A N/A S220 Mar-07

Level Leica NA2 100 5332739 N/A N/A S220

Level Lecia NA2 100 5332747 N/A N/A S220

SOUND SPEED MEASUREMENT EQUIPMENT

TIDES & LEVELING EQUIPMENT



Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last 

Calibration
Date of last 

Service Additional Information

Receiver Ashtech Z-Xtreme ZE1200339016  ZE00 Apr-04 S220 Mar-07 obtained April 2004

GPS Antenna Ashtech Geodetic 4 8365 N/A N/A S220 Mar-07 obtained April 2004

Position Data Link High
Powered Base Unit Pacific Crest PDL 4135 0424 0171 2.40 Apr-04 S220 Mar-07 obtained April 2004

Position Data Link Rover Pacific Crest PDL 4100 04240154 2.4 Apr-04 S220 Mar-07 obtained April 2004

Position Data Link Rover Pacific Crest PDL 4100 03473047 2.32 Apr-04 S220 Mar-07 obtained April 2004

Position Data Link Rover Pacific Crest PDL 4100 04240155 2.4 Apr-04 S220 Mar-07 obtained April 2004

Marine Deep Cycle Battery Magnatron S220 purchased July 2004 7 as of May 2006

Solar Panel Uni-Solar FLX-32 USF-32-14639 N/A N/A S220

Solar Panel Uni-Solar FLX-32 USF-32-14634 N/A N/A S220

Solar Panel Uni-Solar FLX-32 USF-32-14633 N/A N/A S220

Solar Panel Uni-Solar FLX-32 USF-32-14529 N/A N/A S220

Solar Panel Uni-Solar FLX-32 USF-32-14631 N/A N/A S220

Solar Panel Uni-Solar FLX-32 USF-32-14625 N/A N/A S220

Solar Panel Uni-Solar FLX-32 USF-32-14645 N/A N/A S220

Solutions Dongles Ashtech 600586 (A) KEB2083 N/A N/A S220

Solutions Dongles Ashtech 600586 (A) KEB2077 N/A N/A S220

GPS Receiver Trimble DSM-232 22511661 3.5 Feb-07 S220

GPS Receiver Trimble DSM-232RS 225111655 3.5 Feb-07 S220 DGPS Reference Station

DGPS Ant. Trimble 33580-00 220395038 N/A N/A S220

GPS Antenna Trimble Geodetic Reference Station 
Antenna 30325441 N/A N/A S220

Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last 

Calibration
Date of last 

Service Additional Information

  

HORIZONTAL AND VERTICAL CONTROL EQUIPMENT

OTHER EQUIPMENT
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FA_Proc_1 Plot Room DELL PWS 650 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.8 GHz 1 GB 3 GB 2 128 MB J5PSH31 CD0001354993

Plot Room DELL PWS 360 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.8 GHz 1 GB 2 GB 2 128 MB 6WYB451 CD0001741478

Plot Room DELL PWS 360 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.8 GHz 1 GB 3 GB 2 128 MB GBBG451 CD0001741480

Plot Room DELL PWS 360 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.8 GHz 1 GB 3 GB 2 128 MB CBBG454 CD0001741481

Plot Room DELL PWS 450 2000 SP4 ~ March 2004 ~ September 2005 2. GHz unknown 2 GB 2 64 MB 344RH31 CD0001354979

Plot Room DELL PWS 450 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.8 GHz 1 GB 2 GB 2 128 MB 356JG31 CD0001354468

Plot Room DELL PWS 360 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.8 GHz 1 GB 3 GB 2 128 MB 7WYB451 CD0001741477

Plot Room DELL PWS 360 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.8 GHz 1 GB 3 GB 2 128 MB DBBG451 CD0001741482

Plot Room DELL PWS 450 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.8 GHz 1 GB 3 GB 2 128 MB 846JG31 CD0001354463

DP-2 DELL PWS 450 2000 SP4 ~ March 2004 ~ September 2005 2.4 GHz 1 GB 2 GB 2 64 MB 644RH31 CD0001354984

Field Office DELL PWS 360 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.8 GHz 1 GB 2 GB 2 128 MB FBBG451 CD0001741479

Field Office DELL PWS 450 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.8 GHz 1 GB 3 GB 2 128 MB 646JG31 CD0001354465

O-LAB DELL PWS 450 2000 SP4 ~ March 2004 ~ September 2005 2.4 GHz unknown 3 GB 2 64 MB 144RH31 CD0001354980

Laptop DELL Inspiron 1100 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.4 GHz 2.5 GB 2.5 GB 1 64 MB HGHWM41 CD0001272964

Laptop DELL Inspiron 1101 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.4 GHz 2.5 GB 2.5 GB 1 64 MB GGHWM41 CD0001272965

Laptop Panasonic   CF-18 XP Pro 2002 SP2 ~ March 2004 ~ July 2006 1.1 GHz 2.5 GB N/A 1 64 MB 4HKSA59499 CD0001269860

Laptop Panasonic  CF-18 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 1.1 GHz 2.5 GB N/A 1 64 MB 4HKSA59560 CD0001269858

Laptop Panasonic  CF-29 XP Pro 2002 SP2 March 2006 N/A 1.6 GHz 2.5 GB N/A 1 128 MB 6AKSB06863 CD0001698251

Laptop Panasonic  CF-18 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 1.1 GHz 2.5 GB N/A 1 64 MB 4GKSA55049 CD0001269589

Launch 1010 DELL PWS 670 XP Pro 2002 SP3 ~ March 2004 ~ September 2005 2.8 GHz 2 GB 2 GB 3 64 MB 4JD0S61 CD0001696433

Launch 1018 DELL PWS 670 XP Pro 2002 SP4 ~ March 2004 ~ September 2005 2.8 GHz 2 GB 2 GB 3 64 MB 71NKT61 CD0001696419

Plot Room Supermicro Xeon XP Pro 2002 SP2 ~ March 2004 N/A 2.8 GHz 896 MB 896 MB 3 128 MB N/A CD0001269853

Plot Room MVP-C1-2001 2000 SP4 ~ March 2004 ~ September 2005 2.4 GHz 230 MB 230 MB 1 64 MB SN: 10330 CD0001269854

*formerly FA_Process_8b

*rebuilt after crash July 2006

FA_Process_10 added & configured 8/28/05

*Formerly known as S220_NAV                              
FA_Process_7 added & configured 5/6/05

FA_Process_5 added & configured 10/11/05FA_Proc_5

FA_Proc_6

FA_Proc_4

FA_Proc_3

S220_ACQ

1018_ACQ

1010_ACQ

Toughbook 2

Toughtab 1

Toughbook 3

FA_Mobile1

FA_Proc_7*

FA_Mobile2

FA_O-LAB*

FA_FOO

FA_CST

FA_Proc_9

FA_Proc_10

FA_Proc_8

FA_MVP200

Toughbook 1

External Hard Drives
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External Hard Drives

Plot Room Maxtor One Touch II 300 GB S/N L618M19H CD0001698248

Plot Room Maxtor One Touch II 300 GB S/N B60Y1QJH CD0001474757

Plot Room Maxtor One Touch II 300 GB S/N L617HX5H CD0001698245

Plot Room Maxtor One Touch II 300 GB S/N L60DP6TG CD0001698250

Plot Room WD1200B006-RNN 300 GB S/N: WCAEK1371526 CD0001696434

Plot Room WD1200B008-RNN 120 GB S/N: WCAES1181707 CD0001696417

Plot Room WD1200B008-RNN 120 GB S/N: WCAES1182576 CD0001269837

Plot Room WD1200B011-RNN 120 GB S/N: WCAES1181609 CD0001269824

Plot Room 2.5" ION DRIVE GHD225U40 none CD0001269826

Plot Room 2.5" ION DRIVE GHD225U40 none CD0001696418

Plot Room Ximeta Inc. ND Series Model: ND 10 80 GB S/N: N4061100095 CD0001478894

FA-SUBMISSION-UNIT4

Net Disk

1018 Hard Drive

Western Digital 1

1010 Hard Drive

FA-SUBMISSION-UNIT1

Western Digital 2

Western Digital 3



Field Unit:  
Effective Date: 

Updated Through: Jan-92

Name and Grade Current Position Years of Hydro Experience 
(calculated) Hydro Experience Since Notes

CDR Andrew L. Beaver Commanding Officer 15 year(s) + 9 month(s) January-87 Arrived June-06
LCDR Edward J. Van Den Ameele Executive Officer 14 year(s) + 4 month(s) June-93 Departed August-07
LCDR Richard Fletcher Executive Officer 13 year(s) + 6 month(s) April-94 Arrived August-07
LT Jennifer Dowling Field Operations Officer 6 year(s) + 11 month(s) November-00 Arrived February -06
LTjg Michael Gonsalves Junior Officer 2 year(s) + 11 month(s) November-04 Nav Officer; Departed July-07
LTjg Jonathan French Junior Officer 2 year(s) + 11 month(s) November-04 ECO Officer; Departed April-07 
LTjg  Guinevere Lewis Junior Officer 2 year(s) + 4 month(s) June-05 Tides Officer; Promoted to LTjg April-07
LTjg Allison Martin Junior Officer 2 year(s) + 4 month(s) June-05 DC Officer, Nav Officer; Promoted to LTjg April-07
ENS Matthew Glazewski Junior Officer 1 year(s) + 11 month(s) November-05
ENS Llian Breen Junior Officer 0 year(s) + 10 month(s) December-06
ENS Nick Morgan Junior Officer 0 year(s) + 10 month(s) December-06 ECO Officer
ENS Mark Andrews Junior Officer 0 year(s) + 3 month(s) July-07
ENS Patrick Redmond Junior Officer 0 year(s) + 3 month(s) July-07

Name and Rate Current Position Years of Hydro Experience Hydro Experience Since Notes

Lynnette Morgan Chief Survey Technician 7 year(s) + 9 month(s) January-00 departed August-06; return date tba
Grant Froelich Chief Survey Technician 5 year(s) + 2 month(s) August-02
Stephanie Mills Survey Technician 1 year(s) + 7 month(s) March-06 Promoted to SST Sept 07
Dan Jacobs Assistant Survey Technician 1 year(s) + 1 month(s) September-06 Promoted to ST Sept 07
Brenna Campbell Assistant Survey Technician 1 year(s) + 1 month(s) September-06 Promoted to ST Sept 07
Adam Argento Assistant Survey Technician 0 year(s) + 7 month(s) March-07
Andrew Evans Assistant Survey Technician 0 year(s) + 4 month(s) June-07

Name and Rate Current Position Years of Hydro Experience Deck Experience Since Notes

Garry Guice Chief Boatswain N/A April-82
Eric Heiner Third Mate N/A April-93 Promoted to Third Mate August -07
Ron Walker BGL N/A June-84
Kerri Curtin AB N/A February-02 departed July 07
Emily Evans DU N/A January-06
Mills Dunlap GVA N/A June-06
Carter Terry AB N/A February-07
Chris Marcum GVA N/A August-07 arrived Aug 07
Alex Davis AB N/A January-07

Name and Rate Current Position Years of Hydro Experience Hydro Experience Since Notes & Dates Embarked

Sarah Wolfskehl ERT P183, P909 Arr Apr-7, Dep Jun-27
Matt Foss Physical Scientist P183, P909 Arr Apr-21, Dep Jun-27
Toshi Wozumi Physical Scientist P183, P909, P903, P132 Arr Jul-7, Dep Sept-04
Katie Reser Physical Scientist P183, P909, P903, P132 Arr Aug-06, Dep Sep -28
Matt Foss Physical Scientist P903, P132 Arr Sep-5, Dep Oct-02
Dave Sinson Physical Scientist P903, P132 Arr Sep-17, Dep Nov-03

NOTES:

OFFICERS

Hydrographic Personnel Roster
FAIRWEATHER S-220
2/1/2007
10/31/2007

DECK DEPARTMENT (involved in survey work)

ROTATING HYDROGRAPHERS & VISITORS (involved in survey work)

SURVEY DEPARTMENT

Page 1 of 1



Acquisition Processing Miscellaneous Tracking

ISIS Sonar v7.0.2 CARIS HIPS & SIPS v6.0 Adobe Acrobat Professional Microsoft Office

Triton Suite CARIS HIPS & SIPS v6.1 Macromedia Dreamweaver 7.0.1 Corel Word Perfect Office 2002

POS MV Controller 3.3.2.2        
(1010 and 1018) CARIS Utilities Snag It 7.1 McAffee

MV POS View 3.3.1 (S220) CARIS GIS v4.4a Paint Shop Pro v8 Computer Defragmentation

Brooke Ocean Technology MVP 
2.26 CARIS Notebook v3.0 Global Mapper 7

TerraSync 2.41 PYDRO v7.3 SevenCs - SeeMyDEnc

Pathfinder 3.1

Velocwin 8.8

Fledermaus 6.21

MapInfo 8.0

MapInfo 8.5

Ashtech Solutions v2.6

FAIRWEATHER Survey Software Systems
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Comments
v.6.5.0 d.u d.u d.u d.u
v6.5.1 d.u d.u d.u d.u
v6.6.0 d.u d.u d.u d.u
v6.7.0 10/1/04 10/1/04 10/1/04 9/20/04 ISIS removed 2/14/05

v6.7.193.0
v6.8 N/A 2/10/05 2/28/05 2/14/05 FA_Process_4 No longer back-up computer
v6.9 N/A 10/7/05* 9/10/05 9/10/05 8/5/05 FA_Process_5 needs to be uninstalled, was backup acq
v7.0 N/A 1/11/06

v7.0.2 4/27/06 4/27/06 4/27/06
v7.0.410 3/22/06 3/21/06 3/22/06 Uninstalled due to nav problems

v7.0.414 4/20/06 4/24/06 4/24/06 4/21/06 FA_Process_1 setup for Dual 8111/8160 acquistion Uninstalled 
due to datagram frequency issue
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d.u.=date unknown; exact intall date not documented



Triton Suite: DeplhMap, DelphNav, BathyPro, RT Bathy, 81XX Server, Mission Monitor
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v2.12 2/10/05 2/28/05 2/14/05
v2.13 10/7/05 9/10/05 9/10/05 8/5/05

v3.1.410 3/22/06 3/21/06 3/22/06
v3.1.2 4/27/06 4/27/06 4/27/06
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TerraSync
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v2.40 NA NA NA d.u NA NA d.u. NA d.u 7/18/06 d.u
v2.41 NA NA NA NA NA NA 3/21/06 10/6/2004 7/18/2006 10/13/2004 10/5/2004 also installed on TCSe

d.u.=date unknown; exact intall date not documented

Software 
Install Serials

498295-00110-04309-7073A4A7
498295-00110-05068-EBD4EA8B

Product 
Serials

498295-00110
unknown



Caris License # On GIS HIPS Notebook Expires Type Comments
CW9604403 roving 1 1 Purple USB replaces CW9604041
CW9604042 roving 1 12/31/07 Purple USB
CW9604366 FADC3 7 7 5 10/31/07 Red USB new key inst. 10/31/05

CARIS Licenses



CARIS HIPS & SIPS 6.0
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Comments
v6.0 full 04/23/06 04/23/06 10/04/05 10/04/05 03/08/06 04/23/06 04/23/06 10/03/05 04/23/06 04/26/06 08/05/06 8/24/2006 1/17/2006
v6.0 HF1 10/04/05 10/04/05 03/08/06
v6.0 HF2 10/04/05 10/04/05 03/08/06
v6.0 SP1 4/23/2006 4/23/2006 12/14/05 4/23/2006 03/08/06 4/23/2006 4/23/2006 4/23/2006 4/23/2006 4/26/06 08/05/06 8/24/2006 01/17/06
SP1 HF1 12/14/05 03/08/06 01/17/06
SP1 HF2 12/14/05 03/08/06 01/17/06
SP1 HF3 12/14/05 03/08/06 01/17/06
SP1 HF4 12/14/05 03/08/06 01/17/06
SP1 HF5 01/11/06 03/08/06 01/17/06
SP1 HF6 01/11/06 03/08/06 01/17/06
SP1 HF7 01/17/06 03/08/06 01/17/06
SP1 HF8 03/08/06 03/08/06
SP1 HF9 03/08/06 03/08/06
SP1 HF10 03/08/06 03/08/06
SP1 HF11 03/08/06 03/08/06
SP1 HF12 03/08/06 03/08/06
SP1 HF13 03/08/06 03/08/06
SP1 HF14 03/08/06 03/08/06
SP1 HF 15 04/12/06 04/12/06
SP1 HF16 04/12/06 04/12/06
SP1 HF17 04/12/06 04/12/06
SP2 4/23/2006 4/23/2006 04/16/06 4/23/2006 4/23/2006 4/23/2006 4/23/2006 4/23/2006 4/23/2006 4/26/06 08/05/06 8/24/2006 4/16/2006
SP2 HF1 4/23/2006 4/23/2006 4/23/2006 4/23/2006 4/23/2006 4/23/2006 4/23/2006 4/23/2006 4/23/2006 4/26/06 08/05/06 8/24/2006 4/25/2006
SP2 HF2 5/7/2006 5/7/2006 5/7/2006 5/7/2006 5/7/2006 5/7/2006 5/7/2006 5/7/2006 5/7/2006 5/7/2006 08/05/06 8/24/2006 5/22/2006
SP2 HF3 5/7/2006 5/7/2006 5/7/2006 5/7/2006 5/7/2006 5/7/2006 5/7/2006 5/7/2006 5/7/2006 5/7/2006 08/05/06 8/24/2006 5/22/2006
SP2 HF4 7/8/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 08/05/06 8/24/2006 5/22/2006
SP2 HF5 7/8/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 08/05/06 8/24/2006 5/22/2006
SP2 HF6 7/8/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 08/05/06 8/24/2006 5/22/2006
SP2 HF7 7/8/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 08/05/06 8/24/2006 5/22/2006
SP2 HF8 7/8/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 08/05/06 8/24/2006
SP2 HF9 7/8/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 08/05/06 8/24/2006
SP2 HF10 7/8/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 08/05/06 8/24/2006
SP2 HF11 7/8/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 08/05/06 8/24/2006
SP2 HF12 7/8/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 7/6/2006 08/05/06 8/24/2006
SP2 HF13 7/14/2006 7/14/2006 7/14/2006 7/19/2006 7/14/2006 7/14/2006 8/23/2006 8/12/2006 7/14/2006 08/05/06 8/24/2006
SP2 HF14 7/14/2006 7/14/2006 7/14/2006 7/19/2006 7/14/2006 7/14/2006 8/23/2006 8/12/2006 7/14/2006 08/05/06 8/24/2006
SP2 HF15 8/23/2006 8/23/2006 8/23/2006 8/23/2006 8/23/2006 8/23/2006 8/23/2006 8/23/2006 8/23/2006 08/24/06 8/24/2006
SP2 HF16 9/18/2006 9/18/2006 9/18/2006 9/18/2006 9/18/2006 9/18/2006 date unknown 9/18/2006 9/18/2006 09/18/06 09/18/06
SP2 HF17 9/18/2006 9/18/2006 9/18/2006 9/18/2006 9/18/2006 9/18/2006 date unknown 9/18/2006 9/18/2006 09/18/06 09/18/06
SP2 HF18 9/18/2006 9/18/2006 9/18/2006 9/18/2006 9/18/2006 9/18/2006 date unknown 9/18/2006 9/18/2006 09/18/06 09/18/06
SP2 HF19 10/2/2006 10/2/2006 10/2/2006 10/2/3006 10/3/2006 10/3/2006 10/3/2006 10/3/2006 10/3/2006 10/2/2006 10/03/06

removed removed removed removed removed removed removed removed removed removed removed removed
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Comments
v6.1 full 02/25/07 02/25/07 02/13/07 02/25/07 02/25/07 02/25/07 02/25/07 02/25/07 02/25/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF1 03/06/07 03/06/07 03/04/07 03/06/07 03/07/07 04/09/07 03/07/07 03/05/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF2 03/06/07 03/06/07 03/06/07 03/06/07 03/07/07 04/09/07 03/07/07 03/05/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF3 03/06/07 03/06/07 03/06/07 03/06/07 03/07/07 04/09/07 03/07/07 03/05/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF4 03/06/07 03/06/07 03/06/07 03/06/07 03/07/07 04/09/07 03/07/07 03/05/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF5 03/06/07 03/06/07 03/06/07 03/06/07 03/07/07 04/09/07 03/07/07 03/05/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF6 03/06/07 03/06/07 03/06/07 03/06/07 03/07/07 04/09/07 03/07/07 03/05/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF7 03/06/07 03/06/07 03/06/07 03/06/07 03/07/07 04/09/07 03/07/07 03/07/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF8 04/02/07 04/02/07 04/03/07 04/02/07 04/02/07 04/09/07 04/02/07 04/02/07 04/02/07 04/02/07 04/03/07 08/11/07 04/02/07
v6.1 HF9 04/02/07 04/02/07 04/03/07 04/02/07 04/02/07 04/09/07 04/02/07 04/02/07 04/02/07 04/02/07 04/03/07 08/11/07 04/02/07
v6.1 HF10 04/22/07 04/22/07 04/22/07 05/06/07 04/22/07 04/22/07 05/06/07 04/22/07 04/22/07 05/22/07 04/22/07 08/11/07 07/10/07
v6.1 HF11 05/06/07 05/06/07 05/06/07 05/06/07 05/06/07 05/06/07 05/06/07 05/06/07 05/06/07 05/23/07 05/06/07 08/11/07 07/10/07



v6.1 HF12 05/28/07 05/28/07 05/28/07 05/28/07 05/28/07 05/28/07 05/28/07 05/29/07 05/28/07 05/24/07 05/28/07 08/11/07 07/10/07
v6.1 HF13 05/28/07 05/28/07 05/28/07 05/28/07 05/28/07 05/28/07 05/28/07 05/29/07 05/28/07 05/25/07 05/28/07 08/11/07 07/10/07
v6.1 HF14 07/08/07 07/07/07 07/11/07 07/11/07 07/08/07 07/08/07 07/08/07 07/11/07 07/11/07 07/09/07 07/08/07 08/11/07 07/10/07
v6.1 HF15 07/08/07 07/07/07 07/11/07 07/11/07 07/08/07 07/08/07 07/08/07 07/11/07 07/11/07 07/09/07 07/08/07 08/11/07 07/10/07
v6.1 SP1 07/19/07 07/19/07 07/20/07 07/20/07 08/02/07 08/02/07 08/02/07 08/02/07 07/29/07 07/19/07 08/11/07 07/20/07

d.u.=date unknown; exact inxtall date not documented
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Comments
v6.1 full 02/25/07 02/25/07 02/13/07 02/25/07 02/25/07 02/25/07 02/25/07 02/25/07 02/25/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF1 03/06/07 03/06/07 03/04/07 03/06/07 03/07/07 04/09/07 03/07/07 03/05/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF2 03/06/07 03/06/07 03/06/07 03/06/07 03/07/07 04/09/07 03/07/07 03/05/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF3 03/06/07 03/06/07 03/06/07 03/06/07 03/07/07 04/09/07 03/07/07 03/05/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF4 03/06/07 03/06/07 03/06/07 03/06/07 03/07/07 04/09/07 03/07/07 03/05/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF5 03/06/07 03/06/07 03/06/07 03/06/07 03/07/07 04/09/07 03/07/07 03/05/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF6 03/06/07 03/06/07 03/06/07 03/06/07 03/07/07 04/09/07 03/07/07 03/05/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF7 03/06/07 03/06/07 03/06/07 03/06/07 03/07/07 04/09/07 03/07/07 03/07/07 03/07/07 03/06/07 04/03/07 08/11/07 04/02/07
v6.1 HF8 04/02/07 04/02/07 04/03/07 04/02/07 04/02/07 04/09/07 04/02/07 04/02/07 04/02/07 04/02/07 04/03/07 08/11/07 04/02/07
v6.1 HF9 04/02/07 04/02/07 04/03/07 04/02/07 04/02/07 04/09/07 04/02/07 04/02/07 04/02/07 04/02/07 04/03/07 08/11/07 04/02/07
v6.1 HF10 04/22/07 04/22/07 04/22/07 05/06/07 04/22/07 04/22/07 05/06/07 04/22/07 04/22/07 05/22/07 04/22/07 08/11/07 07/10/07
v6.1 HF11 05/06/07 05/06/07 05/06/07 05/06/07 05/06/07 05/06/07 05/06/07 05/06/07 05/06/07 05/23/07 05/06/07 08/11/07 07/10/07
v6.1 HF12 05/28/07 05/28/07 05/28/07 05/28/07 05/28/07 05/28/07 05/28/07 05/29/07 05/28/07 05/24/07 05/28/07 08/11/07 07/10/07
v6.1 HF13 05/28/07 05/28/07 05/28/07 05/28/07 05/28/07 05/28/07 05/28/07 05/29/07 05/28/07 05/25/07 05/28/07 08/11/07 07/10/07
v6.1 HF14 07/08/07 07/07/07 07/11/07 07/11/07 07/08/07 07/08/07 07/08/07 07/11/07 07/11/07 07/09/07 07/08/07 08/11/07 07/10/07
v6.1 HF15 07/08/07 07/07/07 07/11/07 07/11/07 07/08/07 07/08/07 07/08/07 07/11/07 07/11/07 07/09/07 07/08/07 08/11/07 07/10/07
v6.1 SP1 03/06/08 07/19/07 07/20/07 07/20/07 08/02/07 08/02/07 d.u. 08/02/07 08/02/07 07/29/07 07/19/07 08/11/07 07/20/07
SP1 HF1 03/06/08 09/28/07 09/28/07 09/28/07 09/28/07 09/26/07 09/26/07 09/26/07 09/28/07 09/28/07 09/28/07 09/28/07 09/28/07
SP1 HF2 03/06/08 09/28/07 09/28/07 09/28/07 09/28/07 09/26/07 09/26/07 09/26/07 09/28/07 09/28/07 09/28/07 09/28/07 09/28/07
SP1 HF3 03/06/08 09/28/07 09/28/07 09/28/07 09/28/07 09/26/07 09/26/07 09/26/07 09/28/07 09/28/07 09/28/07 09/28/07 09/28/07
SP1 HF4 03/06/08 09/28/07 09/28/07 09/28/07 09/28/07 09/26/07 09/26/07 09/26/07 09/28/07 09/28/07 09/28/07 09/28/07 09/28/07
SP1 HF5 03/06/08 11/14/07* 11/20/07* 11/20/07* 11/21/07 12/03/07 12/03/07 12/03/07 12/03/07 d.u. 12/03/07 d.u. 03/11/08 New processing machines:
SP1 HF6 03/06/08 11/14/07 11/20/07 11/20/07 11/21/07 12/03/07 11/20/07 12/03/07 12/03/07 d.u. 12/03/07 d.u. 03/11/08 P1, P2, P3, P4, P5, P7 (P10)
SP1 HF7 03/06/08 01/14/08 01/22/08 01/22/08 01/22/08 01/22/08 02/11/08 01/22/08 01/22/08 02/13/08 01/22/08 01/22/08 03/11/08
SP1 HF8 03/06/08 01/14/08 01/22/08 01/22/08 01/22/08 01/22/08 02/11/08 01/22/08 01/22/08 02/13/08 01/22/08 01/22/08 03/11/08
SP1 HF9 03/06/08 01/16/08 01/22/08 01/22/08 01/22/08 01/22/08 02/11/08 01/22/08 01/22/08 02/13/08 01/22/08 01/22/08 03/11/08
SP1 HF10 03/06/08 03/05/08 02/12/08 02/11/08 03/05/08 03/06/08 02/11/08 03/05/08 03/06/08 02/13/08 03/06/08 03/06/08 03/11/08
SP1 HF11 03/06/08 03/05/08 03/06/08 03/05/08 03/05/08 03/06/08 03/11/08 03/05/08 03/06/08 03/05/08 03/06/08 03/06/08 03/11/08

d.u.=date unknown; exact inxtall date not documented
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Comments
LUv2.1.0 05/05/04 08/02/04 05/05/04 08/02/04 10/11/05 09/11/04 05/06/05 08/02/04 08/02/04 08/28/05 08/04/04 08/13/04 10/12/05
CPCR v2.0 06/14/04 08/02/04 08/02/04 08/02/04 10/11/05 09/11/04 05/06/05 08/02/04 08/02/04 08/28/05 08/04/04 08/11/04 10/12/05
EasyENCv3.0 11/05/04 10/07/04 10/07/04 10/08/04 10/11/05 09/23/04 05/06/05 10/08/04 09/23/04 08/28/05 10/07/04 10/07/04 10/12/05
ConvUtilityv2.0.0.2 2/9/2005 2/14/2005 2/9/2005 2/9/2005 10/11/05 2/10/2005 05/06/05 2/9/2005 2/9/2005 08/28/05 2/14/2005 2/15/2005 10/12/05
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Comments
v4.4a 05/05/04 08/02/04 05/05/04 08/02/04 10/11/05 09/11/04 05/06/05 08/02/04 08/02/04 08/28/05 08/04/04 08/13/04 10/12/05
SP4 05/05/04 08/02/04 05/05/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04
SP4+HF1 06/14/04 08/02/04 05/05/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04
SP4+HF2 06/14/04 08/02/04 05/05/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04
SP4+HF3 06/14/04 08/02/04 05/05/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04
SP4+HF4 06/17/04 08/02/04 05/05/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04
SP4+HF5 06/17/04 08/02/04 08/03/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04
SP4+HF6 08/03/04 08/02/04 08/03/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04
SP4+HF7 08/03/04 08/02/04 08/03/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04
SP4+HF8 08/03/04 08/02/04 08/03/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04
SP4+HF9 08/26/04 08/26/04 08/26/04 08/26/04 09/11/04 05/06/05 08/26/04 08/26/04 08/26/04 08/26/04
SP4+HF10 08/31/04 08/31/04 08/31/04 08/31/04 09/11/04 05/06/05 08/31/04 09/01/04 08/31/04 09/01/04
SP4+HF11 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 05/06/05 11/06/04 11/06/04 11/06/04 11/06/04
SP4+HF12 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 05/06/05 11/06/04 11/06/04 11/06/04 11/06/04
SP4+HF13 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 05/06/05 11/06/04 11/06/04 11/06/04 11/06/04
SP4+HF14 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 05/06/05 11/06/04 11/06/04 11/06/04 11/06/04
SP4+HF15 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 05/06/05 11/06/04 11/06/04 11/06/04 11/06/04
SP4+HF16 01/10/05 01/10/05 01/13/05 01/12/05 01/12/05 05/06/05 01/04/05 01/06/05 01/14/05 01/12/05
SP4+HF17 01/10/05 01/10/05 01/13/05 01/12/05 01/12/05 05/06/05 01/04/05 01/06/05 01/14/05 01/12/05
SP4+HF18 01/10/05 01/10/05 01/13/05 01/12/05 01/12/05 05/06/05 01/04/05 01/06/05 01/14/05 01/12/05
SP4+HF19 01/10/05 01/10/05 01/13/05 01/12/05 01/12/05 05/06/05 01/04/05 01/06/05 01/14/05 01/12/05
SP4+HF20 01/10/05 01/10/05 01/13/05 01/12/05 01/12/05 05/06/05 01/04/05 01/06/05 01/14/05 01/12/05
SP4+HF21 01/10/05 01/10/05 01/13/05 01/12/05 01/12/05 05/06/05 01/04/05 01/06/05 01/14/05 01/12/05
SP4+HF22 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 02/01/05 02/15/05
SP4+HF23 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 02/01/05 02/15/05
SP4+HF24 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 02/01/05 02/15/05
SP4+HF25 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 2/14/2005 02/15/05
SP4+HF26 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 2/14/2005 02/15/05
SP4+HF27 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 2/14/2005 02/15/05
SP4+HF28 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 2/14/2005 02/15/05
SP4+HF29 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/10/05 02/09/05 2/14/2005 02/15/05
SP4+HF30 03/16/05 05/18/05 03/16/05 03/16/05 03/23/05 05/06/05 03/16/05 03/16/05 03/29/05 03/29/05
SP4+HF31 05/24/05 05/18/05 04/25/05 04/25/05 05/24/05 05/06/05 05/23/05 05/23/05 05/24/05 05/24/05
SP4+HF32 05/24/05 05/18/05 04/25/05 04/25/05 05/24/05 05/06/05 05/23/05 05/23/05 05/24/05 05/24/05
SP4+HF33 05/24/05 05/18/05 05/06/05 05/24/05 05/24/05 05/06/05 05/23/05 05/23/05 05/24/05 05/24/05
SP5 10/11/05 08/02/05 08/28/05 10/12/05
SP5+HF1 10/11/05 08/02/05 08/28/05 10/12/05
SP5+HF2 10/11/05 08/02/05 08/28/05 10/12/05
SP5+HF3 10/11/05 08/02/05 08/28/05 10/12/05
d.u.=date unknown; exact intall date not documented
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Comments
v2.1 05/14/04 08/06/04 08/09/04 08/06/04 09/11/04 05/06/05 08/02/04 08/06/04 08/06/04 08/13/04 01/23/05

SP1 06/23/04 08/06/04 08/09/04 08/06/04 09/11/04 05/06/05 08/02/04 08/06/04 08/06/04 08/13/04 01/23/05

SP1+HF1 08/06/04 08/06/04 08/09/04 08/06/04 09/11/04 05/06/05 08/06/04 08/06/04 08/06/04 08/13/04 01/23/05

v2.2BETA 2/9/2005 02/14/05 2/9/2005 2/14/2005 01/31/05 05/06/05 2/9/2005 2/9/2005 02/01/05 02/15/05 01/23/05

v2.2BETA2 03/25/05 03/25/05

v2.2 07/11/05 07/12/05 07/12/05 07/12/05 03/23/06 07/11/05 07/12/05 07/12/05 07/12/05 08/28/05 07/11/05 08/24/06 10/12/05 01/17/06

v2.2+HF1 09/02/05 09/02/05 09/02/05 09/02/05 03/23/06 09/02/05 09/02/05 09/02/05 09/02/05 08/28/05 08/01/05 don't need 10/12/05

SP1 01/18/06 04/23/06 01/18/06 04/23/06 03/23/06 04/23/06 04/23/06 04/23/06 04/23/06 01/18/06 d.u. 08/24/06 05/11/06 01/17/06

SP1+HF1 01/18/06 04/23/06 01/18/06 04/23/06 03/23/06 04/23/06 04/23/06 04/23/06 04/23/06 01/18/06 d.u. 08/24/06 05/11/06 01/17/06

SP1+HF2 04/23/06 04/23/06 04/12/06 04/23/06 04/23/06 04/23/06 04/23/06 08/23/06 04/23/06 d.u. d.u. 08/24/06 05/11/06

SP1+HF3 04/23/06 04/23/06 04/12/06 04/23/06 04/23/06 04/23/06 04/23/06 04/23/06 04/23/06 04/26/06 d.u. 08/24/06 05/11/06

SP1+HF4 08/23/06 06/06/06 08/23/06 06/18/06 06/18/06 08/23/06 08/23/06 08/23/06 08/23/06 08/24/06 08/24/06 08/24/06

SP1+HF5 08/23/06 06/06/06 08/23/06 06/18/06 06/18/06 08/23/06 08/23/06 08/23/06 08/23/06 08/24/06 08/24/06 08/24/06

SP1+HF6 08/23/06 08/23/06 08/23/06 08/23/06 08/23/06 08/23/06 08/23/06 08/23/06 08/23/06 08/24/06 08/24/06 08/24/06

v3.0 04/02/07 04/02/07 03/15/07 04/02/07 04/02/07 04/09/07 04/02/07 04/02/07 04/02/07 04/02/07 04/03/07 d.u. 04/02/07 3/15/2007

v3.0+HF1 04/02/07 04/02/07 04/02/07 04/02/07 04/02/07 04/09/07 04/02/07 04/02/07 04/02/07 04/02/07 04/03/07 08/11/07 04/02/07

d.u.=date unknown; exact intall date not documented
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Comments
v6.2.9HF1,2,3 S57 Cat 05/11/06 05/11/06 05/11/06 05/03/06 05/03/06 05/03/06 05/11/06 05/11/06 05/11/06

v6.4.9 05/23/06 05/22/06 05/21/06 06/18/06 05/22/06 05/22/06 05/22/06 05/22/06 09/13/06 09/13/06 09/13/06 09/13/06 05/22/06

v6.4.9HF1&2 05/31/06 05/26/06 06/16/06 06/18/06 05/31/06 05/26/06 05/26/06 09/13/06 09/13/06 09/13/06 09/13/06 05/31/06

v6.4.9HF3&4 06/07/06 07/14/06 06/16/06 06/18/06 1/0/1900 07/14/06 6/8/2006 6/8/2006 09/13/06 09/13/06 09/13/06 09/13/06 6/8/2006

v6.4.9HF6 06/08/06 07/14/06 06/16/06 06/18/06 6/8/2006 07/14/06 6/8/2006 6/8/2006 09/13/06 09/13/06 09/13/06 09/13/06 6/8/2006

v6.4.9HF6pp 09/13/06 09/13/06 09/12/06 09/13/06 09/13/06 09/13/06 09/13/06 09/13/06 09/13/06 09/13/06 09/13/06 09/13/06 09/18/06

v7.1.0 (r1940) 01/30/07 01/30/07 01/30/07 01/30/07 01/30/07 d.u. 01/30/07 01/30/07 01/30/07 01/30/07 01/30/07 n/a 01/30/07

v7.2.0 (r1982) 03/04/07 03/04/07 03/04/07 02/27/07 03/07/07 03/14/07 03/07/07 03/07/07 03/07/07 03/05/07 03/07/07 08/11/07 03/05/07

v7.2.0 (r1984) 03/04/07 03/04/07 03/04/07 02/27/07 03/07/07 03/14/07 03/07/07 03/07/07 03/07/07 03/05/07 03/07/07 08/11/07 03/05/07 patch update

v7.2.2 (r1991) 03/07/07 03/07/07 03/07/07 03/07/07 03/07/07 03/14/07 03/07/07 03/07/07 03/07/07 04/02/07 03/07/07 08/11/07 d.u.

v7.3 (r2002) 04/02/07 04/02/07 04/16/07 03/20/07 04/02/07 04/09/07 04/02/07 04/02/07 04/02/07 04/02/07 04/03/07 08/11/07 d.u.

v7.3 (r2014) 04/02/07 04/02/07 04/16/07 04/02/07 04/02/07 04/09/07 04/02/07 04/02/07 04/02/07 04/02/07 04/04/07 08/11/07 d.u.

v7.3 (r2014_TCfix) d.u. 04/16/07 04/16/07 04/16/07 d.u. 05/06/07 d.u. 04/16/07 d.u. d.u. d.u. 08/11/07 d.u.
v7.3 (r2110) 07/07/07 07/07/07 d.u. d.u. d.u. d.u. d.u. 07/09/07 d.u. 08/11/07 07/10/07

v7.3 (r2114) 07/12/07 d.u. 07/12/07 d.u. d.u. d.u. d.u. d.u. d.u. 08/11/07 d.u.

v7.3 (r2119) d.u. d.u. 07/20/07 08/02/07 08/02/07 d.u. 08/02/07 07/29/07 07/19/07 08/11/07 07/20/07
v7.3 (r2143) 08/23/07 08/30/07
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 1
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0 A
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Comments
v7.1.0 (r1940) 01/30/07 01/30/07 01/30/07 01/30/07 01/30/07 d.u. 01/30/07 01/30/07 01/30/07 01/30/07 01/30/07 n/a 01/30/07
v7.2.0 (r1982) 03/04/07 03/04/07 03/04/07 02/27/07 03/07/07 03/14/07 03/07/07 03/07/07 03/07/07 03/05/07 03/07/07 08/11/07 03/05/07
v7.2.0 (r1984) 03/04/07 03/04/07 03/04/07 02/27/07 03/07/07 03/14/07 03/07/07 03/07/07 03/07/07 03/05/07 03/07/07 08/11/07 03/05/07 patch update
v7.2.2 (r1991) 03/07/07 03/07/07 03/07/07 03/07/07 03/07/07 03/14/07 03/07/07 03/07/07 03/07/07 04/02/07 03/07/07 08/11/07 d.u.
v7.3 (r2002) 04/02/07 04/02/07 04/16/07 03/20/07 04/02/07 04/09/07 04/02/07 04/02/07 04/02/07 04/02/07 04/03/07 08/11/07 d.u.
v7.3 (r2014) 04/02/07 04/02/07 04/16/07 04/02/07 04/02/07 04/09/07 04/02/07 04/02/07 04/02/07 04/02/07 04/04/07 08/11/07 d.u.
v7.3 (r2014_TCfix) d.u. 04/16/07 04/16/07 04/16/07 d.u. 05/06/07 d.u. 04/16/07 d.u. d.u. d.u. 08/11/07 d.u.
v7.3 (r2110) 07/07/07 07/07/07 d.u. d.u. d.u. d.u. d.u. d.u. d.u. 07/09/07 d.u. 08/11/07 07/10/07
v7.3 (r2114) d.u. 07/12/07 d.u. 07/12/07 d.u. d.u. d.u. d.u. d.u. d.u. d.u. 08/11/07 d.u.
v7.3 (r2119) d.u. d.u. d.u. 07/20/07 08/02/07 08/02/07 d.u. d.u. 08/02/07 07/29/07 07/19/07 08/11/07 07/20/07
v7.3 (r2143) d.u. d.u. d.u. 08/23/07 d.u. 08/30/07 d.u. d.u. 09/28/07 09/28/07 d.u. d.u. d.u.
v7.3 (r2180) d.u. d.u. d.u. 11/02/07 d.u. d.u. 11/02/07 03/11/08
v7.3 (r2196) 11/20/07 11/14/07 11/20/07 11/20/07 11/20/07 11/20/07 11/02/07 03/11/08
v7.3 (r2239) 12/03/07 12/03/07 12/03/07 12/04/07 12/03/07 12/03/07 12/03/07 12/03/07 12/03/07 03/11/08 12/03/07 12/03/07
v7.3 (r2252) 03/11/08 03/11/08 03/11/08 02/28/08 02/26/08 03/11/08 03/11/08 03/11/08 03/11/08 03/11/08 03/11/08 03/11/08
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License File updated? yes yes yes yes yes yes yes yes yes yes yes yes
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License expires Jan-08 Jan-08 Jan-08 Jan-08 Jan-08 Jan-08 Jan-08 Jan-08 Jan-08 Jan-08 Jan-08 Jan-08 Jan-08

License File updated? n/a yes n/a n/a n/a yes Yes Yes Yes Yes Yes Yes
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d.u.=date unknown; exact install date not documented
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License File updated? Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
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Comments

v3.0 3/22/2005 NA NA d.u. NA NA d.u. NA NA 3/21/06 d.u 7/18/2006 10/13/2004 10/4/2004
v3.02 NA NA NA NA NA NA 3/10/2006 7/18/2006 3/10/2006 3/10/2006

d.u.=date unknown; exact intall date not documented

011746-00300-04309-3BAD03D2
024156-00300-05068-0E94DA58Software 
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v8.5.2 07/31/04

v8.6.0 n/a

v8.7.2 2/9/2005 2/11/2005 2/28/2005

v8.7.3
v8.7.5 4/5/2005

v8.7.6 5/6/2005

v8.7.7 10/6/2005

v8.8 3/30/2006

v8.81 5/26/2006 5/26/2006 5/26/2006 5/26/2006 5/26/2006

v8.83 4/11/2007 3/29/2007

d.u.=date unknown; exact intall date not documented
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Comments

doesn't apply directly to us

For mvp .bot file processing

received new CON files Dec 2004

Seaterm Win 32 V 1.30, Seabird 5.27a
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Comments
v6.1.0 07/28/04 07/28/04
V6.1.1 08/03/04 08/03/04 08/13/04
v6.1.2c 10/05/04 10/07/04 10/07/04
v6.1.3 01/10/05 01/04/05 01/12/05 2 roving keys
v6.1.3i 03/07/05 03/29/05 What does this do?  We don't know.
v6.1.4a 04/18/05
v6.1.4d 8/15/2005 08/13/05 08/13/05 08/15/05 08/13/05 08/13/05 08/13/05 08/13/05 1 local key on Proc 3 and 1 Network key on FADC1
v6.1.5 d.u. 10/11/05 10/12/05
v6.2.0.a 03/06/06
v6.2.1 03/17/06

Lfledermaus FLEXid

9-
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B

9-6153BBA5 on FADC1 (network key)
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B
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v7.5 (4) 06/15/04 07/30/04 10/07/04 08/04/04 09/01/04 Removed from FA_Process_1

v7.8 05/06/05 05/18/05 05/24/05 05/24/05 Upgrade

v8.0 10/12/05 10/05/05 3/6/2006 10/11/05 10/06/05 10/4/2005 3/10/2006 10/20/05 10/05/05 10/12/2005 3 new licenses and 4 upgrades

v8.5 10/09/06 10/10/06 10/19/2006 7 copies to upgrade all 7 licenses
v9.0 08/16/07
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!! Phase and Amplitude
Bottom Detection

!! 150EE Wide Swath
Coverage

!! 240 kHz Frequency

!! Up to 500m Range
Capability

!! Portable
Configuration

!! Meets USACE Class 1
Standards

!! Meets IHO Standards

The SeaBat 8101 Multibeam Echo Sounder measures discrete depths, enabling
complex underwater features to be mapped with precision.  Dense coverage is
achieved utilizing up to 3,000 soundings per second for a swath that can be over
500 meters wide, even as the survey vessel travels at speeds of over 18 knots.

With high accuracy and a measurement rate up to 30 profiles per second, the
SeaBat 8101 enables surveys to be completed faster and in greater detail than
previously realized.  The SeaBat is an integral part of the new, integrated
bathymetry surveying systems.

The SeaBat transducer is available pressurized for depths from 100 to over 3,000
meters.  Small and lightweight, it can be can be mounted on small underwater
vehicles (ROV, AUV or towed) and taken to where accurate measurements are
required.

SeaBat 8101
PRODUCT SPECIFICATION

240kHz MULTIBEAM ECHO SOUNDER



©1999 RESON Inc.
Version 4.0  Due to our policy of continuous product improvement,
032399 specifications are subject to change without notice.

SeaBat 8101 Head
with Optional Fairings

SeaBat 8101 Built-In Test
Environment (“BITE”) Screen

SYSTEM SPECIFICATIONS

Operating Frequency: 240kHz
Range Scales: 5, 10, 15, 20, 25, 35, 50, 75, 100, 125,

150, 175, 200, 250, 300, 350, 400, 450,
500m. 

Range Resolution: 1.25 cm
Number of Beams: 101

Horizontal Beamwidth: 1.5E
Horizontal Coverage: 150E
Vertical Beamwidth: 1.5E

Update Rate: Range-variable up to
30 times per second

SONAR HEAD SPECIFICATIONS

Power Requirement: 24VDC, 2 Amps max.
(Power available from
surface processor.)

Uplink: Digital, 76.8 Mbaud
Down Link Control: RS-232 or RS-422, 19,200 baud

Operating Depth: 100 meters
(300m, 1500m, 3000m & 6000m avbl.)

Dimensions: 266x320mm W/Diam 
(does not include projector)

Temperature: Operating: -5E to +40EC
Storage: -30E to +55EC

Weight (aluminum): Dry: 26.8 kg (59 lbs)
Wet: 4.8 kg (10.6 lbs)

Weight (titanium): Dry: 40 kg (88 lbs)
Wet: 18 kg (39.6 lbs)

DISPLAY SPECIFICATIONS

Screen Size: 14 inch Diagonal 
Input: SVGA (800x600, 72 Hz)

Display: High Resolution Color
Power Consumption: 62 W

PROCESSOR SPECIFICATIONS

Power Requirements: 115/230VAC, 50/60Hz,
100W max.

Data Output: Selectable, 300-155.2 Kbaud
or Ethernet 10 base T
or 10 base 2

Video Output: SVGA (800x600, 72 Hz)
or NTSC or PAL video.

Graphics Colors: 256 colors (8-bit)
Display Mode: Sector Format

Display Arc: 150E
Input Device: 3-Button Trackball
Dimensions: 19" rack, 4U high

(266x483x434mm HWD)
Temperature: Operating: 0E to +40EC

Storage: -30E to +55EC
Weight: 20 kg (44 lbs)

OPTIONS

Option 033: Side Scan Upgrade
Option 034: Mounting Plate Assembly
Option 035: Fairings (pictured above)
Option 036: Spares Kit
Option 037: Titanium Housing
Option 038: 210° Swath
Option 040: Extended-Range Projector
Option 049: Increase Transducer Depth 

Rating



SeaBat 8111
PRODUCT SPECIFICATION

MULTIBEAM ECHOSOUNDER

•• Phase and amplitude
bottom detection

•• 100 kHz frequency

•• 150° swath coverage

•• Real-time quality
control

•• Sidescan upgradeable

•• Modular and portable

•• Pitch stabilization

The SeaBat 8111 is a modular multibeam echosounder system operating at
100 kHz. When installed on a vessel, it produces high-density, high-accuracy
soundings on the seafloor over a 150° swath. Major system components
include a transducer array, a transceiver unit, and a processor unit.

The SeaBat 8111 transducer array is comprised of a cylindrical receive array
and a linear transmitter array, mounted together on a support cradle that
provides mounting points to the vessel. Lightweight and portable, the array
can be installed temporarily over the side of a vessel of opportunity––a first for
a system in this frequency range.

The SeaBat 8111 transceiver features plug-in cards for easy maintenance and
is controlled from the sonar processor.

The Seabat 8111 processor is compatible with other SeaBat sonar heads, can
be updated in minutes to accommodate future requirements, and features a
user-friendly point-and-click interface.



MECHANICAL INTERFACE

Dimensions (in mm):
Transducer Array:

Hydrophone: 636 x 118 (Dia./Length)
Projector: 113 x 650 (Dia./Length)

Processor: 177 x 483 x 417
Transceiver: 267 x 483 x 489

Weight:
Transducer Array: 72 kg (dry) / 59 kg (wet)

with cables
Processor: 20 kg
Transceiver: 13.6 kg

Cable Length: 15m

SEAFLOOR COVERAGE
(with Extended Range option)

SeaBat 8111 SYSTEM SPECIFICATIONS

Version: B006 030205
©1999 RESON Inc.

Due to our policy of continuous product improvement,
RESON reserves the right change specifications without notice.

Transceiver
Processor

Transducer Array

636 OD

650118

113

Hydrophone Projector

SYSTEM PERFORMANCE

Frequency: 100 kHz

Range Resolution: 3.7 cm

Swath Coverage: 150º

Range: 3m to 1200m
(with Option 040)

Number of Beams: 101

Along-Track Beamwidth: 1.5º 3.0º 4.5º 6.0º*
Across-Track Beamwidth: 1.5º

Stabilization: Pitch stabilization 
within +/-15º

Projector Beam Control: External motion
sensor required

Accuracy: IHO Compliant

Operational Speed: Up to 20 knots

Max. Update Rate: 35 Hz

Transducer Pressure Rating: 100m

*operator selectable

INTERFACE

System Supply: 90 to 260VAC, 50/60 Hz,
200W max.

Video Display: SVGA, 800 x 600, 72 Hz

System Control: Trackball or from Ethernet

Data Output: 10 MB Ethernet or
serial RS232C

Data Uplink: High-speed digital coax
with fiber-optic option

Temperature: Operating: 0° to +40° C
Storage: -30° to +55° C

RELATED PRODUCTS
• Option 040 Extended range capabilities
• Option 033 Sidescan upgrade
• Option 051 24DC power supply for SeaBat

81-P Processor

Bottom Depth (meters) Swath Width (meters)
5 to 150 Up to 1110 (7.4 x water depth)

300 960 (3.2 x water depth)
450 810 (1.8 x water depth)
600 600 (1.0 x water depth)
750 450 (0.6 x water depth)
900 360 (0.4 x water depth)



SeaBat 8160
PRODUCT SPECIFICATION
MULTIBEAM ECHOSOUNDER SYSTEM

•• Swath coverage
greater than 4x
water depth

•• Operational depth:
10m to 3000m

•• 50 kHz frequency

•• 126 beams

•• Hull-mount or
portable

•• Meets IHO
accuracy

•• Sidescan
upgradable

The SeaBat 8160 is a new addition to the 8100 series of multibeam
echosounders. Operating at 50 kHz, the system ensonifies the whole
swath in a single ping, generating 126 simultaneous high-resolution
receive beams.

The SeaBat 8160 transducer array is comprised of a linear receive and
transmit array mounted together on a support base. The T-shaped array
geometry provides the basis for a compact, high-resolution sonar which
is easily installed for portable or hull mounts––a first for a high-resolution
system in this frequency range.

The system features a pitch-stabilized transmitter and an active roll-
compensated receiver.

The SeaBat 8160 processor is compatible with other SeaBat sonar heads.
It can be updated in minutes to accommodate future requirements, and
features a user-friendly point-and-click interface.

RESON, INC. • USA
Tel +1 805 964 6260
Fax +1 805 964 7537
Email: sales@reson.com

RESON A/S •  DENMARK
Tel +45 47 38 00 22
Fax +45 47 38 00 66
Email: reson@reson.dk
RESON OFFSHORE •  UK
Tel +44 1224 709 900
Fax +44 1224 709 910
Email: sales@reson.co.uk

w w w. r e s o n . c o m

RESON, GmbH • GERMANY
Tel +49 431 720 7180
Fax +49 431 720 7181
Email: reson@reson-gmbh.de



SYSTEM PERFORMANCE

Frequency: 50 kHz

Depth Resolution: 2.4 cm / 9.6 cm

Swath Coverage: Greater than 4x 
water depth

Max Operational Depth: 3000 m

Number of Beams: 126

Along-Track Beamwidth: 1.5º

Across-Track Beamwidth: 1.5º

Pitch Stabilization: ±10º

Accuracy: IHO Special Order

Operational Speed: Up to 20 knots

Max. Update Rate: 15

Transducer Depth Rating:

100m

INTERFACE

System Supply: 115V/230V 50/60 Hz,
350W

Video Display: SVGA, 800 x 600, 72 Hz

System Control: Trackball or from
Ethernet

Data Output: 10 MB Ethernet or
serial RS232C

Data Uplink: High-speed digital coax
with fiber-optic option

Temperature: Operating: 0° to +40° C
Storage: -30° to +55° C

MECHANICAL INTERFACE

Dimensions (HWD in mm):
Transducer Array: 1474.5 x 1100 x 90.5
Processor: 177 x 483 x 417
Transceiver: 265 x 483 x 492

Weight:

Transducer Array: 50 kg (dry) / 30 kg (wet)
Processor: 20 kg
Transceiver: 13.6 kg

SeaBat 8160 SYSTEM SPECIFICATIONS

Version: B34-PDF-011009
Due to our policy of continuous product improvement,

RESON reserves the right change specifications without notice.

1100mm

1350mm

124.5mm

150mm

90.5mm

Transceiver Processor

Transducer Array

Mounting Frame
Option 034H



Applanix LLC  17461 Village Green Drive, Houston, TX, 77040  
tel: 713-896-9900  fax: 713-896-9919 email: info@applanix.com

Performance

Position (m)

Velocity (m/s)

Roll and Pitch

True Heading

Heave

0.02 - 0.10

0.03

0.01û

0.5 - 4.0

0.03

0.02û

4m baseline: 0.01, 2m baseline: 0.02û

5% of heave amplitude or 5cm

RTK DGPS

Size

Weight

Power

Operating Temperature

Humidity

Cables

IMU

PCS

Antenna

Choke Ring

IMU

PCS

IMU & Antennas

PCS

IMU & Antennas

PCS

IMU

Antennas

204 x 204 x 168mm

441 x 111 x 346mm, 2.5U 19" rack mount

178    x 77mm (2x)

360    x 61mm (2x)

3.5 Kg

7 Kg

110/220 VAC, 60/50 Hz, 60W

-40û to +60ûC

0û to +60ûC

0 to 100%

5 to 95% RH non-condensing

8m standard

15m standard (2x)

Ethernet Interface 
(10base-T)

Function

Data

UDP Ports

IP Ports

NMEA Port

High rate attitude 
data port

Auxillary GPS input

Operate POS MVTM & record data

Position, attitude, heading, velocity, track and speed, 

acceleration, status and performance, raw data.  

All data has time and distance tags

Display port - low rate (1Hz) data

Data port - high rate (1-200Hz) data

Control port - used by POSTM controller

GGA, HDT, VTG, GST, ZDA, PASHR, PRDID (1-50Hz), GGK

Roll, pitch, true heading and heave in all multibeam 

proprietary formats (1-200 Hz)

GGA, GST, GSA, GSV from Auxilliary DGPS, P-code or 

RTK reciever

RS232 Interface (DB9 
males)

Options Internal RTK GPS receiver; analog interface (roll, pitch & heave); field support kit

Physical Specifi cations

Interfaces

All performance figures are RMS, unless otherwise noted.  Specifications subject to change without notice.



The new POS MV V4 - a tightly-coupled system utilizing 
advanced Inertially-Aided Real-Time Kinematic (IARTK) 
technology designed to increase your operational capability 
and reduce downtime.

Tightly integrated inertial navigation – Continuous positioning 
data can be generated while surveying in areas where GPS reception 
is compromised by multipath effect and signal loss, such as close to 
offshore structures, or in ports, harbors, near-shore coastal waters 
and rivers. Raw GPS data from as few as one satellite can now be 
processed directly within the POS MV reducing position drift and RTK 
re-acquisition time. 

The V4 Advantage 
The Major Benefi ts

• Faster, more robust heading aiding from GPS Azimuth 
Measurement Subsystem (GAMS) when compared to V3

• Proprietary Inertially Aided RTK providing almost 
instantaneous reacquisition of RTK following a GPS outage

• Superior low elevation tracking performance using lighter, 
smaller Trimble Zephyr ™ geodetic antenna technology

• Faster initial system calibration 
• Maintains heading accuracy longer when in a high multipath 

environment 
• Increased component reliability
• Automatic identifi cation and error estimation for lever arm 

distances and angles

The Latest Technology
V4 uses the latest Trimble BD950 receivers with the following 
attributes:

• Extremely fast response time
• Latency of less than 20 milliseconds (at 20 times per second) Latency of less than 20 milliseconds (at 20 times per second) 
• Very low noise L1 and L2 carrier phase Very low noise L1 and L2 carrier phase 

measurements
• Uses the Maxwell 4 Custom Survey 

GPS chip for enhanced tracking 
capability    

Straightforward Installation and Operation 
• All components mounted and installed using a straightforward, 

one-time-only, systematic procedure. 

Faster, More Reliable Networking Potential
• An improved Ethernet raw data logging capability for 

streamlined data acquisition of all motion variables with 
microsecond-accurate time stamping   

Upgradeability*
• Convenient upgrade program for PCS and antennas, to allow 

for maximum interoperability when moving from L1 only to a 
full L1/L2 RTK unit

The Most Accurate Position and Orientation Solution
POS MV V4 maintains positioning accuracy under the most demanding 
conditions regardless of vessel dynamics. With its high data update rate, 
the system delivers a full six degree-of-freedom position and orientation 
solution to provide the following:

• Position (latitude, longitude and elevation)
• Velocity (north, east and vertical)
• Attitude (roll, pitch and true heading)
• Heave (real-time, delayed)
• Acceleration Vectors
• Angular Rate Vectors

* For detailed upgrade information please call your Applanix Marine offi ce 

SYSTEM COMPONENTS
POS Computer System (PCS) – A rugged, compact computer system contains the 
core POS processor and IMU interface electronics, plus two GPS receivers and an optional 
removable PC-card disk drive. The PCS provides system timing, position and velocity aiding, 
together with GPS raw observables for use with GAMS.

POS Inertial Measurement Unit – The system’s primary sensor allows for the 
continuous output of position and orientation data. 

Primary GPS Receiver Antenna – A dual frequency antenna for use with GAMS.

Secondary GPS Receiver Antenna – A dual frequency antenna for use with GAMS.

Latency of less than 20 milliseconds (at 20 times per second) Latency of less than 20 milliseconds (at 20 times per second) 
Very low noise L1 and L2 carrier phase Very low noise L1 and L2 carrier phase 

DATASHEET
The New POS MV - Providing the Marine Industry with robust, reliable, and 
repeatable position and orientation solutions



SPECIFICATIONS
Accuracy

POS MV 320 Main Specifi cations (with Differential Corrections)

Roll, Pitch accuracy: 0.02° (1 sigma with GPS or DGPS)

0.01° (1 sigma with RTK) 

Heave Accuracy: 5 cm or 5% (whichever is greater) for periods of 20 
seconds or less

Heading Accuracy: 0.02° (1 sigma) with 2 m antenna baseline, 0.01 (1 
sigma) with 4 m baseline

Position Accuracy: 0.5 - 2 m (1 sigma) depending on quality of differential 
corrections

0.02 - 0.10 m (RTK) with input from auxiliary RTK or 
optional internal RTK receiver

Velocity Accuracy: 0.03 m/s horizontal

POS MV 320 during GPS Outages

Roll, Pitch accuracy: 0.02° (1 sigma) 

Heave accuracy: 5 cm or 5% (whichever is greater) for wave periods 
of 18s or less

Heading accuracy: Drift less than 1° per hour (negligible for outages < 
60s)

Position accuracy
degradation:

2.5 m (1 sigma) for 30 s outages
<6 m (1 sigma) for 60 s outages

POS MV 220 Main Specifi cations (with Differential Corrections)

Roll, Pitch accuracy: 0.05° (1 sigma with GPS or DGPS)

<0.05° (1 sigma with RTK) 

Heave Accuracy: 5 cm or 5% (whichever is greater) for periods of 20 
seconds or less

Heading Accuracy: 0.1° (1 sigma) with 2 m antenna baseline, 0.05° (1 
sigma) with 4 m baseline

Position Accuracy: 0.5 - 4 m (1 sigma) depending on quality of differential 
corrections

0.02 – 0.10 m (RTK) with input from auxiliary RTK or 
optional internal RTK receiver

Velocity Accuracy: 0.05 m/s horizontal DPGS, .03 m/s horizontal RTK

POS MV 220 during GPS Outages

Roll, Pitch accuracy: 0.05° (1 sigma) 

Heave accuracy: 5 cm or 5% (whichever is greater) for wave periods 
of 18s or less

Heading accuracy: Drift less than 3° per hour (negligible for outages < 
60s)

Position accuracy 
degradation:

2.5 m (1 sigma) for 30 s outages
<6 m (1 sigma) for 60 s outages

Physical Characteristics

Size

IMU: 204 mm X 204 mm 
X 168 mm

7.95 in X 7.95 in 
X 6.55 in

PCS: 432 mm X  89 mm 
X 356 mm 

17.00 in X3.50 in 
X 14.05 in

2.0U 19 in rack 
mount 

GPS Antenna (x2): 187 mm X 53 mm 7.4 in X 2.1 in

Weight

IMU: 3.5 kg 7.7 lb (international)

Processor: 5 kg 11.0 lb (international)

GPS Antenna: <0.5 kg <1.1 lb (international)

Power

Processor: 110/230 Vac, 50/60 Hz, auto-switching 80 Watt

IMU: Power provided by PCS

GPS Antennas: Power provided by PCS

Environmental

Temperature Range (Operating)

IMU: -40 °C to +60 °C -40 °F to +140 °F

Processor:    0 °C to +55 °C +32 °F to +131 °F

GPS Antenna: -40 °C to +70 °C -40 °F to +158 °F

Temperature Range (storage)

IMU: -40 °C to +60 °C -40 °F to +140 °F

Processor: -25 °C to +85 °C -13 °F to +185 °F

GPS Antenna: -50 °C to +70 °C -58 °F to +158 °F

Humidity
IMU: 10 - 80% RH, Ingress Protection of 65
Processor: 10 - 80% RH, non-condensing
GPS Antenna: 0 - 100% RH

Shock & Vibration (IMU)
Operating: 90 g, 6 ms terminal saw tooth

Non-Operating: 220 g, 5 ms half-sine

Applanix Marine Offi ces
Applanix Corporation

85 Leek Crescent
Richmond Hill, Ontario

Canada L4B-3B3 

Tel: +1 905-709-4600
Fax: +1 905-709-6027

Applanix LLC
17461 Village Green Drive

Houston, TX 
USA 77040

Tel: +1 713-896-9900
Fax: +1 713-896-9919

Applanix United Kingdom
Forester’s House, 

Old Racecourse, Oswestry 
SY10 7PW UK

Tel: +44 1691 659359
Fax: +44 1691 659299

 



MBX-3S
The most popular commercial-grade 
Coast Guard Beacon Receiver

www.csi-wireless.com

• Dual-channel Coast Guard beacon receiver

• Supplements GPS systems with free differential corrections,
enhancing accuracy

• Fast signal acquisition

• Wide input voltage range for a variety of power sources

• Low power consumption extends battery life 

• Automatic tuning mode for hands-free operation

• Integrated signal splitter outputs GPS signal from combined 
GPS /differential antennas

• Front-panel interface for easy configuration and status monitoring



Receiver Specifications 
Channels: 2 independent channels
Channel Spacing: 500 Hz
Frequency Range: 283.5 to 325.0 Hz
MSK Bit Rates: 50, 100, 200 bps 
Cold Start Time: <1 min
Warm Start Time: <2 seconds
Demodulation: Minimum shift keying
Sensitivity: 2.5 µV/m for 6 dB SNR
Dynamic Range: 100 dB
Frequency Offset: ±8 Hz (27 ppm)
Adjacent Channel Rejection: 61 dB fo ± 400 Hz
Correction Output Protocol: RTCM SC-104
Input Status Protocol: NMEA 0183

Communications 
Interface: RS-232C or RS-422
Baud Rates: 2400, 4800, 9600

Environmental Specifications
Operating Temperature: -30°C to +70°C
Storage Temperature: -40°C to +80°C
Humidity: 95% non-condensing
EMC: EN 60945

EN 50081-1
EN 50082-1
FCC: Part 15, sub-part J,
class A digital device

Power Specifications
Input Voltage Range: 9 to 40 VDC
Nominal Power: 2.5 W
Nominal Current: 210 mA
Antenna Voltage Output: 10 VDC (5 VDC optional)
Antenna Input Impedance: 50 Ω

Mechanical Specifications
Dimensions: 150 mm L x 125 mm W x 51 mm H

(5.9” L x 4.9” W x 2.0” H)
Weight: 0.64 kg (1.4 lb)
Display: 2-line x 16-character LCD
Keypad: 3-key switch membrane
Power Connector: 2-pin circular locking
Data Connector: DB9-S
Antenna Connector: BNC-S
Optional GPS Output Port: TNC-S

Operating Modes
MBX-3 Mode (Default): RTCM SC-104 correction and

NMEA status message output 
(Default Mode)

MBX-E Mode: RTCM SC-104 correction and 
NMEA status message output 
and GPS NMEA message 
input for position and satellite 
status display

NMEA 0183 I/O
• Receiver Automatic and Manual tune command
• Frequency and data rate query
• Receiver performance and operating status queries
• Automatic search almanac queries (proprietary)
• Baud rate selection command
• Receiver tune command
• Force cold start command (proprietary)
• Software upgrade command (proprietary)
• Configuration up-load command (proprietary)

Accessories
Antenna: Various
Power Cables: Various
Antenna Cables: Various
Data Cables: Various
CSI Beacon 
Command Center: MS Windows 95® beacon 

control software

Pin-out
RS, 232C (DB9 PIN#)

Pin 2 TXD,RTCM SC-104/Status Output
Pin 3 RXD, configuration input
Pin 5 Signal return 

RS-422 (DB9 PIN#)

Pin 1 TXD +, RTCM SC-104 / 
Status Output

Pin 2 TXD -, RTCM SC-104 / 
Status Output

Pin 4 RXD -, configuration input
Pin 5 Signal return
Pin 7 RXD +, configuration input

© Copyright September 2002, CSI Wireless Inc. All rights reserved. Specifications subject to change without notice.
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Key Features

High-performance 
GPS with a world of 
real-time options 
The versatile GPS Pathfinder® Pro XRS receiver is 
the thoroughbred of GPS receivers. Offering a full 
range of accurate real-time correction sources, 
great performance in all GPS conditions, and 
rugged design for the toughest environments, the 
Pro XRS is an essential tool for collecting and 
maintaining GPS data.

Built to meet your demands
With the Pro XRS, you don’t have to worry 
whether your GPS receiver can stand up to harsh 
conditions. All its components are sealed in a 
robust casing. Waterproof, dustproof, and  
shock-resistant, the Pro XRS can work  
anywhere you can. 

Just as tough is the custom-designed ergonomic 
backpack. But it’s light and comfortable, so you 
can wear it all day.

You’re spoiled for real-time choice
If you’re navigating in the field, or finding your way 
back to a previously recorded feature, you’ve got 
all the real-time options covered. Corrections from 
a radiobeacon, a satellite differential service such 
as OmniSTAR, or a satellite-based augmentation 
system (SBAS) like WAAS1 or EGNOS2 are not 
just built in, they’re seamlessly integrated into 
the receiver. Want the freedom to connect to an 
external correction source like a virtual reference 
station (VRS)? You’ve got it. This array of real-time 
sources makes the Pro XRS the most adaptable 
real-time GPS receiver around.

High quality, accurate data for your GIS
With the Pro XRS, you can be sure that the data 
you collect meets your high standards. Offering 
submeter accuracy in real time, and centimeter-
level postprocessed accuracy, it’s the obvious 
choice for collecting the high quality GPS data 

you need in your GIS. And it has advanced  
design features, like EVEREST™ multipath 
rejection technology, to ensure you get only the 
best positions.

Get the results you want
The GPS Pathfinder Pro XRS’s advanced design 
gives you complete control over GPS quality. You 
can focus on productivity, to keep working even in 
adverse GPS conditions. Or you can configure the 
receiver to deliver only the most precise positions. 
It’s up to you. 

Flexible data collection options
Pick the field device and software that fits your 
workflow. The Pro XRS is ready to use with a 
variety of field computers, including Trimble’s own 
range of handheld computers: the GIS TSCe™ 
field device, the Trimble® Recon™ handheld, and 
the GeoExplorer® series.

Choosing software? Try the TerraSync™ software, 
for a complete solution from the field to the  
office and back. Choose off-the-shelf GPS field 
software. Or use the GPS Pathfinder Tools SDK 
to build your own application that’s totally 
customized to your needs.

All you need
You need equipment that’s as 
adaptable and hard-working 
as you are. So when you’re 
choosing GPS equipment, 
don’t compromise. Get a 
GPS Pathfinder Pro XRS receiver 
and have it all. 

Key Features

• Real-time submeter accuracy

• Integrated satellite, beacon, 
and WAAS/EGNOS differential 
receiver

• EVEREST multipath rejection

• Rugged design

• Ergonomic, comfortable 
backpack system

• Choice of field device and field 
software 

GPS Pathfinder Pro XRSGPS Pathfinder Pro XRS











































Impulse 200 LR Laser 
Our Impulse lasers are specifically designed for optimal performance under whatever conditions you might encounter
in the field. They are lightweight, extremely rugged, completely waterproof and versatile. Use them as a handheld
unit or mount them on a tripod for added stability. 

Impulse Laser w/
1.5 to 4 X Zoom Scope
and Mounting Bracket

Impulse Laser w/
Red-dot Scope
and Hand Strap

Hardware Specifications: 

7070 S. Tucson Way, Centennial, CO  80112 USA 
Toll Free: 1 (800) 280-6113  |  Local: 1 (303) 649-1000

 Web Page: www.lasertech.com  |  E-mail: info@lasertech.com

* All specifications are subject 
to change without notice.  

(Rev. 11/15/03)

Key Features: 

- Custom backlit LCD display
- Audible and visual indicators
- RS232 serial output for
   electronic data storage
- Selective range gating for
  positive target acquisition
- Built-in tilt sensor 
- Filter system to discriminate
  reflective targets
- Cumulative distance capability
- Determines the distance 
   between two in-line objects
- Integrates with GPS

For 3-D data collection,
integrate the Impulse with

a MapStar System.

Package Includes: 

- Impulse laser
- Red-dot scope
- Hand strap
- Tripod / monopod
   mounting bracket
- (2) AA batteries
- Operator's manual
- Padded carrying case

Optional Accessories:

- 1.5 to 4 X zoom scope
- Yoke and staff
- Remote trigger data cable

MapStar
Angle

Encoder

MapStar 
Compass
Module

Typical Target                   IMPULSE 200 LR

Accuracy & Range (Imperial) (Metric)

Accuracy (Typical) 0.1 - 0.2 ft 3 - 5 cm

Accuracy (Max) 0.5 ft 15 cm

Overhead cable / Stake 330 ft 100 m

Phone pole / Stockpile 655 ft 200 m

Tree / Tower 985 ft 300 m

Rock Face / Building 1640 ft 500 m

Max Distance 1885 ft 575 m

Range Resolution .01 ft 0.01 m

Inclination Limits  +/- 90 deg  +/- 90 deg

Inclination Accuracy  +/- 0.1 deg  +/- 0.1 deg

Weight 2.2 lbs. 1 kg

Size  6 x 2.5 x 5 in. 15.2 x 6.4 x 12.7 cm 

Power Supply  (2) AA batteries (20 hours of use)

Environment  Waterproof to IP 67 and NEMA 6

Temperature  - 22 to + 140 F  -30 to + 60 C   

(Max distances are approximate)



SPECIFICATIONS FOR LASER TECH TRUPULSE 200 LASER RANGEFINDER 

 

Dimensions 5" x 2" x 3.5" (12cm x 5cm x 9cm) 
Weight 8 ounces (220 g) 
Data Communication Serial, via wired RS232 (standard)  
Power                                 3.0 volts DC nominal 
     Battery Type (2) AA or (1) CRV3  

     Battery Duration AA:  Approximately 7,500 measurements                                                                  
CRV3:  Approximately 15,000 measurements 

Eye Safety  FDA Class 1 (CFR 21) 
Environmental Impact, Water & Dust Resistant. NEMA 3, IP 64 
Temperature -4°F to +140°F (-20°C to +60°C) 
Optics 7X Magnification  (Field-of-view; 330 ft @ 1000 yards) 
Display In-scope LCD 
Units Feet, Yards, Meters, and Degrees 
Monopod/tripod mount ¼ " - 20 female thread 
Measurement Range  
     Distance 0 to 3280 ft (1000 m) typical, 6560 ft (2000m) max to reflective target 
     Inclination ± 90 degrees 
Accuracy  
     Distance ±1 ft (± 30 cm) to high quality targets, ±1 yd (±1 m) to low quality targets 
     Inclination ±0.25 degrees 

Measurement Modes Horizontal Distance, Vertical Distance, Slope Distance and Inclination, and 3-point 
flexible height routine with auto sequencing 

Target Modes Standard, Closest, Farthest, Continuous, and Filter (requires reflector and foliage 
filter) 

 

 

 



















 

 
 

 
Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4585



L I M I T E D   L I A B I L I T Y   S T A T E M E N T 

Extreme care should be exercised when using or servicing this equipment.  It should be used or
serviced only by personnel with knowledge of and training in the use and maintenance of
oceanographic electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing of
this system.  SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment or of
choosing the personnel to operate it, and therefore cannot take steps to comply with laws pertaining to
product liability, including laws which impose a duty to warn the user of any dangers involved in
operating this equipment.  Therefore, acceptance of this system by the customer shall be conclusively
deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use of servicing of this
system.
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WARNING !!
Do not submerge this instrument (S/N 19P36026-4585)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Titanium) 7000 meters

Pressure Sensor (3500 dBar) Druck 3500 meters

Pump (SBE 5M) 10500 meters
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 SYSTEM CONFIGURATION 14 June 2004 
 
   
   
 Model SBE 19plus S/N 19P36026-4585 
 Instrument Type SBE 19plus SeaCaT Profiler 
 Firmware Version 1.4D 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 8192K 
 Housing 7000 meter (3AL-4V Titanium) 
 0 Conductivity Raw Frequency 2630.97 Hz 
 Pressure Sensor Strain Gauge: 3500 dBar, S/N 5433 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain gauge 
   
 
          Pump (SBE 5M) 050647 
 
   
   
 Voltage Delay Setting (standard) (standard) 0 seconds 
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IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION 
 
Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data 
analysis and display: 
• SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP 
• SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive 
Detailed information on the use of the Windows software follows: 
 
SEASOFT-Win32 
SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win 
95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the 
procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for 
setup, data collection and retrieval, data display, and data processing: 
• SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the 

90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM) 
• SEASAVE - real-time data acquisition program 
• SBE Data Processing - data processing program 
Instructions for using the software are found in their Help files. 
 
To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive, 
SEATERM must have information about the CTD hardware configuration (communication parameters, internal 
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe: 
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears. 

A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s 
configuration sheet. If necessary, change the com port to match the computer you are using. 

B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.  
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors, 
exactly as they appear in the configuration (.con) file. 

C. On the Header Information tab, change the settings as desired. 
Click OK when done. SEATERM saves the settings in a SEATERM.ini file. 

2. On the Toolbar, click Connect to communicate with the CTD. 
3. To set up the CTD prior to deployment: 

On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the 
CTD setup matches your desired deployment. If not, send commands to modify the setup. 

4. To upload data from the CTD: 
On the Toolbar, click Upload to upload data from the CTD memory to the computer. 

 
Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or 
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data. 
The calculations required to convert from raw data to engineering units of the measured parameters (temperature, 
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after 
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the 
recorded data and creates the file on the computer hard drive.  
 
To successfully store data to a file on the computer and subsequently convert it to engineering units, the software 
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD. 
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has 
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given 
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is 
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the 
Configure menu in SEASAVE or  
SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units  
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in  
SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data 
processing. 
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The instrument type and instrument configuration settings of the .con file and the required setup for the 
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's 
sensors are contained in the calibration coefficient section of the CTD manual. 
 
 NOTE: 
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE 
Data Processing will not interpret the data correctly without the correct .con file. 

 
 
 
 
 
 

SEASOFT CONFIGURATION: 
 
The correct instrument type for your instrument is SBE 19plus SEACAT Profiler.  The correct settings for the configuration of your 
instrument as delivered are documented below: 

 
  

  

0 
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as
well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications
pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in
T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (8 Mbyte vs 1).
There is more power for auxiliary sensors (500 ma vs 50), and they are acquired at higher resolution (14 bit vs 12). Cabling is
simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated
connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH
memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core,
armored cable directly to your PC’s serial port (maximum transmission distance dependent on number of auxiliary sensors,
baud rate, and cable properties). The 19plus’ faster sampling and pump-controlled TC-ducted flow configuration significantly
reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features.
Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescense, PAR, and ORP can be added, and for moored deployments the
19plus can be set to time-series mode using software commands. External power and two-way real-time communication over
10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a
superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design,
materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use.
Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory.
They permit data output in ASCII engineering units (degrees C, Siemens/m, decibars, Salinity [PSU], sound velocity [m/sec],
etc.). The 19plus can be factory-configured to emulate the .hex output format and 2 Hz data rate of old SEACATs for
compatibility with existing software or instrument fleets.

Accuracy, convenience, portability, software, and support; compelling reasons why the 19plus is today’s best low-cost CTD.

CONFIGURATION AND OPTIONS

A standard SBE 19plus is supplied with:
• Plastic housing for depths to 600 meters
• Strain-gauge pressure sensor
• 8 Mbyte FLASH RAM memory
• 9 D-size alkaline batteries
• Impulse glass-reinforced epoxy bulkhead connectors: 4-pin I/O,

2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)
• SBE 5M miniature pump and T-C Duct

Options include:
• Titanium housing for depths to 7000 meters
• Sensors for oxygen, pH, fluorescence, light (PAR), light transmission,

and turbidity
• SBE 5T pump in place of SBE 5M for use with dissolved oxygen and/or

other pumped sensors
• Stainless steel cage
• MCBH Micro connectors
• Ni-Cad batteries and charger

SOFTWARE

SEASOFT©-Win32, our complete Windows 95/98/NT/2000/XP software package,
is included at no extra charge. Its modular programs include:
• SEATERM© — communication and data retrieval
• SEASAVE© — real-time data acquisition and display
• SBE Data Processing© — filtering, aligning, averaging, and plotting of CTD and

auxiliary sensor data and derived variables

Shown with
optional cage,
SBE 5T pump,

& SBE 43
DO sensor
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

Water intake

SBE 5M 
pump

Y-fitting

Air bleed 
valve

Data I/O 
cable

Pump 
inlet port

Pump 
exhaust port

Conductivity cell guard 
(covering temperature 
sensor, TC duct, & 
conductivity sensor)

Dimensions
in millimeters
(inches)

Data I/O

Auxiliary
Differential
Inputs

Pump

Optional
Auxiliary
Input

575 (22.65)

99 (3.90) DIA

 808 (31.80)

136 
(5.37)

103 
(4.05)

SPECIFICATIONS
Measurement Range
Temperature -5 to +35 °C
Conductivity 0 to 9 S/m
Pressure 0 to 20 / 100 / 350 / 1000 / 2000 / 3500 / 7000 meters
Initial Accuracy
Temperature 0.005 °C
Conductivity 0.0005 S/m
Pressure 0.1% of full scale range
Typical Stability (per month)
Temperature 0.0002 °C
Conductivity 0.0003 S/m
Pressure 0.004% of full scale range
Resolution
Temperature 0.0001 °C
Conductivity 0.00005 S/m (most oceanic waters; resolves 0.4 ppm in salinity)

0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)

Pressure 0.002% of full scale range
Memory 8 Mbyte non-volatile FLASH memory
Data Storage Recorded Parameter Bytes/Sample

T + C 6
pressure 5
each external voltage 2

Real-Time Clock 32,768 Hz TCXO accurate to ±1 minute/year
Internal Batteries 9 alkaline D-cells provide 60 hours continuous CTD operation;

optional 9-cell rechargeable nickel-cadmium battery pack
provides approximately 24 hours operation per charge

External Power Supply 9 - 28 VDC
Power Requirements
Sampling 65 mA
SBE 5M pump 95 mA
Quiescent 30 µA
Auxiliary Voltage Sensors
Auxiliary power out up to 500 mA at 10.5 - 11 VDC
A/D resolution 14 bits
Input range 0 - 5 VDC
Housing Materials — Depth Rating — Weight
Acetal Copolymer Plastic housing — 600 meter (1950 feet) — 7.3 kg (16 lbs)
3AL-2.5V Titanium housing — 7000 meter (22,900 feet) — 13.7 kg (30 lbs)
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Sea-Bird Electronics, Inc. E-mail: seabird@seabird.com 
1808 136th Place NE, Bellevue, Washington  98005  USA Telephone: (425) 643-9866 
Website: http://www.seabird.com Fax: (425) 643-9954 

Mini Submersible Pump  SBE 5M 
 
 
The SBE 5M pump module consists of a centrifugal pump 
head and a long-life, DC ball bearing motor contained in a 
compact, titanium, pressure housing usable to  
10,500 meters deep. The pump impeller and electric drive 
motor are coupled magnetically through the housing, 
providing high reliability by eliminating moving seals. Motor 
speed and pumping rate remain constant over the entire 
input voltage range. The motor drive electronics is 
intrinsically protected against accidental reversed polarity. 
 
 
APPLICATIONS 
 
The SBE 5M is standard on the SBE 19 and 19plus 
SEACAT Profiler CTD. It is optional on the SBE 16, 16plus, 
and 16plus-IM SEACAT C-T Recorder. The pump flushes 
water through the conductivity cell at a constant rate, 
independent of the CTD's motion, improving dynamic 
performance. For applications requiring pumping through 
additional sensors (for example, a dissolved oxygen 
sensor), use the SBE 5T pump instead. 
 
Specify: 
• Option 5M-1 for profiling (continuous duty) applications 

such as the SBE 19plus. 
• Option 5M-2 for moored (pulsed duty) applications such 

as the SBE 16plus or 16plus-IM. 
Contact Sea-Bird for use in other applications. 
 
SPECIFICATIONS 
 
Option 5M-1 (continuous duty):  
Input voltage range 9 - 18 VDC  
 
Flow Rate 25 ml/s supply current 95 ma 
 
Note: Supply current is independent of operating voltage. 
 
 
Option 5M-2 (pulsed duty):  
Input voltage range 6 - 18 VDC  
 
Pulse Duration Flow Volume Electrical Charge 

0.5 seconds 15 ml 0.148 amp-seconds 
1.0 seconds 21 ml 0.283 amp-seconds 
1.5 seconds 31 ml 0.418 amp-seconds 
2.0 seconds 40 ml 0.553 amp-seconds 
 
 
 
 
Weight 
In Air: 0.42 kg (0.91 lbs) 
In Water: 0.28 kg (0.60 lbs) 
 06/03 

Optional  
wet-pluggable 
connector, 
MCBH-2MTI 
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1808 136th Place NE, Bellevue, Washington  98005  USA                 Tel: (425) 643-9866
Website: http://www.seabird.com                                                         Email: seabird@seabird.com

Sea-Bird Electronics, Inc. FAX: (425) 643-9954

SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0647

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA8.015 7.73

Vin 9V voltage across C2: VDC      Current mA8.014 7.4

Vin 6V voltage across C2: VDC      Current mA5.888 7.61

Pump submerged test, no load, Vin 12VDC Average current draw in water: 121 mA
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Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4616 and -4617



WARNING !!
Do not submerge this instrument (S/N 19P36026-4616)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters

Pressure Sensor (1000 dBar) Druck 1000 meters

Pump (SBE 5M) 10500 meters
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WARNING !!
Do not submerge this instrument (S/N 19P36026-4617)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters

Pressure Sensor (1000 dBar) Druck 1000 meters

Pump (SBE 5M) 10500 meters
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 SYSTEM CONFIGURATION 14 June 2004 
 
   
   
 Model SBE 19plus S/N 19P36026-4616 
 Instrument Type SBE 19plus SeaCaT Profiler 
 Firmware Version 1.4D 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 8192K 
 Housing 600 meter (Celcon plastic) 
 0 Conductivity Raw Frequency 2686.52 Hz 
 Pressure Sensor Strain Gauge: 1000 dBar, S/N 5512 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain gauge 
   
 
          Pump (SBE 5M) 050651 
 
   
   
 Voltage Delay Setting (standard) (standard) 0 seconds 
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 SYSTEM CONFIGURATION 14 June 2004 
 
   
   
 Model SBE 19plus S/N 19P36026-4617 
 Instrument Type SBE 19plus SeaCaT Profiler 
 Firmware Version 1.4D 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 8192K 
 Housing 600 meter (Celcon plastic) 
 0 Conductivity Raw Frequency 2801.47 Hz 
 Pressure Sensor Strain Gauge: 1000 dBar, S/N 5513 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain gauge 
   
 
          Pump (SBE 5M) 050649 
 
   
   
 Voltage Delay Setting (standard) (standard) 0 seconds 
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1808 136th Place NE, Bellevue, Washington  98005  USA                 Tel: (425) 643-9866
Website: http://www.seabird.com                                                         Email: seabird@seabird.com

Sea-Bird Electronics, Inc. FAX: (425) 643-9954

SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET for 4616

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0651

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA7.947 11.8

Vin 9V voltage across C2: VDC      Current mA7.948 11.0

Vin 6V voltage across C2: VDC      Current mA5.868 10.2

Pump submerged test, no load, Vin 12VDC Average current draw in water: 124 mA
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IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION 
 
Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data 
analysis and display: 
• SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP 
• SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive 
Detailed information on the use of the Windows software follows: 
 
SEASOFT-Win32 
SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win 
95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the 
procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for 
setup, data collection and retrieval, data display, and data processing: 
• SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the 

90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM) 
• SEASAVE - real-time data acquisition program 
• SBE Data Processing - data processing program 
Instructions for using the software are found in their Help files. 
 
To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive, 
SEATERM must have information about the CTD hardware configuration (communication parameters, internal 
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe: 
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears. 

A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s 
configuration sheet. If necessary, change the com port to match the computer you are using. 

B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.  
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors, 
exactly as they appear in the configuration (.con) file. 

C. On the Header Information tab, change the settings as desired. 
Click OK when done. SEATERM saves the settings in a SEATERM.ini file. 

2. On the Toolbar, click Connect to communicate with the CTD. 
3. To set up the CTD prior to deployment: 

On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the 
CTD setup matches your desired deployment. If not, send commands to modify the setup. 

4. To upload data from the CTD: 
On the Toolbar, click Upload to upload data from the CTD memory to the computer. 

 
Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or 
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data. 
The calculations required to convert from raw data to engineering units of the measured parameters (temperature, 
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after 
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the 
recorded data and creates the file on the computer hard drive.  
 
To successfully store data to a file on the computer and subsequently convert it to engineering units, the software 
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD. 
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has 
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given 
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is 
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the 
Configure menu in SEASAVE or  
SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units  
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in  
SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data 
processing. 
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The instrument type and instrument configuration settings of the .con file and the required setup for the 
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's 
sensors are contained in the calibration coefficient section of the CTD manual. 
 
 NOTE: 
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE 
Data Processing will not interpret the data correctly without the correct .con file. 

 
 
 
 
 
 

SEASOFT CONFIGURATION: 
 
The correct instrument type for your instrument is SBE 19plus SEACAT Profiler.  The correct settings for the configuration of your 
instrument as delivered are documented below: 

 
  

  

0 
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as
well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications
pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in
T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (8 Mbyte vs 1).
There is more power for auxiliary sensors (500 ma vs 50), and they are acquired at higher resolution (14 bit vs 12). Cabling is
simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated
connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH
memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core,
armored cable directly to your PC’s serial port (maximum transmission distance dependent on number of auxiliary sensors,
baud rate, and cable properties). The 19plus’ faster sampling and pump-controlled TC-ducted flow configuration significantly
reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features.
Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescense, PAR, and ORP can be added, and for moored deployments the
19plus can be set to time-series mode using software commands. External power and two-way real-time communication over
10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a
superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design,
materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use.
Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory.
They permit data output in ASCII engineering units (degrees C, Siemens/m, decibars, Salinity [PSU], sound velocity [m/sec],
etc.). The 19plus can be factory-configured to emulate the .hex output format and 2 Hz data rate of old SEACATs for
compatibility with existing software or instrument fleets.

Accuracy, convenience, portability, software, and support; compelling reasons why the 19plus is today’s best low-cost CTD.

CONFIGURATION AND OPTIONS

A standard SBE 19plus is supplied with:
• Plastic housing for depths to 600 meters
• Strain-gauge pressure sensor
• 8 Mbyte FLASH RAM memory
• 9 D-size alkaline batteries
• Impulse glass-reinforced epoxy bulkhead connectors: 4-pin I/O,

2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)
• SBE 5M miniature pump and T-C Duct

Options include:
• Titanium housing for depths to 7000 meters
• Sensors for oxygen, pH, fluorescence, light (PAR), light transmission,

and turbidity
• SBE 5T pump in place of SBE 5M for use with dissolved oxygen and/or

other pumped sensors
• Stainless steel cage
• MCBH Micro connectors
• Ni-Cad batteries and charger

SOFTWARE

SEASOFT©-Win32, our complete Windows 95/98/NT/2000/XP software package,
is included at no extra charge. Its modular programs include:
• SEATERM© — communication and data retrieval
• SEASAVE© — real-time data acquisition and display
• SBE Data Processing© — filtering, aligning, averaging, and plotting of CTD and

auxiliary sensor data and derived variables

Shown with
optional cage,
SBE 5T pump,

& SBE 43
DO sensor
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

Water intake

SBE 5M 
pump

Y-fitting

Air bleed 
valve

Data I/O 
cable

Pump 
inlet port

Pump 
exhaust port

Conductivity cell guard 
(covering temperature 
sensor, TC duct, & 
conductivity sensor)

Dimensions
in millimeters
(inches)

Data I/O

Auxiliary
Differential
Inputs

Pump

Optional
Auxiliary
Input

575 (22.65)

99 (3.90) DIA

 808 (31.80)

136 
(5.37)

103 
(4.05)

SPECIFICATIONS
Measurement Range
Temperature -5 to +35 °C
Conductivity 0 to 9 S/m
Pressure 0 to 20 / 100 / 350 / 1000 / 2000 / 3500 / 7000 meters
Initial Accuracy
Temperature 0.005 °C
Conductivity 0.0005 S/m
Pressure 0.1% of full scale range
Typical Stability (per month)
Temperature 0.0002 °C
Conductivity 0.0003 S/m
Pressure 0.004% of full scale range
Resolution
Temperature 0.0001 °C
Conductivity 0.00005 S/m (most oceanic waters; resolves 0.4 ppm in salinity)

0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)

Pressure 0.002% of full scale range
Memory 8 Mbyte non-volatile FLASH memory
Data Storage Recorded Parameter Bytes/Sample

T + C 6
pressure 5
each external voltage 2

Real-Time Clock 32,768 Hz TCXO accurate to ±1 minute/year
Internal Batteries 9 alkaline D-cells provide 60 hours continuous CTD operation;

optional 9-cell rechargeable nickel-cadmium battery pack
provides approximately 24 hours operation per charge

External Power Supply 9 - 28 VDC
Power Requirements
Sampling 65 mA
SBE 5M pump 95 mA
Quiescent 30 µA
Auxiliary Voltage Sensors
Auxiliary power out up to 500 mA at 10.5 - 11 VDC
A/D resolution 14 bits
Input range 0 - 5 VDC
Housing Materials — Depth Rating — Weight
Acetal Copolymer Plastic housing — 600 meter (1950 feet) — 7.3 kg (16 lbs)
3AL-2.5V Titanium housing — 7000 meter (22,900 feet) — 13.7 kg (30 lbs)
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Mini Submersible Pump  SBE 5M 
 
 
The SBE 5M pump module consists of a centrifugal pump 
head and a long-life, DC ball bearing motor contained in a 
compact, titanium, pressure housing usable to  
10,500 meters deep. The pump impeller and electric drive 
motor are coupled magnetically through the housing, 
providing high reliability by eliminating moving seals. Motor 
speed and pumping rate remain constant over the entire 
input voltage range. The motor drive electronics is 
intrinsically protected against accidental reversed polarity. 
 
 
APPLICATIONS 
 
The SBE 5M is standard on the SBE 19 and 19plus 
SEACAT Profiler CTD. It is optional on the SBE 16, 16plus, 
and 16plus-IM SEACAT C-T Recorder. The pump flushes 
water through the conductivity cell at a constant rate, 
independent of the CTD's motion, improving dynamic 
performance. For applications requiring pumping through 
additional sensors (for example, a dissolved oxygen 
sensor), use the SBE 5T pump instead. 
 
Specify: 
• Option 5M-1 for profiling (continuous duty) applications 

such as the SBE 19plus. 
• Option 5M-2 for moored (pulsed duty) applications such 

as the SBE 16plus or 16plus-IM. 
Contact Sea-Bird for use in other applications. 
 
SPECIFICATIONS 
 
Option 5M-1 (continuous duty):  
Input voltage range 9 - 18 VDC  
 
Flow Rate 25 ml/s supply current 95 ma 
 
Note: Supply current is independent of operating voltage. 
 
 
Option 5M-2 (pulsed duty):  
Input voltage range 6 - 18 VDC  
 
Pulse Duration Flow Volume Electrical Charge 

0.5 seconds 15 ml 0.148 amp-seconds 
1.0 seconds 21 ml 0.283 amp-seconds 
1.5 seconds 31 ml 0.418 amp-seconds 
2.0 seconds 40 ml 0.553 amp-seconds 
 
 
 
 
Weight 
In Air: 0.42 kg (0.91 lbs) 
In Water: 0.28 kg (0.60 lbs) 
 06/03 

Optional  
wet-pluggable 
connector, 
MCBH-2MTI 
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LEICA NA2 • NAK2

Universal automatic level



LEICA NA2 
The classical level from Leica Geosystems

The NA2 universal auto-
matic level meets all
requirements regarding
precision, convenience 
and reliability.

It was designed by sur-
veyors and development
engineers with years of
experience and who know
what a field instrument 
has to be able to do.

The NA2 soon pays for 
itself, because it can be
used for all types of sur-
veying job; on building
sites for routine levelling, 
in engineering projects, 
and for geodetic control at
all levels of accuracy.

Universal application

• Levelling of all types and
all orders of accuracy

• Precise levelling and
settlement determinations
on buildings

• Routine heighting for 
the construction of roads,
railways, pipelines,
tunnels and so forth

• Setting-out work and
control measurements on
the construction site

• Area levelling of high
accuracy

• Tacheometric levelling
with the K-version on flat
terrain by combining 
stadia and angular meas-
urements with height 
readings

• Deformation measure-
ment and monitoring of
bridges



Quickly set up, simple to use

Strong tripods

In principle, the NA2 
can be set up on any Leica
Geosystems tripod. In
practice, for all-round
purposes, we recommend
the heavy-duty GST20
telescopic-leg tripod. 
For precise levelling the
GST40 fixed-leg tripod 
is suitable because of its
extreme rigidity.

The modular relationship
between instrument and
tripod is an advantage
when transport space is
limited.

Centring is easy

The circular level only
needs to be centred
approximately to bring the
compensator well into its
working range of ~30', and
so setting-up goes quicker. 

The bubble is viewed
positively via a pentaprism
and is monitored down 
the eyepiece.

Play-free footscrews

The pitch of the smooth-
running and backlash-free
footscrews is such that 
the bubble can be centred
in a very short time.

Independent of 
temperature

Unlike the tubular level of 
a traditional instrument, the
NA2 universal automatic
level is relatively insensitive
to direct solar radiation 
and an umbrella need only 
be considered for the most
precise levelling. 

Open sight

Rapid / fine focusing knob

Pentaprism for viewing circular level

Endless horizontal drive

Footscrew

Push-button for compensator control

Endless horizontal drive

Footscrew



Adjust the line of sight automatically

Easy to level up

The advantage of this
instrument is that, as soon
as the bubble is centred,
the line of sight is horizontal
for all pointings of the
telescope. The observer is
freed of the time-consuming
centring procedure involved
with the traditional tubular
level, and can concentrate
on the business of staff
readings.

Minimum maintenance

In the unlikely event that
the compensator is
damaged (and this can only
happen as a result of
extremely harsh treatment)
it is replaced easily, being
held only by three screws.

NA2/NAK2 compensator

1 Suspension tapes
2 Prism (fixed)
3 Compensator body
4 Pendulum with prism
5 Line of sight
6 Push-button
7 Spring which taps pendulum
8 Pneumatic damping mechanism

Push-button control –
added security

With most automatics one
taps the tripod or instru-
ment to check if the com-
pensator is functioning.
Leica Geosystems offers a
far more sophisticated
solution.

Pressing the button under
the NA2 eyepiece gives the
compensator a gentle tap,
so that you see the staff
image swing smoothly

away and then float gently
back to give the horizontal
line of sight. This check,
which takes less than 
a second, is technically
perfect, as the pendulum
itself is activated and
swings through its full
range. It is also immediately
apparent if the bubble 
is not centred.

Robust and automatic

The compensator is
essentially a pendulum 
with a prism (4). 

The suspension system
comprises four flexed 
tapes (1) made of a special
alloy to ensure faultless
functioning even at extreme
temperatures. The compen-
sator, which is located
between the focusing lens
and the crosshair reticle, 
is pneumatically damped
against mechanical vibra-
tion and is screened against
magnetic fields.



Top-class optics

Top-class optics

The telescope is of excellent
quality and gives a bright,
high-contrast, erect image,
even in poor light – an
essential for accurate
levelling. With the standard
eyepiece the magnification
is 32×, the optimum for
most applications of the
instrument. Optional
eyepieces are available; the
40× may be preferred for
precise levelling, the 25×
in hot, shimmer conditions.
Eyepiece exchange takes
only a second or so.

The focusing knob has a
coarse/fine movement:
– coarse, for rapid setting

with minimum turning
– fine, for the final delicate

touch to give the perfect
image.

Fatigue-free viewing

The reticle has:
– a single horizontal hair

for reading normal staffs
– a wedge-shaped hair for

use with invar staffs
– stadia hairs for distance

measurement and three-
wire levelling.

The general layout of 
the controls, the smooth
friction-braked rotation 
of the instrument, and the
endless horizontal drive
with bilateral knobs, 
all combine to make the
instrument easy to use.

At an advantage on 
unstable ground

If a tubular level is used 
on unstable ground it tilts
out of range and has to be
continuously reset. By
contrast, the pendulum of
the NA2 “compensates”
and keeps the line of sight
horizontal.

Angle measurement 
with the NAK2

Civil engineers and contrac-
tors often require a circle
for angle measurement 
and setting-out work. Even
simple detail surveys, by
taking angle, distance and
height, and plotting with
the polar method, can be
done with a level.

The model NAK2 has an
internal glass circle which
is read via a scale micro-
scope and which can be set
to any value by turning 
the rim around the base 
of the instrument.

NA2 field of view with metric levelling staff
Reading at horizontal hair: 1.143 m

NAK2 
circle reading (400 gon)

392.66 gon

NAK2 
circle reading (360°) 

314°42'



High-performance accessories for precise levelling

GPM3 
parallel-plate micrometer

This optional accessory
slips over the telescope
objective and blends
perfectly with the smooth
lines of the NA2. With 
a compensator setting
accuracy of ±0.3“ (equiva-
lent to 0.01 mm in 10 m)
and a micrometer reading
to 0.1 mm direct and 
0.01 mm by estimation, the
NA2 with GPM3 is an ideal
combination for precise
levelling, deformation 
studies, and even optical
tooling. The micrometer
drive for raising and lower-
ing the line of sight is con-
veniently located and read-
ings are taken on a glass
scale viewed through an
eyepiece just above the
telescope eyepiece. This
optical reading system,
which is digital apart from
the last and estimated
figure in the metric and
inch versions, is superior 
to the usual metal drum
system.

GPM6 
parallel-plate micrometer

There are tasks for which 
a micrometer is needed, 
yet for which the very high
accuracy of the GPM3 is 
not essential. 

To meet this requirement, 
a simpler micrometer
attachment, the GPM6 
with drum reading, 
is available for the NA2.

The GPM6 fits on to the
telescope objective in the
same manner as the GPM3,
but the graduation is
engraved on a metal drum.

Eyepiece accessories for
specialized tasks

Because of the bayonet
fastening of the inter-
changeable eyepiece, all
theodolite eyepiece acces-
sories can be used with 
the NA2.

• Diagonal eyepiece for
observing from above,
below, and from the side;
useful in cramped spaces

• Eyepiece lamp for con-
verting the NA2 into 
a horizontal collimator 
for laboratory work

• Autocollimation eye-
piece for setting machine 
parts and instrument 
components precisely
vertical



Precise

Reliable, automatic, 
maintenance-free

Easy handling

Quick levelling-up

Superb telescope

Abundant accessories; 
many applications

Effortless focusing

The rugged NA2 is indifferent
to weather conditions and 
is extremely reliable in the
rough world of the building
site. The pendulum compen-
sator is protected against
knocks and shocks. There is
a highly-effective vibration-
damping mechanism.

The high setting accuracy
ensures that the line of
sight stays put. The attach-
able parallel-plate micro-
meter renders the NA2 
ideal for precise fine 
levelling.

The instantaneous check
facility with the push-button
control not only makes 
work easier; it also
promotes confidence.

The convenient, well-
arranged controls are
designed for maximum 
convenience. The bilateral,
endless horizontal 
drive promotes rapid 
fine-pointing.

The instrument is quickly 
set up with the three rapid-
action footscrews. Their 
self-adjusting threads 
make subsequent resetting
unnecessary.

Telescope with excellently-
corrected optics for bright,
high-contrast images. 
All optical components are
coated on both sides.

The erect image seen down
the telescope is quickly 
and accurately brought into
focus with the convenient
rapid and fine focusing
knob.

Additional items such as 
the parallel-plate micro-
meter, the laser eyepiece, 
or theodolite eyepiece
accessories, offer almost
unlimited possibilities.

Compact



LEICA NA2 • NAK2
Proven reliability ensures precise results

Versatile accessories for
demonstrable success

A comprehensive program
of accessories enables you
to expand the performance
and applications range 
of each instrument. 
This way, you can match 
your equipment exactly 
to requirements. 

The possibilities are
described in brochure
“Survey accessories” 
710 883en.

Total Quality Management – 
Our commitment to total 
customer satisfaction

Ask your local Leica
Geosystems agent for 
more information 
about our TQM program.

Illustrations, descriptions, and technical data are not binding and may be changed.
Printed in Switzerland – Copyright Leica Geosystems AG, Heerbrugg, Switzerland, 1999
710 837en – V.03 – RDV

Technical data

Standard deviation for 1 km double-run 
levelling, depending on type of staff and on 
procedure up to 0.7 mm
With parallel-plate micrometer 0.3 mm

Telescope erect image
Standard eyepiece 32×
FOK73 eyepiece (optional) 40×
FOK117 (optional) 25×
Clear objective aperture 45 mm
Field of view at 100 m 2.2 m
Shortest focusing distance 1.6 m
Multiplication factor 100
Additive constant 0

Working range of compensator ~30’
Setting accuracy of compensator (stand. dev.) 0.3“
Sensitivity of circular level 8’/2 mm

Glass circle (K version) 400 gon (360°)
Graduation diameter 70 mm
Graduation interval 1 gon (1°)
Reading by estimation to 10 mgon (1’)

Water- and dust resistance IP53

Temperature range:
Operation –20°C to +50°C (– 4°F to 122°F)
Storage –40°C to +70°C (–40°F to 158°F)

Parallel-plate micrometer Range Interval Estimation
(optional accessory)

GPM3, with glass scale 10 mm 0.1 mm 0.01 mm

GPM6, with metal drum 10 mm 0.2 mm 0.05 mm

Robust container for 
safe transport

The NA2 is supplied in a
foam-padded container
made of high performance
synthetic material. The
foam padding absorbs all
jolts and shocks. The
container provides perfect
protection for the NA2.

ISO 9001 / ISO 14001

Leica Geosystems AG
CH-9435 Heerbrugg

(Switzerland)
Phone +41 71 727 31 31

Fax +41 71 727 46 73
www.leica-geosystems.com
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PDL

Positioning Data Link™

19,200 Baud Rate
Higher Over-the -Air Link Rate

Extends Your Battery Life

Enhanced User Interface
Change Channels in the Field

View Status Information

Compatible with GPS
RTK Equipment

Worldwide
Complete Kit Solutions Available

for Your Application

Reliable
Rugged, All Season Operation

2 Year Warranty
Lower Cost of Ownership

High Performance
Data Link

Designed for Survey Systems

Surveyors utilizing Global Positioning Systems require a rugged radio
modem data link for precise positioning information. The PDL is compact
and lightweight and offers power efficient operation. It is easy to use, and
provides high performance and rugged dependability for the toughest
survey environments.

PDL Products are designed to easily mount on all standard tripods and
range poles. Complete kit solutions are available.

™



RF Power Select	 	 Low/High. 		 			Factory Programmable. 	 	 	N/A.

External
Internal Battery 	 	 N/A 	 	 	 	 	 N/A. 	 	 	 	 	 Lithium Ion Battery Pack.
During TX (nominal) 		 110 Watts.	 	 	 	 11 Watts. 		 	 	 	 N/A.
During RX (nominal) 		 1.9 Watts.		 	 	 	 0.9 Watts. 	 	 	 	 0.3 Watts.
Antenna
External 		 	 50 Ohm, BNC.	 	 	 	 50 Ohm, NMO.	 	 	 	 50 Ohm, NMO.
Modem Specifications
Link Rate/Modulation

Hamming Code (12, 8) with Data Interleaving.

On/Off Button.

Digital Display.
Modem/Power Status Indicators.
RF Power Select  Toggle Switch.

19,200 bps/4 Level FSK.

9600 bps/GMSK.
4800 bps/GMSK.

RoverHigh Power Base

3 Wire, RS-232, 38.4k Baud Maximum.

ANSI/ASAE EP455.

990 Richard Avenue, Suite 110, Santa Clara, CA 95050
1-800-795-1001, Tel: 408-653-2070, Fax: 408-748-9984
Web: www.paccrst.com, E-mail: sales@paccrst.com
©2000 Pacific Crest Corporation.
License required prior to operation of radio communication equipment. Specifications subject to change without prior notice.
TRIMTALK™ is a trademark of Trimble Navigation Limited. M00526-9/02

Positioning Data Link™

Refer to price list for available frequency bands.

Synthesized 12.5k Hertz Resolution.
±2.5 ppm Stability.

-116 dBm (12 dB SINAD).
>-70 dB at 9600 bps/GMSK.
>-60 dB at 19,000 bps/4 Level FSK.

-22     to +140    F (-30   to +60   C).
-67     to +185    F (-55   to +85   C).

IEC 60529 I.P. 66.
Water Tight and Dust Proof.

9 – 16 VDC.

Low Power Base

Transparent, Packet Switched, Digipeater,
TRIMTALK.™

Transparent, Packet Switched, Digipeater,
TRIMTALK.™

Transparent, Packet Switched, TRIMTALK.™

6.23" W x 2.77" H x 6.58" L.
(15.8 cm W x 7.0 cm H x 16.7 cm L).

8.25" L x 2.40" Diameter.
(21.0 cm L x 6.1 cm Diameter).

8.25" L x 2.40" Diameter.
(21.0 cm L x 6.1 cm Diameter).

All models are type accepted and certified for operation in the U.S. and Canada.
For detailed information concerning your country's type certification, please contact your sales representative.

On/Off Button.

Digital Display.
Modem/Power Status Indicators.

On/Off Button.

Digital Display.
Modem/Power Status Indicators.

-4   to +140   F (-20   to +85   C).
-4   to +185   F (-20   to +85   C).

General Specifications
DTE – DCE Interface
User Interface

Power

Link Protocols

Forward Error Correction
Radio Specifications
Frequency Bands
Frequency Control

Sensitivity
Adjacent Channel Selectivity

Type Certification

Environmental Specifications
Operating Temperature
Storage Temperature
Vibration/Shock
Enclosure

Mechanical Specifications
Dimensions

Weight 	 	 	 2.96 lbs. (1.34 Kg).	 					 	 	 	 0.65 lbs. (0.30 Kg). 	  	 	 	 	0.75 lbs. (0.34 Kg).
Data/Power Connector	 5 Pin LEMO #1 Shell. 				 	 	 	 5 Pin LEMO #0 Shell. 				 	 	 	 5 Pin LEMO #0 Shell.
Mount 	 	 	 Tripod Bracket. 	 			 	 	 	 5/8" – 11 Range Pole. 				 	 	 	 5/8" – 11 Range Pole.

Channel Button with AutoBase and AutoRover.™ ™Channel Button with AutoBase and AutoRover.™ ™Channel Button with AutoBase and AutoRover.™ ™

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

Antenna

Modem Specifications

RF Transmitter Output 	 3/35 Watts Maximum. 	 	 	 0.5 – 2 Watts. 	 		 	 	  	 	0 Watt (Receive Only).

>-60 dB. >-60 dB.

9600 bps/4 Level FSK.



THALES NAVIGATION

Z-XTREME
The Ashtech® Z-XtremeTM from Thales Navigation professional
products is a rugged, weather-proof, dual-frequency GPS receiver
designed to provide surveyors with cost-effective, centimeter-accurate
positions in a variety of system configurations.

The Z-Xtreme receiver begins with state-of-the-art satellite electronics
coupled with patented Z-Tracking™ to deliver the highest GPS signal
reception level.  A removable battery and flash memory card provide
enough capacity to last all day for maximum utility. Components are
completely integrated inside a weather-proof, high impact plastic
housing, ensuring your investment is safe, rain or shine. Use the easy-
to-operate interface on the front panel for important functions such as
site information entry, survey status, and set-up of RTK base stations
without the additional cost of a handheld controller. The result: 
Z-Xtreme with Instant-RTK® outperforms all other receivers in its class!

ZX-SOLUTIONS
The Z-Xtreme survey system from Thales Navigation provides a range
of solutions designed for the vast array of positioning needs – from
entry level static or kinematic post-processed surveys, all the way up
to real-time functions such as stake out. The entry level ZX-SolutionsTM

system dramatically increases your productivity for control surveys and
other post-processed applications. Add an optional kinematic kit to
make topographic feature collection more cost effective. Use Ashtech
Solutions™ software to easily process the field data, export results and

generate reports. Purchase only what you need for the job at hand
because ZX-Solutions is fully upgradeable.

ZX-SUPERSTATION
Eclipse the productivity of optical instrument stake out with a ZX-
SuperStationTM. The ZX-SuperStation is a field-to-finish GPS surveying
system that combines the Z-Xtreme receiver with a powerful data
collector and wireless modems for centimeter accuracy in real-time.
Instant-RTK gives you the ability to initialize the centimeter solution in
a fraction of the time of conventional RTK systems.  Powerful data
collection software gives you the ability to efficiently perform GPS
surveying techniques and to interface seamlessly with optical total stations.

Z-Xtreme
Survey System

INSTANT-RTK TECHNOLOGY

www.thalesnavigation.com



Z-XTREME

TECHNICAL SPECIFICATIONS

Ashtech Technology

• 12 channel all-in-view operation
• Full-wavelength carrier on L1 and L2
• Z-Tracking
• Multipath mitigation
• Dual-frequency smoothing for improved code   

differential
• Instant-RTK

Performance Figures1

Static, Rapid Static
• Horizontal: 0.005 m + 1 ppm 

(0.016ft+1ppm)
• Vertical: 0.010 m + 1 ppm 

(0.033ft + 1ppm)
Post-Processed Kinematic
• Horizontal: 0.010 m + 1 ppm 

(0.033ft + 1ppm)
• Vertical: 0.020 m + 1 ppm 

(0.065ft+1ppm)
Real-Time Code Differential Position
• <1 m (3.28 ft)
Real-Time Z Kinematic Position (Fine Mode)
• Horizontal: 0.010 m + 2 ppm

(0.033ft + 2 ppm)
• Vertical: 0.020 m + 2 ppm 

(0.065ft + 2 ppm)
• Azimuth (arc sec): 0.4 + 2.0/baseline (km)
RTK Occupation Time
• 2 seconds (typical - sub-centimeter accuracy 

with longer occupation time)
Instant-RTK Initialization
• 99.9% reliability
• Typically <2 seconds with 6 or more satellites, 

PDOP <5, baseline length <7 km (4.35 mi), 
open sky and low multipath conditions

RTK Operating Range
• Recommended: 10 km (6.21 mi)
• Maximum: 40 km (24.85 mi)

Standard Features

• 16 MB PCMCIA removable memory card
• NMEA 0183 output
• Selectable update rate from 999 sec to 10 Hz
• Event marker
• Point positioning
• 1 PPS timing signal
• Session programming

• Wide array of coordinate transformations
• Removable internal battery
• 8-character alphanumeric LED display with 4-    

button interface
• 3 function LED display - Radio,Memory, 

Satellites/Power
• Multi-function audible alarm
• Quick reference card holder
• External mount capabilities
• External power input
• 4 RS-232 ports (115200 baud max, 3   

external, 1 internal)
• 1-year warranty
• Free factory technical support

Standard Accessories

• Communications software
• Padded system bag and hard case
• RS-232 data cable
• Receiver operating manual
• Quick reference field card

Technical Data

Environmental
Z-Xtreme Receiver
• Meets MIL-STD 810E for wind driven rain  

and dust
• Operating temperature: -30° to +55°C 

(-22° to 131°F)
• Storage temperature: -40° to +85°C

(-40° to 185°F)
Geodetic 4 Antenna
• Meets IPX7 specifications for submersion
• Operating temperature: -55 to +75°C

(-40° to 149°F)
• Storage temperature: -55° to +75°C 

(-67° to 167°F)

Physical
Weight
• Receiver: 1.59 kg (3.50 lb)
• Antenna: 0.82 kg (1.81 lb)
• Battery: 0.43 kg (0.95 lb)
Dimensions
• 76.2 H x 196.85 W x 222.25 D mm 
• (0.25 H x 0.646 W x 0.729 D ft)
Power
• 10 - 28 VDC, 6.0 W

Internal battery
• Capacity: 6000 mAh
• >9 hours (typical) @  25°C (77°F)
• Operating temperature: -30° to +55°C 

(-22° to 131°F)
• Storage temperature: -40 to +60°C 

(-40° to + 140°F)

PC card
• ATA Type II PCMCIA memory card (16 MB  

standard)
• Temperature range: -40° to +85°C

(-40° to 185°F)
• Data capacity: 4500 epochs per 2 MB*
* Based on one session, eight satellites' data
and full measurements. This number can vary
significantly depending on the conditions of the
session.

Optional Features

• Real-time kinematic (base and rover modes)  
for cm-accuracy

• RTCM 2.2 (Types 1, 2, 3, 9, 16, 18, 19, 20, 
21, 22)

• Internal UHF or spread spectrum radio for 
RTK rover operations

• External UHF or spread spectrum radio for
RTK base and rover operations

• Geodetic 4 antenna ground plane kit
• Kinematic antenna kit
• Aircraft antenna kit
• AC power cable
• Choke ring antenna
• Long haul backpack kit
• All-on-a-pole kit

Optional Application Software

GPS data processing
• Ashtech Solutions

Land Surveying and Construction
• TDS Survey Pro
• Carlson SurvCE
• Ashtech Survey Control II
• Ashtech GPS Fieldmate

Mining and Land Seismic
• Ashtech Mine Surveyor II
• Ashtech Seismark II 

1 Specifications assume operation follows all the

procedures recommended in the product manual utilizing

Instant-RTK, post processing with Ashtech Solutions or

Ashtech Office Suite for Survey. High-multipath areas,

high PDOP values, low satellite visibility, and periods of

adverse atmospheric conditions and/or other adverse

circumstances will degrade system performance. All

accuracy specifications are RMS values.

Thales Navigation follows a policy of continuous product improvement; specifications and descriptions are thus subject to change without notice.
Please contact Thales Navigation for the latest product information.

© 2003 Thales Navigation, Inc. All rights reserved. Ashtech, Z-Xtreme, Instant-RTK, ZX-SuperStation, ZX-Solutions, Z-Tracking, GPS FieldMate, Survey Control II and Ashtech Solutions are trademarks
of Thales Navigation. All other product and brand names are trademarks or registered trademarks of their respective holders. Ashtech P-code GPS technology has been FGCC tested and is capable
of performing first order surveys (report available upon request).  rev(5.03)  part # 830190

Thales Navigation, Inc.
Corporate Headquarters, Santa Clara, CA, USA 
+1 408 615 5100 * Fax +1 408 615 5200
Toll Free (Sales in USA/Canada) 1 800 922 2401
Email   professionalsales@thalesnavigation.com
In Washington, DC   +1 703 476 2212 * Fax +1 703 476 2214
In South America   +56 2 234 56 43 * Fax +56 2 234 56 47
In China   +86 10 6566 9866 * Fax +86 10 6566 0246

European Headquarters, Carquefou, France  
+33 2 28 09 38 00 * Fax +33 2 28 09 39 39
Email   professionalsalesemea@thalesnavigation.com
In Germany   +49 81 6564 7930 * Fax +49 81 6564 7950
In Russia   +7 095 956 5400 * Fax +7 095 956 5360
In UK   +44 (0) 870 601 0000 * Fax +44 (0) 208 391 1672     
In the Netherlands   +31 78 61 57 988 * Fax +31 78 61 52 027
Web site   www.thalesnavigation.com















������ SET5F
Version 01-00

TOTAL STATION

SURVEYING INSTRUMENTS

Enhanced software with 3,000-point data memory.



Flexible, Friendly and Featherweight
The SET5F's powerful EDM, dependable dual-axis compensator and 3,000-point data memory
are conveniently packaged in a compact, lightweight body. Software [Version 01-00) has
been enhanced for more effective survey work, and "softkey" assignments can be freely
customized to suit all user needs.

Dependable
Hardware

Proven Dual-axis Compensator
•Since its introduction with the Series C
total station in 1989, Sokkia's dual-axis
compensator has proven its reliability and
accuracy at survey sites all over the world.
•The dual-axis tilt sensor monitors
deviations of both the X and Y axes and the
correct horizontal and vertical angle
readings are automatically computed and
applied. The result is easier and faster
instrument leveling.

Spacious 3,000-point Internal
Memory
•The SET5F's internal memory is large—
holding a full 3,000 data points—and
secure. For optimum convenience,
measurements can be performed and
recorded at the touch of a key.
•Up to five (5) job files can be created to
efficiently organize multiple survey tasks.
•Forty (40) feature codes (max.13 charac-
ters each) can be kept in the memory for
easy recall as needed.

The High-performing EDM
•1,500m/4,900ft range with a single prism
under good ambient conditions (40km/
25miles visibility, with no haze, overcast,
no scintillation).
•Outstanding precision;
±(3+2ppmxD)mm. This corresponds to a

deviation of a mere ±3.2mm at a distance
of 100m and ±5mm at 1,000m.
•Supreme speed; only 1.7 seconds initial
measuring time in the rapid measurement
mode.

Average Conditions Good Conditions
CP01 Compact Prism 700 m/2,300 ft.
One AP01 Prism 1,200 m/3,900 ft. 1,500 m 4,900 ft.
Three AP01 Prisms 1,600 m/5,200 ft. 2,000 m 6,500 ft.

Powerful Telescope
•Highest magnification in its class: 30x
•Easy, accurate sighting of prisms or
targets

Outstanding Mobility
•Total carrying weight (including instrument,
tribrach, battery and hard case) is a mere 8
kg/18 lbs. The secret lies in the lightest and
most compact carrying case of its kind

(W390 x D255 x
H220mm / W15.3 x
D10.0 x H8.6in.), making
the SET5F supremely

portable.
•A convenient
shoulder strap is
provided as
standard. An
optional back
pack (SC94) is
ideal for longer
day treks.

Enhanced
Software

The SET5F can be easily customized
to your preferred key assignments.
•The SET5F offers optimum keyboard
flexibility. Any keyboard layout can be
configured. For example, functions can be
assigned to any key position on any page,
and unused functions can be temporarily
deleted.
•A powerful "softkey" feature facilitates
input of coordinate values,
feature codes, etc.

Sophisticated Application Software
Missing Line Measurement (MLM)
•The SET5F measures horizontal distance,
slope distance, height difference, and slope
in percent (%) between two prisms, all at the
touch of a key.

EDM

THEO

S-O

Key assignment mode



The SET5F brings full freedom to survey work.

Remote Elevation Measurement
(REM)
•The SET5F can be used to easily
determine the height of a point where a
prism cannot be placed. The system
sights a prism directly above or below the
target point, and then sights the point
desired.

Angle Repetition
•For enhanced accuracy in the horizontal
angle measurement, the SET5F can
measure in repetition. It then calculates
and displays the average of the multiple
angle measurements.

Azimuth Angle Setting
•Using the coordinates of the instrument
station and a backlight point, the SET5F
can automatically set the horizontal angle
to the azimuth of the backlight.

Resection
•With 2 to 5 known points, the SET5F can
be used to determine the azimuth and
coordinates of the unknown instrument
station.
•When using 2 known points, both angles
and distances are measured. When
using 3 or more points, the distance does
not always have to be measured.

3-D Coordinate Measurement
•The SET5F calculates 3-D coordinate
values of measuring points.
•The operator may choose display settings
either of "N, E, Z" or "E, N, Z."

3-D Setting-out
•The SET5F can be used to perform
3-dimensional setting-out with N, E and/or
Z coordinates.

Offset Measurements
Two basic offset measurement methods
are provided to measure the hidden
points. One calls for input of the offset
distance and the direction between the
measuring point and the prism. The other
uses a prism set on the left or right side of
the measuring point at the same distance
from the SET5F; the angles and distance
to the prism are measured, and the
measuring point is sighted. In both cases,
the SET5F calculates the horizontal and
vertical angles and distance, or the N, E,
Z coordinates.



Standard Configuration
The SET5F comes with two (2) BDC25
rechargeable batteries EDC19 battery
charging adapter CDC27, CDC31 or
CDC31A quick charger, CP7 tubular
compass, sunshade, lens cap, plumb bob,
vinyl cover, tool kit, operator's manual,
carrying case and shoulder strap.

Electronic Field Books
(SDR33/SDR31)
Thanks to its advanced two-way commu-
nications port, the SET5F's functions can
all be accessed by external controller. For
example, by connecting one of the
Sokkia's acclaimed Electronic Field Books
(SDR33 or SDR31), complex field
operations such as traverse adjustment,
intersection, area calculations and roading
can be carried out with remarkable ease.

Optional Accessories
DE17A Diagonal Eyepiece
OF1/OF1A Solar Filters
SC94 Back Pack

Designs and specifications are subject to change without notice.

SOKKIA CO.,LTD.
1-1, TOMIGAYA l-CHOME, SHIBUYA-KU, TOKYO, 151 JAPAN
PHONE +81-3-3465 5211 FAX +81-3-346-5203
INTERNATIONAL DEPT. PHONE +81-3-346-5201 FAX +81-3-3465-5202

SET5F Specifications
Telescope Fully transiting, coaxial EDM
Length 165mm (6.5in)
Objective aperture 45mm (1.8in)
Magnification, image 30x, Erect
Resolving power 3.0"
Field of view 1°30'(26m/1,000m)
Minimum focus 1.3m (4.3ft.)
Reticle illumination Bright or Dim, selectable
Angle measurement Incremental encoder, diametrical detection
Display resolution H&V 1"/ 0.2 mgon/ 0.005 mil, 5"/1 mgon/ 0.02 mil
Angle unit H&V Degree/Gon/Mil
Accuracy H&V 5" (1.5 mgon/ 0.02 mil) according to DIN18723
Dual-axis compensator Liquid dual-axis tilt sensor, range: ±3' (±55 mgon)
Display mode H Clockwise/ Counterclockwise, Repetition, Oset, Hold available

V Zenith 0°/ Horizontal 0°/ Horizontal 0°±90°/ Slope%
Distance measurement Electro-optical with modulated infrared LED.
Measuring range (slope distance) A: Average conditions; slight haze, visibility about 20km(12 miles),

  sunny periods, weak scintillation.
G: Good conditions; no haze, visibility about 40km (25 miles),
  overcast, no scintillation.
Maximum ranges are achieved with Sokkia CP/AP prisms.

With CP01 compact prism A: 1.3m (4.3ft.) to 700m (2,300ft.)
With one AP01 prism A: 1.3m (4.3ft.) to 1,200m (3,900ft.), G: 1,500m (4,900ft.)
With three AP01 prism A: 1.3m (4.3ft.) to 1,600m (5,200ft.), G: 2,000m (6,500ft.)
Distance unit Meters or feet, selectable
Accuracy (Fine measurement) ±(3+2ppmxD)mm D=measuring range, unit=mm
Measuring unit and time Fine 0.001 m Every 3.2 seconds (initial 4.7 seconds)
(slope distance) Rapid 0.001 m 1.7 seconds

Tracking 0.01 m Every 0.3 seconds (initial 1.4 seconds)
Average 0.0001 m (average of 2 to 9 times measurement)

Atmospheric correction Key-in the temperature and pressure, or -499 to +499ppm.
Prism constant -99 to 0mm (1 mm steps)
Refraction & Earth-curvature On/off selectable (K=0.142)
  correction
General
Display LCD dot matrix display (20 characters x 4 lines) on both faces with

  back light.
Keyboard 5 keys on both faces, free assignment of functions.
Resume function On/off selectable
Sensitivity of levels Plate level: 40"/2mm, Circular level: 10'/2mm (in tribrach)
Optical plummet Image: erect, Magnification: 3x, Minimum focus: 0.5m (1.6ft.)
Interface Asynchronous serial, RS-232C compatible, baud rate 1200/

  9600bps
2-way communication Provided
Data storage 3,000-point data memory
Operating temperature -20°C to +50°C (-4°F to +122°F)
Tilting/Trunnion axis height 236mm (9.3in) from tribrach bottom, 193mm (7.6in) from

  tribrach dish.
Size with handle and battery W150 x D165 x H353mm, W5.9 x D6.5 x H13.9in.
Weight with handle and battery 5.4kg (11.9lbs)
Weight of parts BDC25 battery: 240g (8.5oz.), Handle: 100g (3.5oz.),

  Tribrach: 740g (1.6 lbs), Case:2.4kg (5.3lbs)
Power supplies
Battery level display 4 steps with warning message.
Automatic power cut-off On/off selectable (30 minutes after the last operation)
Power source BDC25 rechargeable battery, Ni-Cd 6V, 2 supplied as standard.
Working duration at 25°C (77°F) Distance & angle measurement: about 5 hours, about 600 points
    w/one BDC25 battery (Fine & single measurement with 30 seconds intervals).

Angle measurement only: about 9 hours.
Charging time CDC27/31: about 80 minutes, CDC31A: about 90 minutes



Appendix III 
 
 
Vessel Reports, Offsets, and Diagrams 
 
 Launch 1010 
  Vessel Report 

 1_HVF 
 2_Offsets 
 3_Patch Test 
 4_DDSSM and Settlement & Squat 
 5_POS Gams Calibration 
 6_Wire Diagram 

 
Launch 1018 

  Vessel Report 
 1_HVF 
 2_Offsets 
 3_Patch Test 
 4_DDSSM and Settlement & Squat 
 5_POS Gams Calibration 
 6_Wire Diagram 

 
S220 

  Vessel Report 
 1_HVF 
 2_Offsets 
 3_Patch Test 
 4_DDSSM and Settlement & Squat 
 5_POS Gams Calibration 
 6_Wire Diagram 
 7_Correspondence 

 
 



FA_1010_Reson8101_end07.txt
Vessel Name: FA_1010_Reson8101.hvf
Vessel created: December 19, 2006

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2006-001 00:00

Transduer #1:
-------------
Pitch Offset: -1.160
Roll Offset: 2.250
Azimuth Offset: 0.930

DeltaX: 0.312
DeltaY: -0.142
DeltaZ: 0.397

Manufacturer:  Reson
Model:  sb8101
Serial Number:  2701011

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-001 00:00

Transduer #1:
-------------
Pitch Offset: -0.280
Roll Offset: 2.500
Azimuth Offset: 0.600

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

Manufacturer:  Reson
Model:  sb8101
Serial Number:  2701011

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-119 00:00

Transduer #1:
-------------
Pitch Offset: -0.280
Roll Offset: 3.000
Azimuth Offset: 0.600

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

Manufacturer:  Reson
Model:  sb8101
Serial Number:  2701011

Depth Sensor:
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FA_1010_Reson8101_end07.txt
Sensor Class:  Swath
Time Stamp:  2007-136 22:07

Transduer #1:
-------------
Pitch Offset: -0.280
Roll Offset: 2.710
Azimuth Offset: 0.600

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

Manufacturer:  Reson
Model:  sb8101
Serial Number:  2701011

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-150 00:00

Transduer #1:
-------------
Pitch Offset: -0.280
Roll Offset: 3.000
Azimuth Offset: 0.600

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

Manufacturer:  Reson
Model:  sb8101
Serial Number:  2701011

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-150 19:04

Transduer #1:
-------------
Pitch Offset: -0.280
Roll Offset: 2.710
Azimuth Offset: 0.600

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

Manufacturer:  Reson
Model:  sb8101
Serial Number:  2701011

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-151 00:00

Transduer #1:
-------------
Pitch Offset: -0.280
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FA_1010_Reson8101_end07.txt
Roll Offset: 3.070
Azimuth Offset: 0.600

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

Manufacturer:  Reson
Model:  sb8101
Serial Number:  2701011

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-172 00:10

Transduer #1:
-------------
Pitch Offset: -0.280
Roll Offset: 2.620
Azimuth Offset: 0.600

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

Manufacturer:  Reson
Model:  sb8101
Serial Number:  2701011

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-176 00:00

Transduer #1:
-------------
Pitch Offset: -0.280
Roll Offset: 2.890
Azimuth Offset: 0.600

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

Manufacturer:  Reson
Model:  sb8101
Serial Number:  2701011

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-176 22:20

Transduer #1:
-------------
Pitch Offset: -0.280
Roll Offset: 2.620
Azimuth Offset: 0.600

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.550
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FA_1010_Reson8101_end07.txt

Manufacturer:  Reson
Model:  sb8101
Serial Number:  2701011

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-197 00:00

Transduer #1:
-------------
Pitch Offset: -1.040
Roll Offset: 2.910
Azimuth Offset: 0.890

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.550

Manufacturer:  Reson
Model:  sb8101
Serial Number:  2701011

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-252 00:00

Transduer #1:
-------------
Pitch Offset: -0.570
Roll Offset: 2.810
Azimuth Offset: 0.570

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.550

Manufacturer:  Reson
Model:  sb8101
Serial Number:  2701011

_________________________________________________________
Navigation Sensor:

Time Stamp:  2006-001 00:00

Comments (null)
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:  Applanix
Model:  POS/MV v320
Serial Number:  788

Time Stamp:  2007-001 00:00

Comments POS time mistakenly set to GPS time requiring a 14 sec time 
correction
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FA_1010_Reson8101_end07.txt
Latency 14.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2564

Time Stamp:  2007-102 00:00

Comments Time changed in POS to UTC - 14 sec time correction deleted
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2564

_________________________________________________________
Gyro Sensor:

Time Stamp:  2006-001 00:00

Comments (null)
Latency 0.000

Time Stamp:  2007-001 00:00

Comments POS time mistakenly set to GPS time requiring a 14 sec time 
correction

Latency 14.000

Time Stamp:  2007-102 00:00

Comments Time changed in POS to UTC - 14 sec time correction deleted
Latency 0.000

_________________________________________________________
Heave Sensor:

Time Stamp:  2006-001 00:00

Comments True Heave Enabled
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v320
Serial Number:  788

Time Stamp:  2007-001 00:00
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FA_1010_Reson8101_end07.txt
Comments True Heave Enabled / POS time mistakenly set to GPS time requiring 

a 14 sec time correctionPOS time mistakenly set to GPS time requiring a 14 sec time 
correction

Apply Yes
Latency 14.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2564

Time Stamp:  2007-102 00:00

Comments Time changed in POS to UTC - 14 sec time correction deleted
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2564

_________________________________________________________
Pitch Sensor:

Time Stamp:  2006-001 00:00

Comments (null)
Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v320
Serial Number:  788

Time Stamp:  2007-001 00:00

Comments POS time mistakenly set to GPS time requiring a 14 sec time 
correction

Apply Yes
Latency 14.000
Pitch offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2564

Time Stamp:  2007-102 00:00

Comments Time changed in POS to UTC - 14 sec time correction deleted
Apply Yes
Latency 0.000
Pitch offset: 0.000
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Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2564

_________________________________________________________
Roll Sensor:

Time Stamp:  2006-001 00:00

Comments (null)
Apply Yes
Latency 0.000
Roll offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v320
Serial Number:  788

Time Stamp:  2007-001 00:00

Comments POS time mistakenly set to GPS time requiring a 14 sec time 
correction

Apply Yes
Latency 14.000
Roll offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2564

Time Stamp:  2007-102 00:00

Comments Time changed in POS to UTC - 14 sec time correction deleted
Apply Yes
Latency 0.000
Roll offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2564

_________________________________________________________
Draft Sensor:

Time Stamp:  2006-001 00:00

Apply Yes
Comments DDSSM
Entry 1) Draft: 0.000 Speed: 0.000
Entry 2) Draft: -0.070 Speed: 4.636
Entry 3) Draft: -0.030 Speed: 6.230
Entry 4) Draft: -0.020 Speed: 8.164
Entry 5) Draft: -0.010 Speed: 9.846
Entry 6) Draft: -0.030 Speed: 12.227

Time Stamp:  2007-001 00:00

Apply Yes
Comments DDSSM
Entry 1) Draft: 0.000 Speed: 0.000
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Entry 2) Draft: -0.041 Speed: 5.015
Entry 3) Draft: -0.031 Speed: 6.026
Entry 4) Draft: 0.023 Speed: 7.737
Entry 5) Draft: 0.053 Speed: 8.942
Entry 6) Draft: 0.102 Speed: 10.050
Entry 7) Draft: 0.089 Speed: 10.438

_________________________________________________________
TPE

Time Stamp:  2006-001 00:00

Comments 
Offsets 

Motion sensing unit to the transducer 1 
X Head 1 0.312
Y Head 1 -0.142
Z Head 1 0.397

Motion sensing unit to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Navigation antenna to the transducer 1
X Head 1 1.209
Y Head 1 1.057
Z Head 1 3.538

Navigation antenna to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.050 or 5.000'' of heave amplitude.
Measurement errors: 0.007
Motion sensing unit alignment errors
Gyro:0.250 Pitch:0.150 Roll:0.150
Gyro measurement error: 0.020
Roll measurement error: 0.020
Pitch measurement error: 0.020
Navigation measurement error: 0.500
Transducer timing error: 0.005
Navigation timing error: 0.005
Gyro timing error: 0.005
Heave timing error: 0.005
PitchTimingStdDev: 0.005
Roll timing error: 0.005
Sound Velocity speed measurement error: 0.000
Surface sound speed measurement error: 0.050
Tide measurement error: 0.010
Tide zoning error: 0.720
Speed over ground measurement error: 0.030
Dynamic loading measurement error: 0.000
Static draft measurement error: 0.050
Delta draft measurement error: 0.020
StDev Comment: `éƒJ Ï…J`õ…JPõ…J°ð…J €…J@í…J°k€JàZ€J€Ó…Ja

Time Stamp:  2007-001 00:00

Comments 
Offsets 
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Motion sensing unit to the transducer 1 

X Head 1 0.247
Y Head 1 -0.138
Z Head 1 0.551

Motion sensing unit to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Navigation antenna to the transducer 1
X Head 1 1.144
Y Head 1 1.061
Z Head 1 3.667

Navigation antenna to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.050 or 5.000'' of heave amplitude.
Measurement errors: 0.007
Motion sensing unit alignment errors
Gyro:0.100 Pitch:0.130 Roll:0.130
Gyro measurement error: 0.020
Roll measurement error: 0.020
Pitch measurement error: 0.020
Navigation measurement error: 0.500
Transducer timing error: 0.005
Navigation timing error: 0.005
Gyro timing error: 0.005
Heave timing error: 0.005
PitchTimingStdDev: 0.005
Roll timing error: 0.005
Sound Velocity speed measurement error: 0.000
Surface sound speed measurement error: 0.050
Tide measurement error: 0.010
Tide zoning error: 0.720
Speed over ground measurement error: 0.030
Dynamic loading measurement error: 0.010
Static draft measurement error: 0.016
Delta draft measurement error: 0.007
StDev Comment: `éƒJ Ï…J`õ…JPõ…J°ð…J €…J@í…J°k€JàZ€J€Ó…Ja

_________________________________________________________
Svp Sensor:

Time Stamp:  2006-001 00:00

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.312
DeltaY: -0.142
DeltaZ: 0.397

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
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Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-001 00:00

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-119 00:00

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-136 22:07

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000
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DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-150 00:00

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-150 19:04

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
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Time Stamp:  2007-150 23:23

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-151 00:00

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-172 00:10

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

SVP #2:
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-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-176 00:00

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.551

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-176 22:20

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.550

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-197 00:00

Comments 
Svp #1:
-------------
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Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.550

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-252 00:00

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.247
DeltaY: -0.138
DeltaZ: 0.550

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

_________________________________________________________
WaterLine:

Time Stamp:  2006-001 00:00

Comments 
Apply Yes
WaterLine -0.240

Time Stamp:  2007-001 00:00

Comments 
Apply Yes
WaterLine -0.243

_________________________________________________________
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 1010 Offsets and Measurements - Summary

Measurement IMU to RP* 8101 to RP*
aka
Coord. Sys. Caris Caris Caris Caris Caris
x 0.000 0.247 0.247 1.144 n/a
y 0.000 -0.138 -0.138 1.061 n/a
z 0.000 0.551 0.551 3.667 -0.243

*IMU is RP (Reference Pt)

Vessel Offsets for 1010_8101 are derived from the Horizontal, Vertical & XYZ worksheets in this spreadsheet. 2007 Measured Values

Coord. Sys.
Theodolite IMU (m) x 3.516 IMU (m) x 3.516 IMU (m) x 3.516

y 0.011 y 0.011 y 0.011
z -1.183 z -1.183 z -1.183

BM H x 3.271447 Port Antenna x 2.317 BM C x 0.000
y 0.425598 y -0.886 y 0.000
z -1.37667 z 1.934 z 0.000

IMU x -0.244 IMU to x -1.199 BM C to IMU
to BM H y 0.415 Port Antenna y -0.897 x n/a

z -0.194 z 3.117 y n/a
z -1.183

BM H to x 10.6 IMU to x -0.138
Phase Ctr (cm)   y -16.8 Phase Ctr y 0.247 BM C to Waterline
measured z -35.7 z -0.551 measured x n/a

y n/a
BM H to x 0.106 z -0.940
Phase Ctr (m)     y -0.168

z -0.357
see 

Coord. Sys.
Theodolite IMU to x -0.138 x 1.061 x n/a

Phase Ctr y 0.247 y 1.144 y n/a
z -0.551 z -3.667 z 0.243

Coord. Sys. CARIS Coord. Sys. CARIS Coord. Sys. CARIS
x 0.247 x 1.144 x n/a
y -0.138 y 1.061 y n/a
z 0.551 z 3.667 z -0.243

IMU to 8101 IMU to 8101 Port Ant to 8101

RP* to Waterline

RP to Waterline

RP to Waterline

Port Ant to 8101

Port Ant to 8101

IMU to 8101

8101 to RP* IMU to 8101
Calculations

Nav to Trans x,y,zSWATH1 x,y,z  & MRU to Trans



 1010 Offsets and Measurements - Summary

Caris Pos/Mv Caris Pos/Mv
Scalar Distance 1.840 -0.897 -1.199 -0.011 -1.176

-1.199 -0.897 -1.176 -0.011
-3.117 -3.117 -0.243 -0.243

Port Ant (m) x 2.317 IMU (m) x 3.516 IMU (m) y 0.011
y -0.886 y 0.011 x is n/a z -1.183
z 1.934 z -1.183

Heave Pt (m)
Stbd Ant (m) x 2.324 Port Ant (m) x 2.317 (centerline) y 0.000

y 0.953 y -0.886
z 1.878 z 1.934 BM C to Waterline (m) -0.940

measured scalar dist 

BM C
x&y are n/a z 0.000

BM C to Waterline (m)
(Heave Pt) z -0.940

IMU to LCG x -1.176
See IMU to Heave tab

x -1.199 x -1.176
Scalar Distance 1.840 y -0.897 y -0.011

z 3.117 z 0.243

Coord. Sys. Pos/Mv Coord. Sys. Pos/Mv
x -1.199 x -1.176
y -0.897 y -0.011
z -3.117 z -0.243

See IMU to Heave tab

IMU to Heave

IMU to Port Antenna

Port Ant to Stbd Ant IMU to Port Antenna

IMU to Heave

IMU to Port Antenna IMU to Heave

Port Ant to Stbd Ant

Port Ant to Stbd Ant



Description of Offsets for Launch 1010
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 1010 was based from benchmark (BM) C as the 0 point.  Physical locations were measured with x,y,z offsets from 
this point.  These locations were used to calculate offsets of items with respect to each other, as described for each offset.

x=0.247

z=0.551

z=3.667

x=1.144

z=-3.117

x=-0.897
1.840

z=-0.243
x=-0.011

z=0.551

y=-0.138

z=3.667

y=1.061

z=-0.243

z=-3.117

y=-1.199

z=-0.243
y=-1.176



x y z x y z x y z x y z x y z
0.247 -0.138 0.551 1.144 1.061 3.667 N/A N/A -0.243 -0.897 -1.199 -3.117 -0.011 -1.176 -0.243

IMU to Port Antenna IMU to Heave
Scalar Distance

1.840

IMU to 8101 Port Ant to 8101 RP to Waterline Port Ant to Stbd Ant

The physical positions of the IMU 
and the phase center of the 8101 
with respect to the Ship 
Reference Frame were 
measured by NOAA personnel.  
These physical measurements 
were used to calculate the xyz 
offsets from the IMU to BM H. 
Measurements from BM H to the 
Phase Center of the 8101 were 
collected by NOAA personnel 
while the boat was secured in the 
davit and thought to be as level 
as possible.  The measured 
offsets from BM H to the phase 
center were then added to the 
offset from the IMU to BM H.  
The result is the offset from the 
IMU to the phase center of the 
transducer.  The values in the X 
and Y fields are transposed and 
the inverse of the Z value is used 
to give the offsets in CARIS 
coordinates.

NOAA personnel calculated the 
distance between the port 
antenna and the phase center of 
the port antenna subtracting  the 
IMU to Port Antenna value from 
the IMU to Phase Center value.   

The vertical distance from BM A 
and B to the waterline was 
measured by FAIRWEATHER 
personnel using a steel tape and 
bubble level.  With the 
knowledge of the two BMs height 
above the IMU, the waterline 
height above the IMU could be 
calculated.  On launch 1010, the 
IMU is used as the reference 
point.  

The location of the IMU and the 
location of the port antenna were 
measured by NOAA personnel 
with respect to the Ship 
Reference Frame (SRF).  The 
xyz offsets from the IMU to the 
port antenna could be calculated 
from these physical locations. 

The heave point was positioned 
differently on each of the axes.  
The distance for the longitundinal 
axis was determined as 
described in the "IMU to Heave" 
tab in this workbook.  The 
athwart ships axis was the vessel 
centerline.  Lastly, the waterline 
was used as the height of the 
heave point, which was 
calculated earlier in 'RP to 
Waterline'.  

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
measured by NOAA personnel 
with respect to the SRF.  The 
scalar distance between the 
phase centers was then 
calculated. 



1010 Vessel Diagram
All Values Shown are in Theodolite Coordinates

Note:   Both antenna have been replaced for the POS 
V4.  While their x-y values are not thought to have 
changed, the z-value has been remeasured.



FAIRWEATHER
Multibeam Echosounder Calibration

7/17/2007
Date Dn Local Area

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

7/17/2007
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

1628 22.8
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

(Cast#2 backtimed to 1
2105 27.6

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

197

8101

2701011

Kodiak, Womans Bay

POSMV v.4

071971628

071972105

197

57/43/38.3 152/31/23.73

No Trueheave logged

Dowling, Argento, Morgan, Gonsalves

10-40m

Flat calmKodiak

152/31/56.3

Vessel
Launch 1010

57/42/53.6



ROLL
SV Cast # Hd Speed (kts) Remarks

1 035/215 7.0
1 035/215 6.0 Waked out at beginning of line 1719 (use for timing)
1 035/215 6.5
1 035/215 6.5
1 035/215 7.0
1 035/215 7.2
1 035/215 6.3
1 035/215 6.3
1 035/215 6.4
1 035/215 7.2
1 035/215 7.1
1 035/215 6.5
1 035/215

PITCH
SV Cast # Hd Speed (kts) Remarks

2 247 5.5
2 066 5.5
2 245 5.3
2 065 5.3

HEADING/YAW
SV Cast # Heading Speed (kts) Remarks

2 245
2 065
2 242
2 066

REFERENCE SURFACE
SV Cast # Heading Speed (kts) Remarks

Acquired post hard starbord turns
Jen_Roll_11, Jen_Roll_12 Acquired post hard starbord turns
Adam_Roll_1, Adam_Roll_2 Transducer leisurely cranked down

Pitch_8

Transducer cranked down by Dowling

Port_Turn_2, Port_Turn_3 Acquired post hard port turns
Port_Turn_4, Port_Turn_5 Acquired post hard port turns

XTF Line Filename

Pitch_9
Pitch_10

Acquired post hard starbord turns

Jen_Roll_1, Jen_Roll_2 Transducer cranked down by Dowling

Acquired post hard port turns
Acquired post hard port turns

197-1705, 1709

Jen_Roll_5, Jen_Roll_6
Jen_Roll_7, Jen_Roll_8

197-1714, 1719
197-1725, 1729 Acquired post hard starbord turns
197-1734, 1739

Pitch_2
Pitch_4
Pitch_5

z
XTF Line Filename

XTF Line Filename

XTF Line Filename

Jen_Roll_9, Jen_Roll_10

Jen_Roll_3, Jen_Roll_4

Pitch_6



Processing Log

7/17/2007
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers (mog)

Calibrating Hydrographer(s)

PATCH TEST RESULTS/CORRECTORS Yaw (deg)
Evaluators Latency (sec) Pitch (deg) Roll (deg)
adam/nick A 0.00 0.80
matt B 0.00 -1.10 2.97 0.94
brenna C 0.00
pat/allison D 0.00 -1.05 0.93
mark/steph E 0.00 -1.22 0.90
toshi/cathleen F 0.00 -0.90 2.84 0.85
mog 0.00 -0.95 0.90
FOO (Post SmTide) 0.00

Averages 0.00 -1.04 0.89
Standard Deviation 0.00 0.13 0.05

FINAL VALUES -1.04 0.89

Final Values based on
Final Values analyzed/compiled by: mog/foo

Value from standard deviation of Heading offset values MRU Align StdDev Gyro
Value from sum of squares standard deviations of pitch and roll offsets MRU Align StdDev Roll/Pitch

Results are for HVF File Named:

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:
NARRATIVE

2.91

Kodiak verified - foo

Data converted --> HDCS_Data in CARIS

Argento197

2.91

Compute correctors in this order

2.89

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

2.85

Do not enter/apply correctors until all evaluations are complete and analyzed.

N/A

previous in time

Grayed out signifies outlier-not used in average

2.85
2.94

0.04

Average minus outliers (roll based on mog value based on dozens of roll lines)

FA_1010_Reson8101

0.05
0.13

2.87

No trueheave logged

2.91



RPM Speed (m/s) Speed (knots) mog-Ave bj-Ave kb-Ave Std. Dev. Average
0 0 0 0 0 0 0 0

620 2.58 5 -0.044685862 -0.040728915 -0.037282951 0.003704394 -0.040899243
790 3.10 6 -0.02870312 -0.039467254 -0.023804602 0.00801229 -0.030658325

1040 3.98 7.7 0.019162864 0.017309788 0.033217055 0.008698614 0.023229902
1235 4.60 8.9 0.048612724 0.048718001 0.060843062 0.007030995 0.052724596
1530 5.17 10 0.096159255 0.094792289 0.115960382 0.011846529 0.102303975
1696 5.37 10.4 0.083489759 0.080253529 0.101141624 0.011242583 0.088294971

S220 - Stop#1 DDSSM
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S220 - Stop#2 DDSSM
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S220 - Stop#3 DDSSM
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Ave. StDev 0.006862

Blue cells used in computation of 
Delta Draft StDev used in TPE

1010-8101 DDSSM
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Ship: FAIRWEATHER Vessel: 1010
Date: 3/30/2007 Dn: 089
Personnel: Walker, Gonsalves, Mills

PCS Serial # IMU Serial # 294

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About)

POS Version (Use Menu View > Statistics) MV320 v4
GPS Receivers

Primary Receiver

Secondary Receiver

Calibration area
Location:
Approximate Position: Lat 55 17 3

Lon 131 39 55
DGPS Beacon Station: Annette Island
Frequency: 323

Satellite Constellation (Use View> GPS Data)

Primary GPS
Sketch general SV configuration Note any differences from Primary GPS Receiver

PDOP 1.600 (Use View> GAMS Solution)

Secondary GPS

2564

3.3.2.2

BD950 SN:4624A70264

BD950 SN:4622A68956

NOAA POS/MV Calibration Report

Nichols Passage, AK



POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Configuration Notes:

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)

Start time: 1947
End time: 1948
Heading accuracy achieved for calibration: 0.1

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

GAMS Status Online Yes
Save Settings Yes

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: 1010_089_POSMV

The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

b) Pitch rotation - apply a right-hand screw rotation θy about the once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the twice-rotated x-axis to align one frame with the other.

• The y-axis is perpendicular to the x-axis and points towards the right (starboard) side in the appropriate reference frame.

Apply the rotation in the following order to bring the two frames of reference into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the z-axis to align one frame with the othe



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2

COM3

COM4



SETTINGS Continued

COM5

Heave Filter (Use Settings > Heave)

Events Use Settings > Events)



INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

The Time Tag has since 
been shifted to UTC



User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver
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FA_1018_Reson8101_end07.txt
Vessel Name: FA_1018_Reson8101.hvf
Vessel created: December 19, 2006

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-001 00:00

Transduer #1:
-------------
Pitch Offset: -0.240
Roll Offset: 2.890
Azimuth Offset: 0.260

DeltaX: 0.286
DeltaY: -0.141
DeltaZ: 0.551

Manufacturer:  Reson
Model:  sb8101
Serial Number:  35737

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-224 00:00

Transduer #1:
-------------
Pitch Offset: -0.240
Roll Offset: 3.200
Azimuth Offset: 0.260

DeltaX: 0.286
DeltaY: -0.141
DeltaZ: 0.551

Manufacturer:  Reson
Model:  sb8101
Serial Number:  35737

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-236 00:00

Transduer #1:
-------------
Pitch Offset: -0.240
Roll Offset: 3.630
Azimuth Offset: 0.260

DeltaX: 0.286
DeltaY: -0.141
DeltaZ: 0.551

Manufacturer:  Reson
Model:  sb8101
Serial Number:  35737

_________________________________________________________
Navigation Sensor:

Page 1



FA_1018_Reson8101_end07.txt

Time Stamp:  2007-001 00:00

Comments POS time mistakenly set to GPS time requiring a 14 sec time 
correction

Latency 14.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2560

Time Stamp:  2007-102 00:00

Comments Time changed in POS to UTC - 14 sec time correction deleted
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2560

_________________________________________________________
Gyro Sensor:

Time Stamp:  2007-001 00:00

Comments POS time mistakenly set to GPS time requiring a 14 sec time 
correction

Latency 14.000

Time Stamp:  2007-102 00:00

Comments Time changed in POS to UTC - 14 sec time correction deleted
Latency 0.000

_________________________________________________________
Heave Sensor:

Time Stamp:  2007-001 00:00

Comments True Heave Enabled/POS time mistakenly set to GPS time requiring a 
14 sec time correctionPOS time mistakenly set to GPS time requiring a 14 sec time 
correction

Apply Yes
Latency 14.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2560

Time Stamp:  2007-102 00:00
Page 2



FA_1018_Reson8101_end07.txt

Comments Time changed in POS to UTC - 14 sec time correction deleted
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2560

_________________________________________________________
Pitch Sensor:

Time Stamp:  2007-001 00:00

Comments POS time mistakenly set to GPS time requiring a 14 sec time 
correction

Apply Yes
Latency 14.000
Pitch offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2560

Time Stamp:  2007-102 00:00

Comments Time changed in POS to UTC - 14 sec time correction deleted
Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2560

_________________________________________________________
Roll Sensor:

Time Stamp:  2007-001 00:00

Comments POS time mistakenly set to GPS time requiring a 14 sec time 
correction

Apply Yes
Latency 14.000
Roll offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2560

Time Stamp:  2007-102 00:00

Comments Time changed in POS to UTC - 14 sec time correction deleted
Apply Yes
Latency 0.000
Roll offset: 0.000
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FA_1018_Reson8101_end07.txt
Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2560

_________________________________________________________
Draft Sensor:

Time Stamp:  2007-001 00:00

Apply Yes
Comments DDSSM
Entry 1) Draft: 0.000 Speed: 0.000
Entry 2) Draft: 0.039 Speed: 5.015
Entry 3) Draft: 0.061 Speed: 6.026
Entry 4) Draft: 0.110 Speed: 7.425
Entry 5) Draft: 0.151 Speed: 8.242
Entry 6) Draft: 0.133 Speed: 9.350
Entry 7) Draft: 0.074 Speed: 10.341
Entry 8) Draft: 0.049 Speed: 11.955

_________________________________________________________
TPE

Time Stamp:  2007-001 00:00

Comments 
Offsets 

Motion sensing unit to the transducer 1 
X Head 1 0.286
Y Head 1 -0.141
Z Head 1 0.551

Motion sensing unit to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Navigation antenna to the transducer 1
X Head 1 1.184
Y Head 1 0.960
Z Head 1 3.711

Navigation antenna to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.050 or 5.000'' of heave amplitude.
Measurement errors: 0.007
Motion sensing unit alignment errors
Gyro:0.090 Pitch:0.060 Roll:0.060
Gyro measurement error: 0.020
Roll measurement error: 0.020
Pitch measurement error: 0.020
Navigation measurement error: 0.500
Transducer timing error: 0.005
Navigation timing error: 0.005
Gyro timing error: 0.005
Heave timing error: 0.005
PitchTimingStdDev: 0.005
Roll timing error: 0.005
Sound Velocity speed measurement error: 0.007
Surface sound speed measurement error: 0.007
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FA_1018_Reson8101_end07.txt
Tide measurement error: 0.007
Tide zoning error: 0.030
Speed over ground measurement error: 0.030
Dynamic loading measurement error: 0.010
Static draft measurement error: 0.016
Delta draft measurement error: 0.050
StDev Comment: `éƒJ Ï…J`õ…JPõ…J°ð…J €…J@í…J°k€JàZ€J€Ó…Ja

_________________________________________________________
Svp Sensor:

Time Stamp:  2007-001 00:00

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.286
DeltaY: -0.141
DeltaZ: 0.551

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-224 00:00

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.286
DeltaY: -0.141
DeltaZ: 0.551

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-236 00:00

Comments 
Svp #1:
-------------
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FA_1018_Reson8101_end07.txt
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.286
DeltaY: -0.141
DeltaZ: 0.551

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

_________________________________________________________
WaterLine:

Time Stamp:  2007-001 00:00

Comments 
Apply Yes
WaterLine -0.280

_________________________________________________________
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1018 Offsets and Measurements
Summary

Measurement IMU to RP* 8101 to RP*
aka SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris
x 0.000 0.286 0.286 1.184 n/a
y 0.000 -0.141 -0.141 0.960 n/a
z 0.000 0.551 0.551 3.711 -0.276

*IMU is Reference Point

Vessel Offsets for 1018_8101 are derived from the Horizontal,  Vertical & XYZ worksheets in this spreadsheet. 2007 Measured Value

Calculations
Coord. Sys.
Theodolite IMU (m) x 3.54587 IMU (m) x 3.545867 IMU (m) x 3.546

y -0.01516 y -0.01516 y -0.015
z -0.85883 z -0.85883 z -0.859

BM H x 3.30204 Port Ant (m) x 2.445 BM C x 0.000
y 0.43081 y -0.913 y 0.000
z -1.0485 z 2.302 z 0.000

IMU x -0.244 IMU to x -1.101 BM C to IMU
to BM H y 0.446 Port Antenna y -0.898 x n/a

z -0.190 z 3.161 y n/a
z -0.859

BM H to x 10.3 IMU to x -0.141
Phase Ctr (cm)   y -16.0 Phase Ctr y 0.286 BM C to Waterline (m)
measured z -36.1 z -0.551 z -0.583

BM H to x 0.103
Phase Ctr (m)     y -0.160

z -0.361
see 

Coord. Sys.
Theodolite IMU to x -0.141 x 0.960 x n/a

Phase Ctr y 0.286 y 1.184 y n/a
z -0.551 z -3.711 z 0.276

Coord. Sys. CARIS Coord. Sys. CARIS Coord. Sys. CARIS
x 0.286 x 1.184 x n/a
y -0.141 y 0.960 y n/a
z 0.551 z 3.711 z -0.276

8101 to RP*

IMU to 8101 RP to Waterline  IMU to 8101 Port Ant to 8101

IMU to 8101

IMU to 8101

RP* to Waterline  

RP to Waterline  

Port Ant to 8101

Port Ant to 8101



1018 Offsets and Measurements
Summary

Caris Pos/Mv Caris Pos/Mv
Scaler Distance 1.834 -0.898 -1.101 0.015 -1.114

-1.101 -0.898 -1.114 0.015
-3.161 -3.161 -0.276 -0.276

Port Ant (m) x 2.445 IMU (m) x 3.546 IMU (m) y -0.015
y -0.913 y -0.015 x is n/a z -0.859
z 2.302 z -0.859

Heave Pt (m)
Stbd Ant (m) x 2.445 Port Ant(m) x 2.445 (centerline) y 0.000

y 0.921 y -0.913
z 2.275 z 2.302 BM C to Waterline (m) -0.583

measured scalar dist 

BM C
x&y are n/a z 0.000

BM C to Waterline (m)
(Heave Pt) z -0.583

IMU to Hv x -1.114

x -1.101 x -1.114
Scalar Distance 1.8342 y -0.898 y 0.015

z 3.161 z 0.276

Coord. Sys. Pos/Mv Coord. Sys. Pos/Mv
x -1.101 x -1.114
y -0.898 y 0.015
z -3.161 z -0.276

See IMU to Heave tab.

IMU to Port Ant

IMU to Heave

Port Ant to Stbd Ant IMU to Heave

See IMU to Heave tab.

Port Ant to Stbd Ant

IMU to HeavePort Ant to Stbd Ant IMU to Port Ant

IMU to Port Ant



Description of Offsets for Launch 1018
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 1018 was based from benchmark (BM) C as the 0 point.  Physical locations were measured with x,y,z offsets from this point.  These locations 
were used to calculate offsets of items with respect to each other, as described for each offset.

x=0.286

z=0.551

z=3.711

x=1.184

z=-3.169

x=-0.898
1.834

z=-0.322
x=0.015

z=0.551

y=-0.141

z=3.711

z=-0.276

y=0.960

z=-3.169

y=-1.101

z=-0.322
y=-1.114



x y z x y z x y z x y z x y z
0.286 -0.141 0.551 1.184 0.960 3.711 N/A N/A -0.276 -0.898 -1.101 -3.169 0.015 -1.114 -0.276

IMU to Heave
Scalar Distance

1.834

IMU to 8101 Port Ant to 8101 RP to Waterline Port Ant to Stbd Ant IMU to Port Antenna

The physical positions of the IMU 
and the phase center of the 8101 
with respect to the Ship 
Reference Frame were 
measured by NOAA personnel.  
These physical measurements 
were used to calculate the xyz 
offsets from the IMU to BM H. 
Measurements from BM H to the 
Phase Center of the 8101 were 
collected by NOAA personnel 
while the boat was secured in the 
davit and thought to be as level 
as possible.  The measured 
offsets from BM H to the phase 
center were then added to the 
offset from the IMU to BM H.  
The result is the offset from the 
IMU to the phase center of the 
transducer.  The values in the X 
and Y fields are transposed and 
the inverse of the Z value is used 
to give the offsets in CARIS 
coordinates.

NOAA personnel calculated the 
distance between the port 
antenna and the phase center of 
the port antenna subtracting  the 
IMU to Port Antenna value from 
the IMU to Phase Center value.   

The vertical distance from BM A 
and B to the waterline was 
measured by FAIRWEATHER 
personnel using a steel tape and 
bubble level.  With the 
knowledge of the two BMs height 
above the IMU, the waterline 
height above the IMU could be 
calculated.  On launch 1010, the 
IMU is used as the reference 
point.  

The location of the IMU and the 
location of the port antenna were 
measured by NOAA personnel 
with respect to the Ship 
Reference Frame (SRF).  The 
xyz offsets from the IMU to the 
port antenna could be calculated 
from these physical locations. 

The heave point was positioned 
differently on each of the axes.  
The distance for the longitundinal 
axis was determined as 
described in the "IMU to Heave" 
tab in this workbook.  The 
athwart ships axis was the vessel 
centerline.  Lastly, the waterline 
was used as the height of the 
heave point, which was 
calculated earlier in 'RP to 
Waterline'.  

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
measured by NOAA personnel 
with respect to the SRF.  The 
scalar distance between the 
phase centers was then 
calculated. 



All Values Shown are in Theodolite Coordinates
1018 Vessel Diagram

Note:   Both antenna have been replaced for the POS 
V4.  While their x-y values are not thought to have 
changed, the z-value has been remeasured.



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/9/2007
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/9/2007
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

17:11 57.1
UTC Time Lat Lon Ext. Depth Bk time to For lines

18:51 77.2
UTC Time Lat Lon Ext. Depth Bk time to For lines

81.1
UTC Time Lat Lon Ext. Depth Bk time to For lines

SV Cast #2 filename

07099203 55/11/29 -131/37/36

-131/37/52
SV Cast #1 filename

07099185 55/16/28 -131/40/26

POSMV4

40m

Ketchikan

Launch 1018

Gonsalves, Johnston, Brown, Froelich

Gonsalves, Johnston, Brown, Froelich

099

Reson 8101

35737

099

TH_1018_DN099

SV Cast #3 filename

CalmKetchikan

07099171 55/19/59



ROLL
SV Cast # Heading Speed (kts) Remarks
70991851.ex 270 4.8

090 4.6
270 4.8
090 4.6
270 4.7
090 4.6

PITCH
SV Cast # Heading Speed (kts) Remarks
070991711.ex 100 4.5

292 4.5
BAD BAD

292 4.5
100 4.5
295 4.5

HEADING/YAW
SV Cast # Heading Speed (kts) Remarks
070991711.ex 120 4.5

295 4.5
117 4.5
295 4.5

REF SURFACE
SV Cast # Heading Speed (kts) Remarks

70992033
70992033

099-2053
099-2055 to 2101

XTF Line Filename
Reference surface on 11fm shoal

HEADING1
XTF Line Filename

Mike's
Mike's

Kurt's
Kurt's
Bonnie's
Bonnie's

Roll5
Roll6

Roll1
Roll2
Roll3
Roll4

XTF Line Filename
pitch1
pitch2
pitch3
pitch4

pitch6
pitch5

HEADING2
HEADING3
HEADING4

XTF Line Filename



Processing Log

Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
14.00 -0.25 2.90 0.20
14.00 -0.30 2.87 0.22
14.00 -0.18 2.90 0.36

14.00 -0.24 2.89 0.26
0.00 0.06 0.02 0.09
14.00 -0.24 2.89 0.26

Resulting HVF File Name

MRU Align StdDev gyro 0.09 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.06 Value from sum of squares standard deviations of pitch and roll offset v

FA_1018_Reson8101

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Group Average

Data converted --> HDCS_Data in CARIS

Final Values based on

Averages
Standard Deviation

FINAL VALUES

blj

TH_1018_DN099.000 (kb)

kb - No zoning used for patch lines over wreck - outside zoning file

kb

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

mog
keb



NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 04/12/2007Kurt Brown

Time on the POSMV was mistakenly set to GPS time on launches for all data acquired prior to DN100.  This resulted in a latency value of 
14.00 seconds which is equivalent to the time difference between GPS and UTC time.  GPS time is ahead 14 seconds.  Following this 

discovery the POSMV was corrected to log UTC time on both launches.  Two lines of offset values have been added to the HVFs for 1018.  
The first set of offsets include 14 seconds entered into the time correction field for Navigation, Gyro, Heave, Ptich, and Roll, and should be 
used for all data collected on and before DN100.  The second set has the time correction field set to zero and should be used for all data 

collected on and after DN102.  Values for Pitch, Roll and Yaw in both set of offsets were taken from the average bias values shown above.



RPM Speed (m/s) Speed (knots) mog-Ave bj-Ave kb-Ave Std. Dev. Average
0 0 0 0 0 0 0

2.58 5 -0.00585794 0.079715319 0.043122636 0.042935813 0.038993338
3.10 6 0.025614878 0.079009483 0.076973913 0.030256894 0.060532758
3.82 7.4 0.03839154 0.148848379 0.144137953 0.062456925 0.110459291
4.24 8.2 0.08821736 0.151215298 0.214475233 0.063128982 0.15130263
4.81 9.3 0.077429894 0.200576308 0.121471387 0.062399627 0.133159196
5.32 10.3 0.016338694 0.109102998 0.095486417 0.050091565 0.073642703
6.15 11.9 -0.01948801 0.099463807 0.0659994 0.061342615 0.048658399

1018 - Stop#1 DDSSM
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1018 - Stop#2 DDSSM

-0.1000

-0.0800

-0.0600

-0.0400

-0.0200

0.0000

0.0200

0.0400

0 2 4 6 8 10 12 14

Speed (kts)

D
ep

th
 D

iff
er

en
ce

 (m
)

Series1

1018 - Stop#3 DDSSM
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Blue cells used in computation of Delta Draft 
StDev used in TPE

Ave StDev 0.052236

1018_ DDSSM
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Ship: FAIRWEATHER Vessel: 1018
Date: 3/30/2007 Dn: 89
Personnel: Froelich, Lewis, Campbell

PCS Serial # IMU Serial # 37

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About)

POS Version (Use Menu View > Statistics) MV320 v4
GPS Receivers

Primary Receiver

Secondary Receiver

Calibration area
Location:
Approximate Position: Lat 55 13 30

Lon 131 43 30
DGPS Beacon Station: Annete Island
Frequency: 323 kHz

Satellite Constellation (Use View> GPS Data)

Primary GPS
Sketch general SV configuration Note any differences from Primary GPS Receiver

PDOP 1.7 (Use View> GAMS Solution)

NOAA POS/MV Calibration Report

Bostwick Inlet, AK

Secondary GPS

2560

3.3.2.2

SN:4624A70243

SN:4624A70263



POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Configuration Notes:

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)

Start time: 1130
End time: 1135
Heading accuracy achieved for calibration: 0.085

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2

COM3



SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events Use Settings > Events)



INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Time Tag 1 has been 
shifted to UTC time.



User Parameter Accuracy (Use Settings > Installation > User Accuracy)

GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver
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FA_S220_Reson8111_end07.txt
Vessel Name: FA_S220_Reson8111.hvf
Vessel created: December 19, 2006

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2006-001 00:00

Transduer #1:
-------------
Pitch Offset: -0.630
Roll Offset: -0.010
Azimuth Offset: -0.520

DeltaX: 2.868
DeltaY: 8.252
DeltaZ: 4.753

Manufacturer:  Reson
Model:  sb8111
Serial Number:  

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2006-216 00:00

Transduer #1:
-------------
Pitch Offset: -0.630
Roll Offset: -0.010
Azimuth Offset: -0.520

DeltaX: 2.868
DeltaY: 8.252
DeltaZ: 4.753

Manufacturer:  Reson
Model:  sb8111
Serial Number:  

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-001 00:00

Transduer #1:
-------------
Pitch Offset: -0.590
Roll Offset: -0.020
Azimuth Offset: -0.380

DeltaX: 2.868
DeltaY: 8.252
DeltaZ: 4.752

Manufacturer:  Reson
Model:  sb8111
Serial Number:  

_________________________________________________________
Navigation Sensor:
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Time Stamp:  2006-001 00:00

Comments (null)
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:  Applanix
Model:  POS/MV v320
Serial Number:  846

Time Stamp:  2007-001 00:00

Comments (null)
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2411

_________________________________________________________
Gyro Sensor:

Time Stamp:  2006-001 00:00

Comments (null)
Latency 0.000

Time Stamp:  2007-001 00:00

Comments (null)
Latency 0.000

_________________________________________________________
Heave Sensor:

Time Stamp:  2006-001 00:00

Comments True Heave Enabled
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v320
Serial Number:  846

Time Stamp:  2007-001 00:00

Comments True Heave Enabled
Apply Yes
Latency 0.000
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DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2411

_________________________________________________________
Pitch Sensor:

Time Stamp:  2006-001 00:00

Comments (null)
Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v320
Serial Number:  846

Time Stamp:  2007-001 00:00

Comments (null)
Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2411

_________________________________________________________
Roll Sensor:

Time Stamp:  2006-001 00:00

Comments (null)
Apply Yes
Latency 0.000
Roll offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v320
Serial Number:  846

Time Stamp:  2007-001 00:00

Comments (null)
Apply Yes
Latency 0.000
Roll offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2411

_________________________________________________________
Draft Sensor:
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Time Stamp:  2006-001 00:00

Apply Yes
Comments 
Entry 1) Draft: 0.000 Speed: 0.000
Entry 2) Draft: 0.090 Speed: 4.704
Entry 3) Draft: 0.075 Speed: 6.104
Entry 4) Draft: 0.064 Speed: 7.192
Entry 5) Draft: 0.046 Speed: 8.106
Entry 6) Draft: 0.095 Speed: 9.097
Entry 7) Draft: 0.170 Speed: 11.605
Entry 8) Draft: 0.189 Speed: 12.907

Time Stamp:  2007-001 00:00

Apply Yes
Comments 
Entry 1) Draft: 0.000 Speed: 0.000
Entry 2) Draft: -0.032 Speed: 4.024
Entry 3) Draft: 0.002 Speed: 5.618
Entry 4) Draft: 0.023 Speed: 8.339
Entry 5) Draft: 0.142 Speed: 10.400
Entry 6) Draft: 0.159 Speed: 11.857
Entry 7) Draft: 0.232 Speed: 13.860

_________________________________________________________
TPE

Time Stamp:  2006-001 00:00

Comments 
Offsets 

Motion sensing unit to the transducer 1 
X Head 1 2.868
Y Head 1 8.252
Z Head 1 4.753

Motion sensing unit to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Navigation antenna to the transducer 1
X Head 1 2.993
Y Head 1 19.145
Z Head 1 16.253

Navigation antenna to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.050 or 5.000'' of heave amplitude.
Measurement errors: 0.003
Motion sensing unit alignment errors
Gyro:0.230 Pitch:0.160 Roll:0.160
Gyro measurement error: 0.020
Roll measurement error: 0.020
Pitch measurement error: 0.020
Navigation measurement error: 0.500
Transducer timing error: 0.005
Navigation timing error: 0.005
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Gyro timing error: 0.005
Heave timing error: 0.005
PitchTimingStdDev: 0.005
Roll timing error: 0.005
Sound Velocity speed measurement error: 0.003
Surface sound speed measurement error: 0.003
Tide measurement error: 0.003
Tide zoning error: 0.030
Speed over ground measurement error: 0.030
Dynamic loading measurement error: 0.030
Static draft measurement error: 0.050
Delta draft measurement error: 0.020
StDev Comment: `éƒJ Ï…J`õ…JPõ…J°ð…J €…J@í…J°k€JàZ€J€Ó…Ja

Time Stamp:  2007-001 00:00

Comments 
Offsets 

Motion sensing unit to the transducer 1 
X Head 1 2.868
Y Head 1 8.252
Z Head 1 4.752

Motion sensing unit to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Navigation antenna to the transducer 1
X Head 1 1.691
Y Head 1 20.172
Z Head 1 17.756

Navigation antenna to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.050 or 5.000'' of heave amplitude.
Measurement errors: 0.007
Motion sensing unit alignment errors
Gyro:0.050 Pitch:0.110 Roll:0.110
Gyro measurement error: 0.020
Roll measurement error: 0.020
Pitch measurement error: 0.020
Navigation measurement error: 0.500
Transducer timing error: 0.005
Navigation timing error: 0.005
Gyro timing error: 0.005
Heave timing error: 0.005
PitchTimingStdDev: 0.005
Roll timing error: 0.005
Sound Velocity speed measurement error: 0.003
Surface sound speed measurement error: 0.003
Tide measurement error: 0.003
Tide zoning error: 0.030
Speed over ground measurement error: 0.030
Dynamic loading measurement error: 0.020
Static draft measurement error: 0.022
Delta draft measurement error: 0.075
StDev Comment: `éƒJ Ï…J`õ…JPõ…J°ð…J €…J@í…J°k€JàZ€J€Ó…Ja

_________________________________________________________
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Svp Sensor:

Time Stamp:  2006-001 00:00

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 2.868
DeltaY: 8.252
DeltaZ: 4.753

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2006-216 00:00

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 2.868
DeltaY: 8.252
DeltaZ: 4.753

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:  2007-001 00:00

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 2.868
DeltaY: 8.252
DeltaZ: 4.752
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SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

_________________________________________________________
WaterLine:

Time Stamp:  2006-001 00:00

Comments 
Apply Yes
WaterLine -0.010

Time Stamp:  2007-001 00:00

Comments 
Apply Yes
WaterLine 0.000

_________________________________________________________
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FA_S220_Reson8160_5to750_end07.txt
Vessel Name: FA_S220_Reson8160_5to750.hvf
Vessel created: December 19, 2006

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2007-001 00:00

Transduer #1:
-------------
Pitch Offset: -0.290
Roll Offset: -0.040
Azimuth Offset: 0.100

DeltaX: 0.493
DeltaY: 7.665
DeltaZ: 4.726

Manufacturer:  Reson
Model:  sb8160a
Serial Number:  

_________________________________________________________
Navigation Sensor:

Time Stamp:  2007-001 00:00

Comments (null)
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2411

_________________________________________________________
Gyro Sensor:

Time Stamp:  2007-001 00:00

Comments (null)
Latency 0.000

_________________________________________________________
Heave Sensor:

Time Stamp:  2007-001 00:00

Comments True Heave Enabled
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2411
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_________________________________________________________
Pitch Sensor:

Time Stamp:  2007-001 00:00

Comments (null)
Apply No
Latency 0.000
Pitch offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2411

_________________________________________________________
Roll Sensor:

Time Stamp:  2007-001 00:00

Comments (null)
Apply No
Latency 0.000
Roll offset: 0.000

Manufacturer:  Applanix
Model:  POS/MV v4
Serial Number:  2411

_________________________________________________________
Draft Sensor:

Time Stamp:  2007-001 00:00

Apply Yes
Comments DDSSM
Entry 1) Draft: 0.000 Speed: 0.000
Entry 2) Draft: -0.031 Speed: 4.024
Entry 3) Draft: 0.002 Speed: 5.618
Entry 4) Draft: 0.022 Speed: 8.339
Entry 5) Draft: 0.136 Speed: 10.400
Entry 6) Draft: 0.153 Speed: 11.857
Entry 7) Draft: 0.223 Speed: 13.860

_________________________________________________________
TPE

Time Stamp:  2007-001 00:00

Comments 
Offsets 

Motion sensing unit to the transducer 1 
X Head 1 0.493
Y Head 1 7.665
Z Head 1 4.726

Motion sensing unit to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Navigation antenna to the transducer 1
X Head 1 1.691
Y Head 1 20.172
Z Head 1 17.756

Navigation antenna to the transducer 2
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X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.050 or 5.000'' of heave amplitude.
Measurement errors: 0.007
Motion sensing unit alignment errors
Gyro:0.030 Pitch:0.260 Roll:0.260
Gyro measurement error: 0.020
Roll measurement error: 0.020
Pitch measurement error: 0.020
Navigation measurement error: 0.500
Transducer timing error: 0.005
Navigation timing error: 0.005
Gyro timing error: 0.005
Heave timing error: 0.005
PitchTimingStdDev: 0.005
Roll timing error: 0.005
Sound Velocity speed measurement error: 0.500
Surface sound speed measurement error: 0.100
Tide measurement error: 0.010
Tide zoning error: 0.000
Speed over ground measurement error: 0.030
Dynamic loading measurement error: 0.020
Static draft measurement error: 0.030
Delta draft measurement error: 0.075
StDev Comment: `éƒJ Ï…J`õ…JPõ…J°ð…J €…J@í…J°k€JàZ€J€Ó…Ja

_________________________________________________________
Svp Sensor:

Time Stamp:  2007-001 00:00

Comments 
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.493
DeltaY: 7.665
DeltaZ: 4.726

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

_________________________________________________________
WaterLine:

Time Stamp:  2007-001 00:00

Comments 
Apply Yes
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WaterLine -0.002

_________________________________________________________
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S220_8111 Measurements

Measurement
Coord. Sys. Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 2.868 2.993 n/a Scaler Distance 4.064 -0.125 -10.893 1.866 -7.028
y 8.252 19.145 n/a -10.893 -0.125 -7.028 1.866
z 4.753 16.253 -0.010 -11.501 -11.501 -2.085 -2.085

*Top of IMU is RP (Reference Pt)

Vessel Offsets for S220_8111 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf

Calculations
Coord. Sys.
Westlake IMU easting 0.000 Port easting -35.739 IMU Base to baseline at Keel Port easting -35.739 IMU easting 0.000 IMU to Bulkhd (Frame) 52 IMU Base to baseline at Keel

Base northing 0.000 Ant northing -0.409 (ft) elevation 12.856 Ant northing -0.409 Base northing 0.000 (ft) easting -11.638 (ft) elevation 12.856
(ft/m) elevation 0.000 (ft) elevation -38.283 IMU Base to baseline at Keel (ft) elevation -38.283 (ft/m) elevation 0.000 (m) easting -3.547 (m) elevation 3.919

(m) elevation 3.919
8111 easting 27.072 8111 easting 27.072 Stbd easting -35.866 Port easting -35.739 Frame 0 (FP) to Frame 52 Top of IMU to Base of IMU

(ft) northing 9.410 (ft) northing 9.410 Waterline to Keel Ant northing 12.925 Ant northing -0.409 (m) easting -27.737 (m) elevation 0.168
elevation 15.042 elevation 15.042 (ft) elevation 13.375 (ft) elevation -38.209 (ft) elevation -38.283 Top of IMU to Keel

Waterline to Keel IMU to Frame 0 (FP) (m) elevation 4.087
8111 easting 8.252 Port Ant to 8111 (m) elevation 4.077 Port easting -10.893 (m) easting 24.1898

(m) northing 2.868 (ft) easting 62.811 Ant northing -0.125 Center of Gravity above baseline
elevation 4.585 northing 9.819 Top of IMU to Base of IMU (m) elevation -11.669 Heave Pt* to Frame 0 (FP) (ft) elevation 16.37

elevation 53.325 (m) elevation 0.168 (ft) easting 102.42 Mean Metacentric height
Base of IMU to Top of IMU Top of IMU to Keel Base of IMU to Top of IMU (m) easting 31.218 (ft) elevation 3.88
  (inverse of measured value) (m) 4.087   (inverse of measured value)

(m) elevation -0.168 (m) elevation -0.168 IMU to Centerline Heave Pt* to baseline at Keel
(ft) northing 6.122 (ft) elevation 20.25
(m) northing 1.866 (m) elevation 6.172

Heave Pt* to Centerline (*Heave Pt is Metacenter)
(m) northing 0 (FP is Forward Perpendicular)

(m) easting 8.252 (m) easting 19.145 (m) easting N/A (m) easting -10.893 (m) easting -7.0282
Top of IMU northing 2.868 northing 2.993 Waterline northing N/A Scalar Distance (ft) 13.335 Top of IMU northing -0.125 Top of IMU northing 1.866
 to 8111 elevation 4.753 elevation 16.253  to IMU elevation -0.010  to Port Ant elevation -11.501 to Heave Pt* elevation -2.085

Coord Sys. CARIS Coord Sys. CARIS Coord. Sys.CARIS Coord Sys. Pos/Mv Coord. Sys. Pos/Mv
x 2.868 x 2.993 x N/A Scalar Distance (m) 4.064 x -10.893 x -7.028
y 8.252 y 19.145 y N/A y -0.125 y 1.866
z 4.753 z 16.253 z -0.010 z -11.501 z -2.085

see Description Tab see Description Tab

IMU to Port Ant IMU to HeaveIMU to 8111 Port Ant to Stbd AntPort Ant to 8111 Waterline to RP*

IMU to 8111 (MRU to Trans)

IMU to 8111

Port Ant to 8111 (Nav to Trans)

Port Ant to 8111

IMU to Heave

IMU to HeaveWaterline to RP*

Waterline to RP* Port Ant to Stbd Ant

Port Ant to Stbd Ant IMU to Port Ant

IMU to Port Ant

2006 Measured Values



S220_8160 Measurements

Measurement
Coord. Sys. Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.493 -0.684 n/a Scaler Distance 1.995 1.177 -11.920 1.866 -7.028
y 7.665 19.585 n/a -11.920 1.177 -7.028 1.866
z 4.726 17.730 -0.002 -13.004 -13.004 -2.086 -2.086

*Top of IMU is RP (Reference Pt)

Derivations
Coord. Sys.

Westlake NGS
IMU easting 0.000 Port easting -11.920
Base northing 0.000 Ant northing 1.177

(ft/m) elevation 0.000 (m) elevation -13.004
Westlake Westlake
8160 easting 25.149 8160 easting 7.665

(ft) northing 1.619 (m) northing 0.493
elevation 14.956 elevation 4.559

Westlake NGS
8160 easting 7.665 8160 (as calculated)

(m) northing 0.493 (m) easting 7.665
elevation 4.559 northing 0.493

elevation 4.726
Base of IMU to Top of IMU

(m) elevation -0.168

(m) easting 7.665 (m) easting 19.585
Top of IMU northing 0.493 northing -0.684
 to 8160 elevation 4.726 elevation 17.730

Coord Sys Caris Coord Sys Caris
x 0.493 x -0.684
y 7.665 y 19.585
z 4.726 z 17.730

Port Ant to 8160

IMU to Port Ant

IMU to 8160

IMU to 8160 (MRU to Trans)

IMU to 8160

Port Ant to 8160 (Nav to Trans)

Port Ant to 8160

IMU to HeavePort Ant to Stbd AntWaterline to RP*

Vessel Offsets for S220_8111 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf
and Fairweather_NGS_Report_Feb_2007.doc



S220 Offset Descriptions

Description of Offsets for FAIRWEATHER S-220
All Values Shown are in CARIS Coordinates

IMU to Port Antenna
x: -0.125
y: -10.893
z: -11.501

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.085

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000

IMU to Seabat 8111
x: 2.868
y: 8.252
z: 4.753

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.727

Port Antenna to 8160
x: 0.618
y: 18.559
z: 16.227

Port Antenna to 8111
x: 2.993
y: 19.145
z: 16.253



S220 Offset Descriptions

Scaler Distance 4.064

IMU to Port Antenna
x: -0.125
y: -10.893
z: -11.501

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.085

Port Antenna to 8160
x: 0.618
y: 18.559
z: 16.227
Port Antenna to 8111
x: 2.993
y: 19.145
z: 16.253

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.727

IMU to Seabat 8111
x: 2.868
y: 8.252
z: 4.753

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000



S220 Offset Descriptions

x y z x y z
2.868 8.252 4.753 0.493 7.665 4.727

x y z x y z
2.993 19.145 16.253 0.618 18.559 16.227

IMU to 8111 (MRU to Trans)

Port Ant to 8111 (Nav to Trans)

IMU to 8160 (MRU to Trans)

The lever arms between the IMU 
and phase center of the 8111 
transducer are taken from the 
Westlake report with the addition 
of the 0.168 m offset included for 
the height of the IMU.

Port Ant to 8160 (Nav to Trans)

The lever arms between the IMU 
and phase center of the 8160 
transducer are taken from the 
Westlake report with the addition 
of the 0.168 m offset included for 
the height of the IMU.

This information comes directly 
from the Westlake survey.

This information comes directly 
from the Westlake survey.



S220 Offset Descriptions

x y z
Scaler Distance 4.064 -0.125 -10.893 -11.501

x y z x y z From pg 3 of the Westlake Survey
n/a n/a -0.010 1.866 -7.028 -2.085

Waterline to RP*

The height of the IMU above the 
keel comes from the Westlake 
survey value of 3.919 m plus the 
measured value of the top of the 
IMU to the base plate, to get an 
IMU height above the keel.  The 
draft (waterline to keel) used for 
the FAIRWEATHER is based on 
repeated observations.  
Differencing the value of IMU to 
keel and waterline to keel gives 
the waterline to RP value.  

Key points on the IMU, from the 
Westlake survey, are its location 
with respect to the ship’s 
reference frame.  It is 4.087 m 
(3.919 m to base line + 0.168 m 
for IMU height above base plate) 
above the keel, 1.866 m port of 
centerline and 3.547 m forward of 
frame 52.  This information is 
needed to reference the IMU to 
the ship’s Heave Measurement 
Location (Heave Point). *

IMU to Port Ant

IMU to Heave

Port Ant to Stbd Ant

From the Westlake survey it was 
determined that the vector for 
antenna separation was 4.064 m. 

This information comes directly 
from the Westlake survey.

IMU to Heave



S220 Offset Descriptions

IMU to Heave

Referencing the metacenter (Heave Point, HP) to the IMU information requires information about the frame spacing of the vessel.  From 
the Westlake survey, the IMU is located 3.547 m forward of frame 52.  From Inclination document, the HP is 31.217 m aft of the forward 
perpendicular.  From engineering drawings of the ship frame spacing is approximately 21 inches.  The calculation for the longitudinal 
location of the HP with respect to frame zero, the Forward Perpendicular (FP) is as follows:

52 (frame) * 21 (inches/frame)/12(inches/ft)*.3048(m/ft)-3.547 m = 24.190 m from frame 0.

31.217 m (HP aft of FP) – 24.190 m (IMU aft of FP) =  7.027 m (HP aft of IMU)

The calculation for the vertical separation between the IMU and the HP is based on the height of the metacenter being 6.172m and the 
height of the IMU being 4.087 m above the keel.  Differencing yields the metacenter being 2.085 m above the IMU.

The calculation for the athwartship separation is based upon the assumption that the HP is on the centerline and the knowledge that the 
IMU is 1.866 m to port of the centerline.

* From the Art Anderson inclination experiment the position of the metacenter was used as the position of the ship’s Heave Point. (There 
may be a better way to determine the Heave Point, but this decision was based upon available information).  The metacenter is defined by 
the center of buoyancy.  As a vessel inclines through small angles, the center of buoyancy moves through the arc of a circle whose center 
is at the metacenter.  

Important numbers and information determined from the Art Anderson report are the location of the metacenter and how it is positioned 
with respect to the vessel.  The longitudinal location of the metacenter is defined as 102.42 feet (31.217 m) aft of the forward 
perpendicular.  The height of the metacenter is 20.25 feet (6.172 m) above the keel.  There is an assumption of the metacenter being on 
the centerline of the vessel.  Similar values for the RAINIER’s metacenter are 32.52 m aft of the forward perpendicular and 5.2 m above 
the keel.  The difference in the height of the metacenter can be attributed to the difference between the FA’s and RA’s average draft which 
is 13.12 feet as opposed to approximately 14.5 feet respectively.



S220 Offset Descriptions

Sources

On September 23, 2003 an offset survey of the NOAA Ship FAIRWEATHER was conducted by:

Westlake Consultants, Incorporated
15115 SW Sequoia Parkway, Suite 150
Tigard, Oregon 97224
Phone (503) 684-0652

On July 16, 2004 an inclination experiment was conducted at MOC-P by:

Art Anderson Associates
202 Pacific Avenue
Bremerton, WA  98337-1932

Calculations

As a requirement for the TPE, the standard deviation for each position is 3 mm.  This value is based upon a conversation with 
Elaine McDonald of Westlake and is followed up by an Email documenting that fact.  The email is located at the end of this 
document.

Offset values for the ship were derived from three sources.  A static offset survey, an inclination experiment, and values measured or 
approximated by ship’s personnel.

These values relate the physical positions of one sensor to the next with the base plate of the IMU being the point of origin.  
All dimensions in the document are given in feet and decimal feet.  

The values for the required lever arms are listed in the S220_Offsets and Measurements spreadsheet.  The reference point and 
the IMU are identical.  Difference in documentation between Westlake and FA calculations are based off of measuring up from 
the IMU base (Westlake’s origin) and the top of the IMU.  The top center of the IMU for the POS/MV is the defined origin for 
the POS/MV and the origin that is being used on all FAIRWEATHER vessels.  The distance from the base plate to the top of 
the IMU is 0.168 m, a value measured by ship’s complement.  Conversions factor from feet to meters is 0.3048 m/ft.



Westlake Coord Sys



POS_MV Coord Sys



CARIS Coord Sys



Westlake Consultants, Inc.
9/23/2003

Definitions and Basis for Dimensions/Locations

Northings 

Northings (Port - Starboard) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are starboard of the IMU.
Negative values are port of the IMU.
Calculated values are in italics.

Eastings 

Eastings (Stern to Bow ) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are forward of the IMU. 
Negative values are aft of the IMU.
Calculated values are in italics.

Elevations  

Elevations are with reference to the IMU Foundation Plate centerline scribe = 0 elevation. 
Positive values are below the IMU (toward the keel).
Negative values are toward the topside.

Dimensions 

All dimensions are in feet and decimal feet. All dimensions provided are "offsets" to IMU centerline.

Ship's Centerline Data 

At project initiation, control was established to define the ship's centerline 
as a plane running from a point on the centerline of the keel at the stern through a 
point on the centerline of the keel near the bow, to a point on the bow splitting the bow chock. 

IMU Referenced Data - Procedure
All data was originally referenced to the ship's geometry. 
Following location of the IMU, data was transformed to the IMU as point of origin for 
Northings, Eastings, and Elevation. All dimensions provided with reference to the IMU are "offsets."
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Westlake Consultants, Inc.
9/23/2003

Ship's Centerline - Control Measurements 
(Prior to location of IMU and referencing of data to IMU as point of origin (0,0,0)

Defined by measurements at the keel centerline 
longitude transverse elevation

near the bow 1190.674 1000.000 135.8672
at the stern (point of origin) 1000.000 1000.000 100.0000
along the keel (approx 180' forward) 1180.121 1000.000 116.6810

Ship's Baseline

Defined by measurements on the keel 
longitude transverse elevation

at the stern (point of origin) 1000.000 1000.000 100.0000
and approx. 129' forward of stern 1129.120 999.985 100.0022
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Westlake Consultants, Inc.
9/23/2003

IMU Foundation Plate
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines 
on IMU foundation plate 0.001

0.000

Scribed lines - intersection/centerline of IMU plate
0.000 0.000 0.000

Elevation checks near four corners of IMU Foundation plate *
0.001

-0.001
0.000

-0.001

SUMMARY 
•  IMU foundation plate is level to within +/-0.001 feet.
•  IMU foundation plate is located 12.856 feet above baseline established at the keel.
•  IMU is parallel to ship's centerline to within +/- 0.001 feet.

Location of scribed centerline intersection is 6.122 feet port of ship's centerline.
•  IMU foundation plate centerline is located 11.638' feet forward of bulkhead 52. 

* elevation check adjusted for target 
that created 10 mm offset =.03281 

feet
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Westlake Consultants, Inc.
9/23/2003

Granite Block 
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines
1.584
1.583

Scribed lines - intersection/centerline of granite block 
-0.003 1.583

Deviation
Elevation checks near four corners of granite block from level

-0.217 -0.001
-0.217 -0.001
-0.216 0.001
-0.215 0.001

SUMMARY 
•  Granite block is level to within +/-0.001 foot 

of average elevation = -0.21632 feet
•  Granite block is parallel to ship's centerline to within  0.001 foot 

Location is  4.54 feet to port of ship's centerline and 1.583 feet starboard of IMU.
•  Granite block is aligned with IMU to within 0.003 feet longitudinally. 

* elevation check adjusted for target that created 10 
mm offset = 0.03281 feet
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Westlake Consultants, Inc.
9/23/2003

Array Acoustical Centers - Referenced to IMU 

EASTING NORTHING ELEVATION

PORT ARRAY (81-60) 25.149 1.619 14.956

Explanation of Calculations
Acoustic center is defined as the center of the transmitter array with the 
elevation = 83 mm below mounting face of array.

Easting
Center of array is defined by the foundation plate bolt centerlines (1/2 distance between bolts)

27.008 Forward edge of foundation as measured 
- 0.104 Forward edge of foundation to centerline of forward bolt hole
- 1.755 Distance from bolt hole centerline to center of array 
25.149 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the foundation. 

1.369 Port edge of foundation  as measured 
+ 0.078 Port edge of foundation to centerline of bolt hole - per Cascade General 
 + 0.172 Distance from bolt hole centerline to array center 

1.619 feet starboard of IMU

Elevation 
Per Reson drawing 2148M011_001  the elevation is 83 mm below array mounting surface

14.679 Array foundation elevation as measured. 
  0.005 Isolation "shim" added between foundation and array 
  0.272 83 mm below array mounting surface to acoustical center 
14.956 feet below IMU 
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Westlake Consultants, Inc.
9/23/2003

Array Acoustical Centers - Referenced to IMU 
EASTING NORTHING ELEVATION

STARBOARD ARRAY (81-11) 27.072 9.41 15.042

Explanation of Calculations
Acoustic center is defined as midpoint of the transmitter array in the longitudinal and transverse axes. 
The elevation is defined as the center of the receiving array. 

Easting
Center of array is defined as 0.235' aft of the forward bolt centerlines on transmitter array foundation

28.563 Forward edge of foundation fixture plate as measured (receiving plate forward edge)
27.349 Forward edge of transmitter array foundation as calculated 

 - 0.042 Forward edge of foundation to centerline of forward bolt hole - per design
 - 0.235 Distance from bolt hole centerline to center of array - per design
27.072 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the transmitter array foundation.

9.410 Centerline of array foundation as measured on scribe - aft section of fixture plate
9.410 feet starboard of IMU

Elevation 
Elevation is 0.401 feet above receiver array mounting surface

16.085 Mounting foundation fixture plate as measured. 
15.447 Receiver foundation elevation - as calculated 

 + 0.005 Isolation "shim" added between foundation and array 
 - 0.410 Design distance from mounting surface of array to acoustic center 
15.042 feet below IMU 
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Westlake Consultants, Inc.
9/23/2003

Longitudinal Array Foundation - Port Side 
EASTING NORTHING ELEVATION

Horizontal alignment measured  at port edge of array foundation
1.369
1.369

Forward edge of array foundation - measured
27.008

Horizontal alignment - calculated  to array centerline 
1.619
1.619

deviation from 
Elevation checks near four corners of array foundation level (average)

14.680 0.001
14.681 0.002
14.678 -0.001
14.677 -0.002

SUMMARY 
•  Port longitudinal array foundation average elevation is 14.679 feet.

Variation in elevation is +0.002 to -0.002 feet.
•  Port longitudinal array foundation is parallel to ship's centerline and 1.369 feet starboard of IMU.

Calculated array centerline is 1.619 feet starboard of IMU 

Foundation edge is 0.25 feet port of 
array centerline
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Westlake Consultants, Inc.
9/23/2003

Longitudinal Array Foundation - Starboard Side 
EASTING NORTHING ELEVATION deviation from 

Horizontal alignment measured  on fixture plate scribe - parallel
9.410 0.002
9.406 -0.002

Forward edge of array foundation fixture plate - measured
28.563

deviation from
Elevation checks near four corners of array foundation "fixture plate" average

16.085 0.000
16.085 0.000
16.084 0.000
16.085 0.000

Calculated locations of longitudinal and transverse array foundations
Forward edge
Receiver (transverse) 28.563
Transmitter (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Calculated elevation of longitudinal and transverse array foundations
Receiver/Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263

SUMMARY 
•  Starboard longitudinal array foundation (measured at fixture plate) average elevation is 16.085 feet.

Deviation from level (average elevation) is less than 0.001 feet. 
•  Starboard longitudinal array foundation averages 9.408 feet starboard of IMU.

Variation from parallel is from -0.002  feet to +0.002 feet from average. 
•  Starboard longitudinal array foundation forward edge is 28.563 feet forward of IMU. 

Design location is 3.292 feet 
starboard of ship centerline 
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Westlake Consultants, Inc.
9/23/2003

Transverse Array Foundation - Port Side
EASTING NORTHING ELEVATION

Forward Edge - Transverse array foundation - measured
28.343
28.338

Port edge - Transverse array - measured
-0.181

Centerline of array - calculated  
28.093
28.088

Port edge of foundation plus 1.806 feet 1.624
to calculated array centerline 

deviation from 
Elevation checks near four corners of array foundation level

14.679 0.002
14.675 -0.001
14.675 -0.001
14.677 0.001

SUMMARY 
•  Transverse array foundation average measured elevation is 14.677 feet 

below IMU (0.006 feet above design location).
Deviation from level (average elevation) is 0.003 to -0.001 feet

•  Transverse array foundation centerline (calculated) averages 28.090 feet forward of IMU.
Variation from parallel to ship's centerline is from -0.003 to 0.003 feet (from average). 

•  Transverse array centerline is calculated to be 1.624 feet starboard of IMU. 

Foundation forward edge minus        
0.25 feet to array centerline

0.861 feet below baseline with 0.965 
foot offset = 98.180 feet average 
elevation
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Westlake Consultants, Inc.
9/23/2003

Transverse Array Foundation - Starboard Side

NOTE: Direct Measurements were not taken to the transverse array because a single "fixture plate" covered bo
transmitter and receiver foundations. The data provided here is primarily "calculated".

EASTING NORTHING ELEVATION

Forward edge - as measured on fixture plate
Receiver - (transverse) 28.563

as measured 
Transmitter  (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Horizontal Alignment 9.406
centerline scribe on fixture plate 
as measured - forward portion of plate
(near receiver array)
Average of measurements on fixture plate 9.408

Elevation of longitudinal and transverse array foundations
Receiver/Transducer Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263
Based on measured elevations averaging 16.085 feet across fixture plate

SUMMARY
•  Transverse array foundation is calculated to be 15.446 feet below IMU - calculated from measured elevation 

of 16.085 feet.  Deviation in elevation measurements across the  array fixture plate is less than 0.001 fe
•  Transverse array foundation forward edge (measured) is 28.563 feet forward of IMU.
•  Transverse array centerline is measured to be 9.406 feet starboard of IMU. 

Variation from parallel of the fixture plate across entire starboard array is ± 0.002  feet (from average). 
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Westlake Consultants, Inc.
9/23/2003

Antennae
EASTING NORTHING ELEVATION

Stbd POS MV Antenna -Location -35.866 12.925 -38.209
Port POS MV Antenna - Location -35.739 -0.409 -38.283

Foundation Plate Stack Antenna Alignment 7.677
Foundation Plate Stack Antenna Alignment 7.677

Port GYRO Foundation Plate Alignment 2.411
Port GYRO Foundation Plate Alignment 2.411

Stbd GYRO Foundation Plate Alignment 3.866
Stbd GYRO Foundation Plate Alignment 3.867

SUMMARY
•  Foundation plate stack antenna alignment is parallel to ship's centerline.
•  Port GYRO Foundation Plate is aligned parallel to ship's centerline.
•  Starboard GYRO Foundation Plate is aligned parallel to ship's centerline.
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Email regarding Standard Deviation of Westlake Survey 
 
Subject: Precision of Measurements - NOAA Fairweather (1109-11 and 12) 
Date: Thu, 12 Aug 2004 12:06:45 -0700 
From: "Elaine McDonald" <emcdonald@westlakeconsultants.com> 
To: <mark.wetzler@noaa.gov> 
CC: "Derek Colclough" <dcolclough@westlakeconsultants.com>, 
     "Mike Hargrave" <mhargrave@westlakeconsultants.com>, 
     "Judi Haney" <jhaney@westlakeconsultants.com>, 
      
Greetings Mark - 
 
As promised I am writing to document our conversation of late yesterday afternoon 
regarding the reliability of measurements on the NOAA Fairweather. 
 
We discussed your question here at Westlake and possible interpretations. 
 
We believe the you can comfortably use plus/minus 3 mm as the standard error of any 
given distance between 2 measured/located points on the vessel. We are confident that 
given the same circumstances, were we to repeat the measurements, our inter-point 
distances would be within plus/minus 3 mm of data reported (standard error). 
 
If the measurements were taken from a single instrument set up within a 
fairly close range the distance would be reliable to nearly plus/minus 1 mm.  
However, we had to take many measurements from a number of setups around, on, and 
inside the vessel, and we then tied all of these measurements to a common coordinate 
system. Consequently, it is not realistic to expect a 1 mm error. 
 
As we discussed yesterday, there are many other factors that will impact the location 
of each point and, consequently, the distance between two or more points. 
Temperature, sun light, deformation of the vessel when it is in and out of the water, 
movement of the drydock, settlement, definition of the actual point to be measured 
relative to the identified structure etc. all impact the reliability or repeatability 
of measurements. 
 
Nonetheless we appear to be in agreement that the 3 mm value will work in your 
software without introducing significant, additional variability. 
 
If you have questions or require additional information, please give me a call - or 
email. 
 
Best wishes, 
 
Elaine for Derek Colclough, Director, Industrial Measurement Division 
 
Elaine McDonald 
Director of Marketing 
Westlake Consultants, Inc. 
15115 SW Sequoia Parkway (150) 
Tigard, Oregon  97224 
 
phone    503-684-0652 
fax        503-624-0157 
toll-free  800-523-8750 
email     emcdonald@westlakeconsultants.com 
 
We invite you to visit our website  www.westlakeconsultants.com 
 
 
 



 











FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

3/29/2007
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

3/29/2007
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename
Append to Copy files to 

Batch # BOT Files (botXXX.???-???) Day SV Filename day SV file network
1
2

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

POS MV version 4

Nichols Passage

S220 8111

S220

088

8111

29 March 2007

088

TH_S220_088

Sunny, near calm seasNichols Passage



ROLL
SV Cast # Heading Speed (kts) Remarks

PITCH
SV Cast # Heading Speed (kts) Remarks

359 3.9
179 4.3
359 4.0
168 4.0

HEADING/YAW
SV Cast # Heading Speed (kts) Remarks

359 4.1
179 5.1
179 4.3
359 4.0

NAV TIME LATENCY
SV Cast # Heading Speed (kts) RemarksXTF Line Filename

Good line

18m shoal observed

Good line
Good line

HEADING1
XTF Line Filename

XTF Line Filename
PITCH1
PITCH2
PITCH3
PITCH4

HEADING2
HEADING3
HEADING4

XTF Line Filename



Processing Log

4/2/2007
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Froelich092

Data converted --> HDCS_Data in CARIS

Trueheave file was corrupted -- not applied to calibration lines

patch_test.zdf

9450460.tid

Testing_s220_088.svp

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.70 -0.10 -0.40
0.00 -0.55 0.00 -0.40
0.00 -0.50 0.05 -0.30

-0.60 -0.04 -0.40

0.00 -0.59 -0.02 -0.38
0.00 0.09 0.06 0.05
0.00 -0.59 -0.02 -0.38

Resulting HVF File Name

MRU Align StdDev gyro 0.05 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.11 Value from sum of squares standard deviations of pitch and roll offset v

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 14-Apr-07

FA_S220_Reson8101.hvf

Group AverageFinal Values based on

Averages
Standard Deviation

FINAL VALUES

Brown
Johnston

gonsalves

PATCH TEST RESULTS/CORRECTORS

Froelich
Gonsalves



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/16/2007
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/16/2007
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

ROLL
SV Cast # Heading Speed (kts) RemarksXTF Line Filename

106

TH_s220_106_2.000 (use for pitch lines); TH_8160_106_3 (use for heading)

S220 8160

Froelich, Martin, CO, Gonsalves, French

French, Froelich, Gonsalves, Mills

Hull mount

106

Reson 8160

Use pitch lines…

Ernest Sound

65 Fathoms

CalmErnest Sound



PITCH
SV Cast # Heading Speed (kts) Remarks
bot_106.001 207 5.5

032 4.8
207 5.6
035 4.7

HEADING/YAW
SV Cast # Heading Speed (kts) Remarks
bot_106.001 210 5.7

029 4.8
211 5.7
029 4.8
211 5.7

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

Processing Log

4/18/2007
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

XTF Line Filename

XTF Line Filename

XTF Line Filename
PITCH1
PITCH2
PITCH3
PITCH4

TH_s220_106_2 and TH_8160_106_3

O119FA2007CORP.zdf

predicted - 09450460.tid

bot_106_8160.svp

HEADING1 missed the target - do not use

Computer crashed near end of line.

HEADING2
HEADING3
HEADING4
HEADING5

may have been too far from target

operator error, I may have blown out near the target (of all places)

Data converted --> HDCS_Data in CARIS

Brown, Johnston, Gonsalves, Froelich108



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.30 -0.06 -0.15
0.00 -0.26 -0.03 0.35
0.00 -0.28 -0.06 0.30
0.00 -0.31 -0.02 -0.11

0.00 -0.29 -0.04 0.10
0.00 0.02 0.02 0.26
0.00 -0.29 -0.04 0.10

Resulting HVF File Name

MRU Align StdDev gyro 0.26 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.03 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 19-Apr-07FA_S220_Reson8160_5to750

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

keb
blj

Final Values based on

Averages
Standard Deviation

FINAL VALUES

mog
gdf

FA_S220_Reson8160_5to750 and …1000to1500 and …1750to5000

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

group average



RPM/Pitch Speed (m/s) Speed (knots) mog-Ave bj-Ave kb-Ave Std. Dev.
0 0 0 0 0 0 0

145/40% 2.07 4 -0.064982971 -0.013021726 -0.018728741 0.028495599
150/40% 2.89 5.6 -0.01867823 0.001391433 0.022948255 0.02081767
150/80% 4.29 8.3 -0.019780177 0.001593794 0.086367291 0.056140712
150/90% 5.35 10.35 0.132309505 0.045112313 0.247795069 0.101669862

155/100% 6.10 11.8 0.195134109 0.02426495 0.258779328 0.121273779
185/100% 7.13 13.8 0.241202363 0.09212141 0.361192291 0.134797288

S220 - Stop#1 DDSSM
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Average 8160 Depth
0 0 Heave to 8111(m) 15.28

-0.032244479 -0.0310205 Heave to 8160(m) 14.7
0.001887152 0.00181552 Lever arm ratio 0.962042
0.022726969 0.0218643
0.141738962 0.13635882
0.159392796 0.15334255
0.231505354 0.22271785

Blue cells used in computation of Delta Draft 
StDev used in TPE

Ave Stdev 0.059543

S220-8111 DDSSM
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Ship: FAIRWEATHER Vessel: S220
Date: 3/29/2007 Dn: 088
Personnel: Lewis, Evans, Mills, Froelich

PCS Serial # IMU Serial # 292

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About) 3.3.2.2

POS Version (Use Menu View > Statistics) Version 4
GPS Receivers

Primary Receiver BD950 SN:4611A66708 v.00211

Secondary Receiver BD950 SN:4602A62806 v.00211

Calibration area
Location:
Approximate Position: Lat 55 14 26

Lon 131 38 31
DGPS Beacon Station: Annette Island
Frequency: 323

Satellite Constellation (Use View> GPS Data)

Primary GPS
Sketch general SV configuration Note any differences from Primary GPS Receiver

N
HDOP HDOP

VDOP VDOP

Sattelites in use: Sattelites in use:
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 1.904 (Use View> GAMS Solution)

NOAA POS/MV Calibration Report

Nichols Passage

Secondary GPS

N

2411



POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Configuration Notes:

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 1810
End time: 1812
Heading accuracy achieved for calibration: 0.352

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

GAMS Status Online Yes
Save Settings Yes



Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: S220_032907_POSMV

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2

a) Heading rotation - apply a right-hand screw rotation θz about the z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the twice-rotated x-axis to align one frame with the other.

• The y-axis is perpendicular to the x-axis and points towards the right (starboard) side in the appropriate reference frame.

Apply the rotation in the following order to bring the two frames of reference into complete alignment:



COM3

COM4

COM5



SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



INSTALLATION Continued
Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)



Frame Control (Use Tools > Config)

GPS  Receiver Configuration 

Primary GPS  Receiver

Secondary GPS Receiver
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SeaBat 8111 Noise Analysis 

1.0 Overview 
 
For mid and deep water sonar systems, noise emanating from the vessel on which the sonar is 
mounted is a major determinant in the performance of the sonar.   In addition to sources such as 
echosounders and other acoustic devices, such as doppler logs, mechanical noise from the 
engines and drive trains, and flow noise will also affect performance, with the magnitude of the 
noise varying with vessel speed. 
 
This document describes the noise analysis test done on the RESON SeaBat 8111 installed on 
the NOAA S/V Fairweather, on 11 October 2004. 

2.0 Test Conduct 
 
The following is a description of the system setup and test protocol used to test the SeaBat 8111 
multibeam sonar. 

2.1 Sonar Setup 
 
To determine the amount of in-band noise seen by the sonar, the system was configured as 
follows: 

 
Setting Value 
Power Off 
Gain Manual Fixed 20 
Range  100 meters 

 
Data collection was done using a RESON engineering utility, which collects the full amplitude 
and phase time series data from the sonar.  Figure 1 shows a sample screen capture, in this case 
one of the data sets taken at six knots, with a shaft speed of 140 RPM.  At least ten (10) 
collections were done for each test case, and the results for first 10 measurements each test case 
were averaged for the report. 

2.2 Vessel Operation 
 
Normal survey speed for the vessel is approximately 10 knots.  To bracket this range, and to 
check at possible lower survey speeds, the test protocol was defined to cover the range of 2 to 12 
knots, in 2 knot steps.  The tests were conducted at shaft speeds of 120 to 170 RPM, in 10 RPM 
steps, with the speed adjusted by changing the pitch on the propellers.  For each RPM value, the 
speeds that could be achieved at that shaft speed were tested.  A log of data collections for the 
tests is provided in Appendix A. 
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All the underway data collections were done in water depths of 120 to 160 fathoms.  The zero 
speed data collections, with the engines on, were done at anchor in about 30 meters of water, and 
out in the bay, at water depths of about 130 fathoms. 
 

 
Figure 1 - Snapshot Utility Screen Capture 

2.3 Data Analysis 
 
The data from each of the test cases were collated in an Excel spreadsheet, shown in Appendix 
B.  A graph of the measured noise levels, as a function of vessel speed and shaft RPM is shown 
in Figure 2.  The noise level is a unitless value that represents the average of all the amplitude 
samples, from all the beams for the sampled sonar ping.  This value represents a combination of 
the electrical noise in the sonar, and the response to all acoustic energy, within the bandwidth of 
the sonar, impinging on the receive array.   
 
For each the tests, the plot shows the noise level as a function of vessel speed.  Again, the tests 
were run at the speeds that could be achieved at the selected shaft RPM. 
 
In an effort to resolve the cause of the high noise levels at anchor seen in the 8160 tests, noise 
tests with the engines at idle (110 shaft RPM, 0 pitch) in both shallow and deep water.  In deeper 
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water, much lower noise levels were observed, apparently due to the greater attenuation of the 
noise from the various acoustic sources on the ship over the greater range. 
 

8111 Noise Analysis
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Figure 2 - Noise Plot 

3.0 Conclusions 
 

a. It appears that the best survey speed for the 8111, from a noise perspective, is in the 
range of 8 to 10 knots.  Both lower and higher speeds correlate with higher noise levels. 

b. It would be desirable to use shaft speeds of 140 RPM, or lower, to minimize the noise 
level seen by the sonar. 

c. Significantly increased levels of reverberation from acoustic sources on the vessel are 
seen in shallower water.  If this causes any degradation in the quality of the soundings in 
the 8111, increased power levels, higher than those recommended in the sonar settings 
guide, should be used to compensate. 



 

 

  
 

 
Fairweather 8111 Noise Analysis Report Page 4 of 6
 

Appendix A – Test Logs 
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Appendix B – Noise Analysis Spreadsheet 
 

 
 



Appendix IV 
 
 
Total Propagated Error (TPE) 
 

TPE Values 
 Standard Deviation 

  
 
 



Vessel FAIRWEATHER-S220 FAIRWEATHER-S220 1010 1018
Sonar System Reson 8111 Reson 8160 Reson 8101 Reson 8101

MRU to Trans X 2.868 0.493 0.247 0.286
MRU to Trans Y 8.252 7.665 -0.138 -0.141
MRU to Trans  Z 4.752 4.726 0.551 0.551
Nav to Trans X 1.691 -0.684 1.144 1.184
Nav to Trans Y 20.172 19.585 1.061 0.96
Nav to Trans Z 17.756 17.730 3.667 3.711
Trans Roll 0.00 0.00 0.00 0.00

Vessel FAIRWEATHER-S220 FAIRWEATHER-S220 1010 1018
Sonar System Reson 8111 Reson 8160 Reson 8101 Reson 8101

Status
Motion Gyro (deg) 0.02 0.02 0.02 0.02 Finalized
Heave% Amp 5 5 5 5 Finalized
Heave (m) 0.05 0.05 0.05 0.05 Finalized
Roll (deg) 0.02 0.02 0.02 0.02 Finalized
Pitch (deg) 0.02 0.02 0.02 0.02 Finalized
Position Nav (m) 0.5* 0.5 0.5 0.5 Finalized
Vessel Speed (m/s) 0.03 0.03 0.03 0.03 Finalized
Timing Trans (s) 0.005 0.005 0.005 0.005 Finalized
Nav Timing (s) 0.005 0.005 0.005 0.005 Finalized
Gyro Timing (s) 0.005 0.005 0.005 0.005 Finalized
Heave Timing (s) 0.005 0.005 0.005 0.005 Finalized
Pitch Timing (s) 0.005 0.005 0.005 0.005 Finalized
Roll Timing (s) 0.005 0.005 0.005 0.005 Finalized
Offset X (m) 0.007 0.007 0.007 0.007 Finalized
Offset Y (m) 0.007 0.007 0.007 0.007 Finalized
Offset Z (m) 0.008 0.008 0.007 0.007 Finalized
Loading 0.02 0.02 0.01 0.01 Finalized
Draft (m) 0.022 0.022 0.016 0.016 Finalized
DeltaDraft (m) 0.075 0.075 0.007 0.05 Finalized
MRU alignStdev gyro 0.05 0.26 0.10 0.09 Finalized
MRU align roll/pitch 0.11 0.03 0.13 0.06 Finalized
Tide Meas (m) 0.01 0.01 0.01 0.01 Project Dependent
Tide Zoning (m) 0.1 0.1 0.1 0.1 Project Dependent
SV Meas (m/s) 0.5 0.5 1.0 1.0 Finalized
Surface SV (m/s) 0.5 0.5 1.0 1.0 Finalized

*Position Nav adjusted in the HVF to 5m when acquiring in Coarse Acquisition mode, additional information will be submitted in the DAPR and/or the DR.

FAIRWEATHER SURVEY
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Appendix V 
 
 
Additional Calibration Reports 
 

Control 
 Ashtech 

• Positioning Equipment Confidence Check 
• OPUS solution 

 Tides 
• Kukkamakis 2006 
• Vertical Control Equipment Testing 

 Trimble 
• Positioning Equipment Confidence Check 
• OPUS solution 
• See SAND1.ssf attached in digital separates  

 
Diver Least Depth Gauge (DLDG) 

 See cal files attached in digital separates 
 
Laser Level 
 
Leadlines 
 
SV 

 MVP 
• Penetrometer 

 SBE 
• SBE 19plus 

- SBE 19plus 4585 
- SBE 19plus 4616 
- SBE 19plus 4617 

• SBE 45 TSG 
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FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check 
3/14/20073/14/20073/14/20073/14/20073/14/20073/14/20073/14/20073/14/20073/14/2007

USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37
Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1
Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2

Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016
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TR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-Bearing TR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-Bearing
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Ashtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observation

BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37



Subject: 
OPUS solution : USCG0732.07O 000106232 
From: 
opus@ngs.noaa.gov 
Date: 
Mon, 02 Apr 2007 12:07:31 -0400 (EDT) 
To: 
horcon.fairweather@noaa.gov 
 
 FILE: USCG0732.07O 000106232 
 
                              NGS OPUS SOLUTION REPORT 
                              ======================== 
 
      USER: horcon.fairweather@noaa.gov             DATE: April 02, 2007 
RINEX FILE: uscg073s.07o                            TIME: 16:07:30 UTC 
 
 
  SOFTWARE: page5  0612.06 master29.pl             START: 2007/03/14  18:06:00 
 EPHEMERIS: igs14183.eph [precise]                  STOP: 2007/03/14  20:36:00 
  NAV FILE: brdc0730.07n                        OBS USED:  6385 /  6511   :  98% 
  ANT NAME: ASH701975.01AGP NONE             # FIXED AMB:    30 /    32   :  94% 
ARP HEIGHT: 2.0                              OVERALL RMS: 0.018(m) 
 
 
 REF FRAME: NAD_83(CORS96)(EPOCH:2003.0000)            ITRF00 (EPOCH:2007.1995) 
       
         X:     -2415358.884(m)   0.013(m)          -2415359.692(m)   0.013(m) 
         Y:     -2718046.175(m)   0.012(m)          -2718045.070(m)   0.012(m) 
         Z:      5222559.312(m)   0.016(m)           5222559.510(m)   0.016(m) 
 
       LAT:   55 19 58.66133      0.010(m)        55 19 58.67266      0.010(m) 
     E LON:  228 22 28.18023      0.007(m)       228 22 28.10433      0.007(m) 
     W LON:  131 37 31.81977      0.007(m)       131 37 31.89567      0.007(m) 
    EL HGT:            3.781(m)   0.023(m)                 3.780(m)   0.023(m) 
 ORTHO HGT:            9.656(m)   0.034(m) [Geoid06 NAVD88] 
 
                        UTM COORDINATES    STATE PLANE COORDINATES 
                         UTM (Zone 09)         SPC (5001 AK 1) 
Northing (Y) [meters]     6134983.221                0.000 
Easting (X)  [meters]      333464.469                0.000 
Convergence  [degrees]    -2.15989540           0.00000000 
Point Scale                0.99994023           0.00000000 
Combined Factor            0.99993963           0.00000000 
 
US NATIONAL GRID DESIGNATOR:  9UUB3346434983(NAD 83) 
 
 
 
                              BASE STATIONS USED 
PID       DESIGNATION                        LATITUDE    LONGITUDE DISTANCE(m) 
AI5022 BIS1 BIORKA ISLAND 1 CORS ARP       N565116.162 W1353221.387  296620.8 
AJ4430 LEV1 LEVEL ISLAND 1 CORS ARP        N562756.438 W1330533.935  155968.5 
AF9530 AIS1 ANNETTE ISLAND 1 CORS ARP      N550408.647 W1313558.255   29425.1 
 
                 NEAREST NGS PUBLISHED CONTROL POINT 
AI4914      BM NO 37                       N551958.659 W1313731.820       0.0 



 
 
                                                    
                                                    
                          BASE STATION INFORMATION  
                                                    
 STATION NAME: bis1  a    5 (BIORKA ISLAND 1; Biorka Island, Alaska, U.S.A.) 
  ANTENNA: ASH700829.3     SNOW                             S/N=xxxx             
 XYZ  -2494921.0213  -2448390.9324   5317113.5289  MON @ 1997.0000 (M) 
 XYZ        -0.0164         0.0037         0.0005  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0877  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0598  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1673         0.0377         0.0051  VEL TIMES 10.1982 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0342        -0.0336         0.0734  ARP TO L1 PHASE CENTER 
 XYZ  -2494921.2228  -2448390.9283   5317113.6074  L1 PHS CEN @ 2007.1995 
 XYZ        -0.0001         0.0014         0.0005  + XYZ ADJUSTMENTS 
 XYZ  -2494921.2228  -2448390.9269   5317113.6080  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2494921.1886  -2448390.8933   5317113.5345  NEW ARP @ 2007.1995 
 XYZ  -2494921.1886  -2448390.8933   5317113.5345  NEW MON @ 2007.1995 
 LLH  56 51 16.17228  224 27 38.53267     66.6787  NEW L1 PHS CEN @ 2007.1995 
 LLH  56 51 16.17228  224 27 38.53267     66.5910  NEW ARP @ 2007.1995 
 LLH  56 51 16.17228  224 27 38.53267     66.5910  NEW MON @ 2007.1995 
 
 STATION NAME: lev1  a    8 (Level Island 1; Level Island, Alaska  USA) 
  ANTENNA: ASH700829.3     SNOW                             S/N=CG11936          
 XYZ  -2412828.4670  -2579056.1235   5293283.3535  MON @ 1997.0000 (M) 
 XYZ        -0.0190         0.0003        -0.0044  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0877  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0598  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1938         0.0031        -0.0449  VEL TIMES 10.1982 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0331        -0.0354         0.0731  ARP TO L1 PHASE CENTER 
 XYZ  -2412828.6939  -2579056.1558   5293283.3817  L1 PHS CEN @ 2007.1995 
 XYZ        -0.0002         0.0006         0.0002  + XYZ ADJUSTMENTS 
 XYZ  -2412828.6941  -2579056.1552   5293283.3819  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2412828.6610  -2579056.1198   5293283.3088  NEW ARP @ 2007.1995 
 XYZ  -2412828.6610  -2579056.1198   5293283.3088  NEW MON @ 2007.1995 
 LLH  56 27 56.44916  226 54 25.98578     25.2831  NEW L1 PHS CEN @ 2007.1995 
 LLH  56 27 56.44916  226 54 25.98578     25.1954  NEW ARP @ 2007.1995 
 LLH  56 27 56.44916  226 54 25.98578     25.1954  NEW MON @ 2007.1995 
 
 STATION NAME: ais1  a    7 (ANNETTE ISLAND 1; Annette Island, Alaska, U.S.A.) 
  ANTENNA: ASH700829.3     SNOW                             S/N=11276            
 XYZ  -2430153.7846  -2737192.8996   5205816.6147  MON @ 1997.0000 (M) 
 XYZ        -0.0151         0.0008        -0.0082  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0877  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0598  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1540         0.0082        -0.0836  VEL TIMES 10.1982 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0333        -0.0376         0.0719  ARP TO L1 PHASE CENTER 
 XYZ  -2430153.9719  -2737192.9290   5205816.6030  L1 PHS CEN @ 2007.1995 
 XYZ         0.0001        -0.0001        -0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2430153.9718  -2737192.9291   5205816.6030  NEW L1 PHS CEN @ 2007.1995 



 XYZ  -2430153.9385  -2737192.8915   5205816.5311  NEW ARP @ 2007.1995 
 XYZ  -2430153.9385  -2737192.8915   5205816.5311  NEW MON @ 2007.1995 
 LLH  55  4  8.65871  228 24  1.66998     32.2471  NEW L1 PHS CEN @ 2007.1995 
 LLH  55  4  8.65871  228 24  1.66998     32.1594  NEW ARP @ 2007.1995 
 LLH  55  4  8.65871  228 24  1.66998     32.1594  NEW MON @ 2007.1995 
 
                         REMOTE STATION INFORMATION 
                                                    
 STATION NAME: uscg       1 
  ANTENNA: ASH701975.01AGP NONE                             S/N=UNKNOWN          
 XYZ  -2415360.3793  -2718045.5588   5222561.1762  MON @ 2007.1993 (M) 
 NEU         0.0000        -0.0000         2.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0637  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0440  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.7557        -0.8504         1.6449  MON TO ARP 
 XYZ        -0.0241        -0.0271         0.0524  ARP TO L1 PHASE CENTER 
 XYZ  -2415361.1590  -2718046.4363   5222562.8735  L1 PHS CEN @ 2007.1995 
 
 BASELINE NAME:   bis1  uscg 
 XYZ         0.6817         0.4813        -1.6607  + XYZ ADJUSTMENTS 
 XYZ  -2415360.4774  -2718045.9549   5222561.2128  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2415360.4533  -2718045.9278   5222561.1604  NEW ARP @ 2007.1995 
 XYZ  -2415359.6976  -2718045.0775   5222559.5155  NEW MON @ 2007.1995 
 LLH  55 19 58.67251  228 22 28.10438      5.8533  NEW L1 PHS CEN @ 2007.1995 
 LLH  55 19 58.67251  228 22 28.10438      5.7896  NEW ARP @ 2007.1995 
 LLH  55 19 58.67251  228 22 28.10438      3.7896  NEW MON @ 2007.1995 
 
 BASELINE NAME:   lev1  uscg 
 XYZ         0.6864         0.4936        -1.6609  + XYZ ADJUSTMENTS 
 XYZ  -2415360.4727  -2718045.9427   5222561.2127  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2415360.4486  -2718045.9156   5222561.1603  NEW ARP @ 2007.1995 
 XYZ  -2415359.6929  -2718045.0652   5222559.5153  NEW MON @ 2007.1995 
 LLH  55 19 58.67284  228 22 28.10412      5.8462  NEW L1 PHS CEN @ 2007.1995 
 LLH  55 19 58.67284  228 22 28.10412      5.7825  NEW ARP @ 2007.1995 
 LLH  55 19 58.67284  228 22 28.10412      3.7825  NEW MON @ 2007.1995 
 
 BASELINE NAME:   ais1  uscg 
 XYZ         0.6951         0.4928        -1.6769  + XYZ ADJUSTMENTS 
 XYZ  -2415360.4639  -2718045.9435   5222561.1967  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2415360.4398  -2718045.9164   5222561.1443  NEW ARP @ 2007.1995 
 XYZ  -2415359.6842  -2718045.0660   5222559.4993  NEW MON @ 2007.1995 
 LLH  55 19 58.67268  228 22 28.10452      5.8300  NEW L1 PHS CEN @ 2007.1995 
 LLH  55 19 58.67268  228 22 28.10452      5.7663  NEW ARP @ 2007.1995 
 LLH  55 19 58.67268  228 22 28.10452      3.7663  NEW MON @ 2007.1995 
 
                                   G-FILES  
                                            
Axx2007 314   7 314 
B2007 31418 5   7 3142035 1 page5 v0612.06IGS     222 1 2 27NGS   2007 4 2IFDDFX 
Iant_info.003        NGS   20070320 
C00090001 -795614910   19 2696541842   21  945540190   39 X0737AUSCGX0737ABIS1 
D  1  2  7550588  1  3 -9307589  2  3 -7806480 
  
Axx2007 314   7 314 
B2007 31418 5   7 3142035 1 page5 v0612.06IGS     222 1 2 27NGS   2007 4 2IFDDFX 
Iant_info.003        NGS   20070320 
C00090002   25310319   17 1389889454   20  707237935   38 X0737AUSCGX0737ALEV1 



D  1  2  8189618  1  3 -9202066  2  3 -7448116 
  
Axx2007 314   7 314 
B2007 31418 5   7 3142035 1 page5 v0612.06IGS     222 1 2 27NGS   2007 4 2IFDDFX 
Iant_info.003        NGS   20070320 
C00090003 -147942543   19 -191478255   22 -167429683   36 X0737AUSCGX0737AAIS1 
D  1  2  9369495  1  3 -7883557  2  3 -7554607 
  
                   POST-FIT RMS BY SATELLITE VS. BASELINE 
                                                          
            OVERALL     03     06     07     10     16     18     19     21 
 bis1-uscg|  0.017  0.018  0.016  0.018  0.014  0.019  0.013  0.015    ... 
                22     24     25     26     29     30 
 bis1-uscg|  0.018  0.015    ...  0.022  0.019    ...                      
 
            OVERALL     03     06     07     10     16     18     19     21 
 lev1-uscg|  0.018  0.017  0.018  0.019  0.017  0.022  0.017  0.015    ... 
                22     24     26     29     30 
 lev1-uscg|  0.018  0.013  0.018  0.021    ...                             
 
            OVERALL     03     06     07     10     16     18     19     21 
 ais1-uscg|  0.018  0.020  0.018  0.018  0.012  0.022  0.016    ...    ... 
                22     24     26     29     30 
 ais1-uscg|  0.015  0.017  0.015  0.016    ...                             
 
                        OBS BY SATELLITE VS. BASELINE 
                                                      
            OVERALL     03     06     07     10     16     18     19     21 
 bis1-uscg|   2148    155    203    279    102    296    245     28    ... 
                22     24     25     26     29     30 
 bis1-uscg|    118    284    ...    200    238    ...                      
            OVERALL     03     06     07     10     16     18     19     21 
 lev1-uscg|   2087    155    182    225    106    296    247     28    ... 
                22     24     26     29     30 
 lev1-uscg|    117    284    200    247    ...                             
            OVERALL     03     06     07     10     16     18     19     21 
 ais1-uscg|   2150    152    207    284    105    295    239    ...    ... 
                22     24     26     29     30 
 ais1-uscg|    119    283    213    253    ...                             
                                            
 
 Covariance Matrix for the xyz OPUS Position (meters2). 
    0.0000022467     0.0000002159    -0.0000004052 
    0.0000002159     0.0000029444    -0.0000004008 
   -0.0000004052    -0.0000004008     0.0000094689 
 
 Covariance Matrix for the enu OPUS Position (meters2). 
    0.0000023402    -0.0000002845     0.0000001534 
   -0.0000002845     0.0000044782     0.0000029060 
    0.0000001534     0.0000029060     0.0000078416 
 
 Horizontal network accuracy =    0.00458 meters. 
 Vertical network accuracy   =    0.00549 meters. 
 
 
                       Derivation of NAD 83 vector components 
 



  
  Position of reference station ARP in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xa(m)           Ya(m)           Za(m) 
       BIS1  -2494920.37852  -2448391.99956   5317113.26406    2003.00 
       LEV1  -2412827.84636  -2579057.21856   5293283.07789    2003.00 
       AIS1  -2430153.14737  -2737194.00189   5205816.33593    2003.00 
  
  Position of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xr(m)           Yr(m)           Zr(m) 
       BIS1  -2494920.37852  -2448391.99956   5317113.26406    2003.00 
       LEV1  -2412827.84636  -2579057.21856   5293283.07789    2003.00 
       AIS1  -2430153.14737  -2737194.00189   5205816.33593    2003.00 
  
  Velocity of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Vx (m/yr)       Vy (m/yr)       Vz (m/yr) 
       BIS1         0.00490         0.00450         0.00990 
       LEV1         0.00220         0.00120         0.00480 
       AIS1         0.00580         0.00170         0.00110 
  
  Vectors from unknown station monument to reference station monument 
  in NAD_83(CORS96)(EPOCH:2003.0000). 
                Xr-X= DX(m)     Yr-Y= DY(m)     Zr-Z= DZ(m) 
       BIS1    -79561.49452    269654.17544     94553.95206    2003.00 
       LEV1      2531.03764    138988.95644     70723.76589    2003.00 
       AIS1    -14794.26337    -19147.82689    -16742.97607    2003.00 
 
This position and the above vector components were computed without any  
knowledge by the National Geodetic Survey regarding the equipment or  
field operating procedures used. 



Kukkamaki March 13 & 14, 2007 
 
On March 13, 2007 (Dn072) LTJG Lewis, ST Mills and ENS Morgan performed a 
Kukkamaki on both Carl Zeiss NI2 (stadia: 333) levels (S/N 103267 and S/N 100056). 
 
The Kukkamaki course was set up at the NOAA base in Ketchikan, AK in the early 
afternoon. The sky was overcast with occasional snow showers passing intermixed with 
occasional rain. A 40 meter straight line was set up on relatively level ground and divided 
into 10 meter intervals. The level was then set up on the 30 meter mark and a backsight 
and foresight were shot to the 20 and 40 meter marks respectively. Next, the level was 
set up at the 0 meter mark, and a backsight and foresight were shot to the 20 and 40 
meter marks, respectively. (See fig. 1)  
 
The Carl Zeiss level S/N 103267 had a collimation error of 0.0066, which is within 
tolerance.  The Carl Zeiss level S/N 100056 had a collimation error of -0.176, which is 
not within tolerance.  The kukkamaki was run 2 more times on that level and still did not 
pass within tolerance.  An adjustment was made to the level to calibrate it for the error 
recorded during the kukkamaki.  After the level S/N 100056 was re-calibrated, another 
kukkamaki was run on March 14, 2007 (Dn073) and the level was within tolerance with a 
collimation error of 0.02.  

 
Fig 1. Diagram of Kukkamaki setup. 

 



NOAA FORM 75-29 U.S. DEPARTMENT OF COMMERCE TIDE STATION NUMBER SHEET OF

(12-
75)

NATIONAL OCEANIC AND 
ATMOSPHERIC 

ADMINISTRATION

PRECISE LEVELING
FROM B.M. TO B.M.

THREE-WIRE Kukkamaki TIME DATE: DN 072, 13 March 2007

FORWARD RUN (See reverse for BACKWARD RUN)
WEATHER Overcast with snow showers

BACKSIGHTS FORESIGHTS ___3____ ORDER, CLASS ___1____

Setup
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
ROD 

TEMP
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
REMARKS

1558 BS1 1602 FS1 C = (Δh1 - Δ2) - 0.2mm
1 1543 1543 1588 1587.67 20 m

1528 1573                       where    BS1 - FS1 = Δh1
4629 4763                                   BS2 - FS2 = Δh2

1220 20mS 1295 40mS Δh1-         -44.67
2 1190 1190 1235 1235 Δh2          -45

1160 1175 Δh1-Δh2 = 0.33
3570 3705 - 0.2 (CR)    0.13

÷20m        0.00666667
C =     0.00666667

Fill in YELLOW shaded cells. "C" must be < + 0.05mm/m

Instrument SN:  103267
Rod SN: B
Party Chief: Beaver
Observer:  Mills
Recorder: Lewis
Rod Person:  Morgan



NOAA FORM 75-29 U.S. DEPARTMENT OF COMMERCE TIDE STATION NUMBER SHEET OF

(12-
75)

NATIONAL OCEANIC AND 
ATMOSPHERIC 

ADMINISTRATION

PRECISE LEVELING
FROM B.M. TO B.M.

THREE-WIRE Kukkamaki TIME DATE  DN 072, 13 March 2007

FORWARD RUN (See reverse for BACKWARD RUN)
WEATHER Overcast with snow showers

BACKSIGHTS FORESIGHTS ___3____ ORDER, CLASS ___1____

Setup
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
ROD 

TEMP
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
REMARKS

1588 BS1 1634 FS1 C = (Δh1 - Δ2) - 0.2mm
1 1573 1573.33 1618 1618.67 20 m

1559 1604                       where    BS1 - FS1 = Δh1
4720 4856                                   BS2 - FS2 = Δh2

1278 20mS 1350 40mS Δh1-         -45.33
2 1248 1248 1290 1290 Δh2          -42

1218 1230 Δh1-Δh2 = -3.33
3744 3870 - 0.2 (CR)    -3.53

÷20m        -0.17666667
C =     -0.17666667

Fill in YELLOW shaded cells. "C" must be < + 0.05mm/m

Instrument SN: 100056
Rod SN: B
Party Chief: Beaver
Observer:  Lewis
Recorder: Mills
Rod Person:  Morgan



NOAA FORM 75-29 U.S. DEPARTMENT OF COMMERCE TIDE STATION NUMBER SHEET OF

(12-
75)

NATIONAL OCEANIC AND 
ATMOSPHERIC 

ADMINISTRATION

PRECISE LEVELING
FROM B.M. TO B.M.

THREE-WIRE Kukkamaki TIME DATE  DN 072, 13 March 2007

FORWARD RUN (See reverse for BACKWARD RUN)
WEATHER Overcast with snow showers

BACKSIGHTS FORESIGHTS ___3____ ORDER, CLASS ___1____

Setup
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
ROD 

TEMP
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
REMARKS

1587 BS1 1631 FS1 C = (Δh1 - Δ2) - 0.2mm
1 1572 1572 1617 1616.33 20 m

1557 1601                       where    BS1 - FS1 = Δh1
4716 4849                                   BS2 - FS2 = Δh2

1307 20mS 1380 40mS Δh1-         -44.33
2 1277 1277 1320 1320 Δh2          -43

1247 1260 Δh1-Δh2 = -1.33
3831 3960 - 0.2 (CR)    -1.53

÷20m        -0.07666667
C =     -0.07666667

Fill in YELLOW shaded cells. "C" must be < + 0.05mm/m

Instrument SN: 100056
Rod SN: B
Party Chief: Beaver
Observer:  Lewis
Recorder: Mills
Rod Person:  Morgan



NOAA FORM 75-29 U.S. DEPARTMENT OF COMMERCE TIDE STATION NUMBER SHEET OF

(12-
75)

NATIONAL OCEANIC AND 
ATMOSPHERIC 

ADMINISTRATION

PRECISE LEVELING
FROM B.M. TO B.M.

THREE-WIRE Kukkamaki TIME DATE  DN 072, 13 March 2007

FORWARD RUN (See reverse for BACKWARD RUN)
WEATHER Overcast with snow showers

BACKSIGHTS FORESIGHTS ___3____ ORDER, CLASS ___1____

Setup
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
ROD 

TEMP
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
REMARKS

1585 BS1 1630 FS1 C = (Δh1 - Δ2) - 0.2mm
1 1570 1570 1615 1615 20 m

1555 1600                       where    BS1 - FS1 = Δh1
4710 4845                                   BS2 - FS2 = Δh2

1278 20mS 1350 40mS Δh1-         -45.00
2 1248 1248 1290 1290 Δh2          -42

1218 1230 Δh1-Δh2 = -3.00
3744 3870 - 0.2 (CR)    -3.20

÷20m        -0.16
C =     -0.16

Fill in YELLOW shaded cells. "C" must be < + 0.05mm/m

Instrument SN: 100056
Rod SN: B
Party Chief: Beaver
Observer:  Lewis
Recorder: Mills
Rod Person:  Morgan



NOAA FORM 75-29 U.S. DEPARTMENT OF COMMERCE TIDE STATION NUMBER SHEET OF

(12-
75)

NATIONAL OCEANIC AND 
ATMOSPHERIC 

ADMINISTRATION

PRECISE LEVELING
FROM B.M. TO B.M.

THREE-WIRE Kukkamaki TIME DATE  DN 072, 13 March 2007

FORWARD RUN (See reverse for BACKWARD RUN)
WEATHER Overcast with snow showers

BACKSIGHTS FORESIGHTS ___3____ ORDER, CLASS ___1____

Setup
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
ROD 

TEMP
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
REMARKS

1480 BS1 1700 FS1 C = (Δh1 - Δ2) - 0.2mm
1 1465 1465 1685 1685 20 m

1450 1670                       where    BS1 - FS1 = Δh1
4395 5055                                   BS2 - FS2 = Δh2

2210 20mS 2462 40mS Δh1-         -220.00
2 2180 2180 2402 2402 Δh2          -222

2150 2342 Δh1-Δh2 = 2.00
6540 7206 - 0.2 (CR)    1.80

÷20m        0.09
C =     0.09

Fill in YELLOW shaded cells. "C" must be < + 0.05mm/m

Instrument SN: 100056
Rod SN: B
Party Chief: Beaver
Observer:  Lewis
Recorder: Mills
Rod Person:  Morgan



NOAA FORM 75-29 U.S. DEPARTMENT OF COMMERCE TIDE STATION NUMBER SHEET OF

(12-
75)

NATIONAL OCEANIC AND 
ATMOSPHERIC 

ADMINISTRATION

PRECISE LEVELING
FROM B.M. TO B.M.

THREE-WIRE Kukkamaki TIME DATE  DN 072, 13 March 2007

FORWARD RUN (See reverse for BACKWARD RUN)
WEATHER Overcast with snow showers

BACKSIGHTS FORESIGHTS ___3____ ORDER, CLASS ___1____

Setup
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
ROD 

TEMP
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
REMARKS

1483 BS1 1705 FS1 C = (Δh1 - Δ2) - 0.2mm
1 1469 1468.67 1689 1689.33 20 m

1454 1674                       where    BS1 - FS1 = Δh1
4406 5068                                   BS2 - FS2 = Δh2

2234 20mS 2485 40mS Δh1-         -220.67
2 2204 2203.67 2425 2425 Δh2          -221.333333

2173 2365 Δh1-Δh2 = 0.67
6611 7275 - 0.2 (CR)    0.47

÷20m        0.02333333
C =     0.02333333

Fill in YELLOW shaded cells. "C" must be < + 0.05mm/m

Instrument SN: 100056
Rod SN: B
Party Chief: Beaver
Observer:  Lewis
Recorder: Mills
Rod Person:  Morgan



NOAA FORM 75-29 U.S. DEPARTMENT OF COMMERCE TIDE STATION NUMBER SHEET OF

(12-
75)

NATIONAL OCEANIC AND 
ATMOSPHERIC 

ADMINISTRATION

PRECISE LEVELING
FROM B.M. TO B.M.

THREE-WIRE Kukkamaki TIME DATE  DN 356, 2005

FORWARD RUN (See reverse for BACKWARD RUN)
WEATHER Overcast with occasional rain showers

BACKSIGHTS FORESIGHTS ___3____ ORDER, CLASS ___1____

Setup
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
ROD 

TEMP
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
REMARKS

1544 BS1 1538 FS1 C = (Δh1 - Δ2) - 0.2mm
1 1559 1559 1554 1553.67 20 m

1574 1569                       where    BS1 - FS1 = Δh1
4677 4661                                   BS2 - FS2 = Δh2

1584 20mS 1550 40mS Δh1-         5.33
2 1615 1614.67 1609 1609.67 Δh2          5

1645 1670 Δh1-Δh2 = 0.33
4844 4829 - 0.2 (CR)    0.13

÷20m        0.00666667
C =     0.00666667

Fill in YELLOW shaded cells. "C" must be < + 0.05mm/m

Instrument SN: 100056
Rod SN: B
Party Chief: Beaver
Observer:  Morgan
Recorder: Mills
Rod Person:  Lewis
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FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check 
3/14/20073/14/20073/14/20073/14/20073/14/20073/14/20073/14/20073/14/20073/14/2007

USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37
Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1Trimble Backpack Unit 1
Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2Trimble Backpack Unit 2

Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016Ashtech Z-Xtreme S/N 9016

vvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvv

TR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-BearingTR2 Distance-Bearing TR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-BearingTR1 Distance-Bearing

TR2 Double DistanceTR2 Double DistanceTR2 Double DistanceTR2 Double DistanceTR2 Double DistanceTR2 Double DistanceTR2 Double DistanceTR2 Double DistanceTR2 Double DistanceTR2 Double Distance

TR1 Double DistanceTR1 Double DistanceTR1 Double DistanceTR1 Double DistanceTR1 Double DistanceTR1 Double DistanceTR1 Double DistanceTR1 Double DistanceTR1 Double DistanceTR1 Double Distance

2.
5 

M
et

er
 R

in
g

5 
M

et
er

 R
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g

Ashtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observationAshtech Z-Xtreme 2.5 hour observation

BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37



Subject: 
OPUS solution : USCG0732.07O 000106232 
From: 
opus@ngs.noaa.gov 
Date: 
Mon, 02 Apr 2007 12:07:31 -0400 (EDT) 
To: 
horcon.fairweather@noaa.gov 
 
 FILE: USCG0732.07O 000106232 
 
                              NGS OPUS SOLUTION REPORT 
                              ======================== 
 
      USER: horcon.fairweather@noaa.gov             DATE: April 02, 2007 
RINEX FILE: uscg073s.07o                            TIME: 16:07:30 UTC 
 
 
  SOFTWARE: page5  0612.06 master29.pl             START: 2007/03/14  18:06:00 
 EPHEMERIS: igs14183.eph [precise]                  STOP: 2007/03/14  20:36:00 
  NAV FILE: brdc0730.07n                        OBS USED:  6385 /  6511   :  98% 
  ANT NAME: ASH701975.01AGP NONE             # FIXED AMB:    30 /    32   :  94% 
ARP HEIGHT: 2.0                              OVERALL RMS: 0.018(m) 
 
 
 REF FRAME: NAD_83(CORS96)(EPOCH:2003.0000)            ITRF00 (EPOCH:2007.1995) 
       
         X:     -2415358.884(m)   0.013(m)          -2415359.692(m)   0.013(m) 
         Y:     -2718046.175(m)   0.012(m)          -2718045.070(m)   0.012(m) 
         Z:      5222559.312(m)   0.016(m)           5222559.510(m)   0.016(m) 
 
       LAT:   55 19 58.66133      0.010(m)        55 19 58.67266      0.010(m) 
     E LON:  228 22 28.18023      0.007(m)       228 22 28.10433      0.007(m) 
     W LON:  131 37 31.81977      0.007(m)       131 37 31.89567      0.007(m) 
    EL HGT:            3.781(m)   0.023(m)                 3.780(m)   0.023(m) 
 ORTHO HGT:            9.656(m)   0.034(m) [Geoid06 NAVD88] 
 
                        UTM COORDINATES    STATE PLANE COORDINATES 
                         UTM (Zone 09)         SPC (5001 AK 1) 
Northing (Y) [meters]     6134983.221                0.000 
Easting (X)  [meters]      333464.469                0.000 
Convergence  [degrees]    -2.15989540           0.00000000 
Point Scale                0.99994023           0.00000000 
Combined Factor            0.99993963           0.00000000 
 
US NATIONAL GRID DESIGNATOR:  9UUB3346434983(NAD 83) 
 
 
 
                              BASE STATIONS USED 
PID       DESIGNATION                        LATITUDE    LONGITUDE DISTANCE(m) 
AI5022 BIS1 BIORKA ISLAND 1 CORS ARP       N565116.162 W1353221.387  296620.8 
AJ4430 LEV1 LEVEL ISLAND 1 CORS ARP        N562756.438 W1330533.935  155968.5 
AF9530 AIS1 ANNETTE ISLAND 1 CORS ARP      N550408.647 W1313558.255   29425.1 
 
                 NEAREST NGS PUBLISHED CONTROL POINT 
AI4914      BM NO 37                       N551958.659 W1313731.820       0.0 



 
 
                                                    
                                                    
                          BASE STATION INFORMATION  
                                                    
 STATION NAME: bis1  a    5 (BIORKA ISLAND 1; Biorka Island, Alaska, U.S.A.) 
  ANTENNA: ASH700829.3     SNOW                             S/N=xxxx             
 XYZ  -2494921.0213  -2448390.9324   5317113.5289  MON @ 1997.0000 (M) 
 XYZ        -0.0164         0.0037         0.0005  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0877  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0598  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1673         0.0377         0.0051  VEL TIMES 10.1982 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0342        -0.0336         0.0734  ARP TO L1 PHASE CENTER 
 XYZ  -2494921.2228  -2448390.9283   5317113.6074  L1 PHS CEN @ 2007.1995 
 XYZ        -0.0001         0.0014         0.0005  + XYZ ADJUSTMENTS 
 XYZ  -2494921.2228  -2448390.9269   5317113.6080  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2494921.1886  -2448390.8933   5317113.5345  NEW ARP @ 2007.1995 
 XYZ  -2494921.1886  -2448390.8933   5317113.5345  NEW MON @ 2007.1995 
 LLH  56 51 16.17228  224 27 38.53267     66.6787  NEW L1 PHS CEN @ 2007.1995 
 LLH  56 51 16.17228  224 27 38.53267     66.5910  NEW ARP @ 2007.1995 
 LLH  56 51 16.17228  224 27 38.53267     66.5910  NEW MON @ 2007.1995 
 
 STATION NAME: lev1  a    8 (Level Island 1; Level Island, Alaska  USA) 
  ANTENNA: ASH700829.3     SNOW                             S/N=CG11936          
 XYZ  -2412828.4670  -2579056.1235   5293283.3535  MON @ 1997.0000 (M) 
 XYZ        -0.0190         0.0003        -0.0044  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0877  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0598  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1938         0.0031        -0.0449  VEL TIMES 10.1982 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0331        -0.0354         0.0731  ARP TO L1 PHASE CENTER 
 XYZ  -2412828.6939  -2579056.1558   5293283.3817  L1 PHS CEN @ 2007.1995 
 XYZ        -0.0002         0.0006         0.0002  + XYZ ADJUSTMENTS 
 XYZ  -2412828.6941  -2579056.1552   5293283.3819  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2412828.6610  -2579056.1198   5293283.3088  NEW ARP @ 2007.1995 
 XYZ  -2412828.6610  -2579056.1198   5293283.3088  NEW MON @ 2007.1995 
 LLH  56 27 56.44916  226 54 25.98578     25.2831  NEW L1 PHS CEN @ 2007.1995 
 LLH  56 27 56.44916  226 54 25.98578     25.1954  NEW ARP @ 2007.1995 
 LLH  56 27 56.44916  226 54 25.98578     25.1954  NEW MON @ 2007.1995 
 
 STATION NAME: ais1  a    7 (ANNETTE ISLAND 1; Annette Island, Alaska, U.S.A.) 
  ANTENNA: ASH700829.3     SNOW                             S/N=11276            
 XYZ  -2430153.7846  -2737192.8996   5205816.6147  MON @ 1997.0000 (M) 
 XYZ        -0.0151         0.0008        -0.0082  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0877  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0598  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1540         0.0082        -0.0836  VEL TIMES 10.1982 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0333        -0.0376         0.0719  ARP TO L1 PHASE CENTER 
 XYZ  -2430153.9719  -2737192.9290   5205816.6030  L1 PHS CEN @ 2007.1995 
 XYZ         0.0001        -0.0001        -0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2430153.9718  -2737192.9291   5205816.6030  NEW L1 PHS CEN @ 2007.1995 



 XYZ  -2430153.9385  -2737192.8915   5205816.5311  NEW ARP @ 2007.1995 
 XYZ  -2430153.9385  -2737192.8915   5205816.5311  NEW MON @ 2007.1995 
 LLH  55  4  8.65871  228 24  1.66998     32.2471  NEW L1 PHS CEN @ 2007.1995 
 LLH  55  4  8.65871  228 24  1.66998     32.1594  NEW ARP @ 2007.1995 
 LLH  55  4  8.65871  228 24  1.66998     32.1594  NEW MON @ 2007.1995 
 
                         REMOTE STATION INFORMATION 
                                                    
 STATION NAME: uscg       1 
  ANTENNA: ASH701975.01AGP NONE                             S/N=UNKNOWN          
 XYZ  -2415360.3793  -2718045.5588   5222561.1762  MON @ 2007.1993 (M) 
 NEU         0.0000        -0.0000         2.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0637  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0440  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.7557        -0.8504         1.6449  MON TO ARP 
 XYZ        -0.0241        -0.0271         0.0524  ARP TO L1 PHASE CENTER 
 XYZ  -2415361.1590  -2718046.4363   5222562.8735  L1 PHS CEN @ 2007.1995 
 
 BASELINE NAME:   bis1  uscg 
 XYZ         0.6817         0.4813        -1.6607  + XYZ ADJUSTMENTS 
 XYZ  -2415360.4774  -2718045.9549   5222561.2128  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2415360.4533  -2718045.9278   5222561.1604  NEW ARP @ 2007.1995 
 XYZ  -2415359.6976  -2718045.0775   5222559.5155  NEW MON @ 2007.1995 
 LLH  55 19 58.67251  228 22 28.10438      5.8533  NEW L1 PHS CEN @ 2007.1995 
 LLH  55 19 58.67251  228 22 28.10438      5.7896  NEW ARP @ 2007.1995 
 LLH  55 19 58.67251  228 22 28.10438      3.7896  NEW MON @ 2007.1995 
 
 BASELINE NAME:   lev1  uscg 
 XYZ         0.6864         0.4936        -1.6609  + XYZ ADJUSTMENTS 
 XYZ  -2415360.4727  -2718045.9427   5222561.2127  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2415360.4486  -2718045.9156   5222561.1603  NEW ARP @ 2007.1995 
 XYZ  -2415359.6929  -2718045.0652   5222559.5153  NEW MON @ 2007.1995 
 LLH  55 19 58.67284  228 22 28.10412      5.8462  NEW L1 PHS CEN @ 2007.1995 
 LLH  55 19 58.67284  228 22 28.10412      5.7825  NEW ARP @ 2007.1995 
 LLH  55 19 58.67284  228 22 28.10412      3.7825  NEW MON @ 2007.1995 
 
 BASELINE NAME:   ais1  uscg 
 XYZ         0.6951         0.4928        -1.6769  + XYZ ADJUSTMENTS 
 XYZ  -2415360.4639  -2718045.9435   5222561.1967  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2415360.4398  -2718045.9164   5222561.1443  NEW ARP @ 2007.1995 
 XYZ  -2415359.6842  -2718045.0660   5222559.4993  NEW MON @ 2007.1995 
 LLH  55 19 58.67268  228 22 28.10452      5.8300  NEW L1 PHS CEN @ 2007.1995 
 LLH  55 19 58.67268  228 22 28.10452      5.7663  NEW ARP @ 2007.1995 
 LLH  55 19 58.67268  228 22 28.10452      3.7663  NEW MON @ 2007.1995 
 
                                   G-FILES  
                                            
Axx2007 314   7 314 
B2007 31418 5   7 3142035 1 page5 v0612.06IGS     222 1 2 27NGS   2007 4 2IFDDFX 
Iant_info.003        NGS   20070320 
C00090001 -795614910   19 2696541842   21  945540190   39 X0737AUSCGX0737ABIS1 
D  1  2  7550588  1  3 -9307589  2  3 -7806480 
  
Axx2007 314   7 314 
B2007 31418 5   7 3142035 1 page5 v0612.06IGS     222 1 2 27NGS   2007 4 2IFDDFX 
Iant_info.003        NGS   20070320 
C00090002   25310319   17 1389889454   20  707237935   38 X0737AUSCGX0737ALEV1 



D  1  2  8189618  1  3 -9202066  2  3 -7448116 
  
Axx2007 314   7 314 
B2007 31418 5   7 3142035 1 page5 v0612.06IGS     222 1 2 27NGS   2007 4 2IFDDFX 
Iant_info.003        NGS   20070320 
C00090003 -147942543   19 -191478255   22 -167429683   36 X0737AUSCGX0737AAIS1 
D  1  2  9369495  1  3 -7883557  2  3 -7554607 
  
                   POST-FIT RMS BY SATELLITE VS. BASELINE 
                                                          
            OVERALL     03     06     07     10     16     18     19     21 
 bis1-uscg|  0.017  0.018  0.016  0.018  0.014  0.019  0.013  0.015    ... 
                22     24     25     26     29     30 
 bis1-uscg|  0.018  0.015    ...  0.022  0.019    ...                      
 
            OVERALL     03     06     07     10     16     18     19     21 
 lev1-uscg|  0.018  0.017  0.018  0.019  0.017  0.022  0.017  0.015    ... 
                22     24     26     29     30 
 lev1-uscg|  0.018  0.013  0.018  0.021    ...                             
 
            OVERALL     03     06     07     10     16     18     19     21 
 ais1-uscg|  0.018  0.020  0.018  0.018  0.012  0.022  0.016    ...    ... 
                22     24     26     29     30 
 ais1-uscg|  0.015  0.017  0.015  0.016    ...                             
 
                        OBS BY SATELLITE VS. BASELINE 
                                                      
            OVERALL     03     06     07     10     16     18     19     21 
 bis1-uscg|   2148    155    203    279    102    296    245     28    ... 
                22     24     25     26     29     30 
 bis1-uscg|    118    284    ...    200    238    ...                      
            OVERALL     03     06     07     10     16     18     19     21 
 lev1-uscg|   2087    155    182    225    106    296    247     28    ... 
                22     24     26     29     30 
 lev1-uscg|    117    284    200    247    ...                             
            OVERALL     03     06     07     10     16     18     19     21 
 ais1-uscg|   2150    152    207    284    105    295    239    ...    ... 
                22     24     26     29     30 
 ais1-uscg|    119    283    213    253    ...                             
                                            
 
 Covariance Matrix for the xyz OPUS Position (meters2). 
    0.0000022467     0.0000002159    -0.0000004052 
    0.0000002159     0.0000029444    -0.0000004008 
   -0.0000004052    -0.0000004008     0.0000094689 
 
 Covariance Matrix for the enu OPUS Position (meters2). 
    0.0000023402    -0.0000002845     0.0000001534 
   -0.0000002845     0.0000044782     0.0000029060 
    0.0000001534     0.0000029060     0.0000078416 
 
 Horizontal network accuracy =    0.00458 meters. 
 Vertical network accuracy   =    0.00549 meters. 
 
 
                       Derivation of NAD 83 vector components 
 



  
  Position of reference station ARP in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xa(m)           Ya(m)           Za(m) 
       BIS1  -2494920.37852  -2448391.99956   5317113.26406    2003.00 
       LEV1  -2412827.84636  -2579057.21856   5293283.07789    2003.00 
       AIS1  -2430153.14737  -2737194.00189   5205816.33593    2003.00 
  
  Position of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xr(m)           Yr(m)           Zr(m) 
       BIS1  -2494920.37852  -2448391.99956   5317113.26406    2003.00 
       LEV1  -2412827.84636  -2579057.21856   5293283.07789    2003.00 
       AIS1  -2430153.14737  -2737194.00189   5205816.33593    2003.00 
  
  Velocity of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Vx (m/yr)       Vy (m/yr)       Vz (m/yr) 
       BIS1         0.00490         0.00450         0.00990 
       LEV1         0.00220         0.00120         0.00480 
       AIS1         0.00580         0.00170         0.00110 
  
  Vectors from unknown station monument to reference station monument 
  in NAD_83(CORS96)(EPOCH:2003.0000). 
                Xr-X= DX(m)     Yr-Y= DY(m)     Zr-Z= DZ(m) 
       BIS1    -79561.49452    269654.17544     94553.95206    2003.00 
       LEV1      2531.03764    138988.95644     70723.76589    2003.00 
       AIS1    -14794.26337    -19147.82689    -16742.97607    2003.00 
 
This position and the above vector components were computed without any  
knowledge by the National Geodetic Survey regarding the equipment or  
field operating procedures used. 



NOTE 
 
Trimble – Additional Calibration Reports 

 
See SAND1.ssf attached as digital separates  



NOAA Ship FAIRWEATHER
LASER LEVEL Accuracy test
3.8 sn# 000676
Laser Technology, Inc. Impulse 200 laser ranging instrument

Testing date: 02/27/2006

Trial
Actual 

Distance
LL 

Distance
Actual 
Height

LL 
Height

1 10 10.0 2.0 2.0
2 10 10.0 2.0 2.0
3 10 10.0 2.0 2.0
4 20 20.0 2.0 1.9
5 20 19.9 2.0 2.0
6 20 20.0 2.0 2.0
7 50 50.1 2.0 2.0
8 50 50.1 2.0 2.1
9 50 50.1 2.0 2.1
10 100 100.1 2.0 2.1
11 100 100.1 2.0 1.9
12 100 100.1 2.0 1.8

LL = Laser Level
all distances are measured in meters

Comparison Testing Lasers 000676 and i0929 and Trimble

Testing date: 03/03/2006

Trial Trimble 
Distance

000676 
Distance

i0929 
Distance

000676 
Height

i0929 
Height

Actual 
Height

1.0 30.0 32.8 33.0 2.1 2.4 2.0 2.8
2.0 23.5 27.3 27.8 2.0 1.9 2.0 3.8
3.0 20.2 24.0 24.2 2.2 2.0 2.0 3.8
4.0 34.0 31.9 32.4 2.6 2.3 2.0 2.1
5.0 26.8 26.2 25.8 2.1 2.0 2.0 0.6
7.0 30.6 28.5 28.5 2.0 2.4 2.0 2.1
6.0 51.9 38.7 38.5 2.0 2.3 2.0 13.2

sum 217.0 209.4 210.2 15.0 15.3 14.0 28.4 15.2

mean 31.0 29.9 30.0 2.1 2.2 2.0 4.1 2.5

standard deviation 10.3 5.0 4.9 0.2 0.2 0.0



Checked by: BC

Lead Line Corrector
(c = b - a)
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8 7.97

6 5.97

4 3.97

5 4.97

Field unit: FA

1 0.96

Measured by: BC Recorded by: BC

Graduated Marking
(a)

Chief of Party: Cdr. Andrew Beaver, NOAA, FA

Lead Line / Sounding Pole Unit of Measure:  Meters

Method of Calibration:                    X� Steel tape          � Permanent graduation marks          � 
Other

Lead Line / Sounding Pole Identification Number: Leadline 10_01_05
(Unique Identifier, with equipment type, date made, etc. )

Date of Calibration: 3/6/2007

8.97

2 1.96

3 2.96

7 6.95

Calibration Measurement
(b)

Location: Ketchikan, Alaska

Average Correction

9

10

Lead Line & Sounding Pole Calibration Report

Standard Deviation

9.95



Correction Values Lead Line 10_01_05
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Checked by: BC

Lead Line Corrector
(c = b - a)

0.003

0.012

0.019

0.021

0.022

0.017

0.019
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0.019

0.017

0.016

0.017

0.017

0.017

0.017

0.014

0.016

0.01

0.01

0.007

0.015

0.005Standard Deviation

20 19.993

Average Correction

18 17.99

19 18.99

16 15.986

17 16.984

Lead Line & Sounding Pole Calibration Report

14

15 14.983

12 11.983

13.983

13 12.983

9.983

10.984

9

10

11

Date of Calibration: 3/20/2007

8.981

2 1.988

3 2.981

7 6.981

Calibration Measurement
(b)

Location: Ketchikan, Alaska

Field unit: FA

1 1.003

Measured by: BC/DJ Recorded by: BC

Graduated Marking
(a)

Chief of Party: Brenna Campbell

Lead Line / Sounding Pole Unit of Measure:  Meters

Method of Calibration:                   X� Steel tape          � Permanent graduation marks          �  
Other

Lead Line / Sounding Pole Identification Number: Leadline 20_01_05
(Unique Identifier, with equipment type, date made, etc. )

4 3.979

5 4.978

8 7.981

6 5.983



Correction Values Lead Line 20_01_05
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Checked by: BC

Lead Line Corrector
(c = b - a)

0.01

0.013

0.015
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0.032
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0.035
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0.033
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0.031

0.027

0.022

0.018

0.02655

0.00810117

Average Correction

Standard Deviation

19 18.978

20 19.982

17 16.969

18 17.973

Lead Line & Sounding Pole Calibration Report

14

15 14.967

12 11.964

13.965

13 12.965

9.966

Date of Calibration: 4/09/2007

8.968

2 1.987

3 2.985

7 6.973

Calibration Measurement
(b)

Location: Ketchikan, Alaska

Field unit: FA

1 0.99

Measured by: BC/DJ Recorded by: BC

Graduated Marking
(a)

Chief of Party: CDR Andrew Beaver/NOAA Ship Fairweather

Lead Line / Sounding Pole Unit of Measure:  Meters

Method of Calibration:                   X� Steel tape          � Permanent graduation marks          � 
Other

Lead Line / Sounding Pole Identification Number: Leadline 20_02_05
(Unique Identifier, with equipment type, date made, etc. )

6 5.977

4 3.979

5 4.977

8 7.973

10.966

9

10

11

16 15.965



Correction Values Leadline 20_02_05
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Checked by: BC

Lead Line Corrector
(c = b - a)

0.015
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0.014

8 7.962

10.946

9
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11

16 15.942

6 5.961

4 3.969

5 4.966

Field unit: FA

1 0.985

Measured by: BC/DJ Recorded by: BC

Graduated Marking
(a)

Chief of Party: Cdr. Andrew Beaver/NOAA Ship Fairweather

Lead Line / Sounding Pole Unit of Measure:  Meters

Method of Calibration:                   X� Steel tape          � Permanent graduation marks          �  
Other

Lead Line / Sounding Pole Identification Number: Leadline 20_03_05
(Unique Identifier, with equipment type, date made, etc. )

Date of Calibration: 3/26/2007

8.956

2 1.978

3 2.973

7 6.962

Calibration Measurement
(b)

Location: Ketchikan, Alaska

Lead Line & Sounding Pole Calibration Report

14

15 14.946

12 11.949

13.95

13 12.951

9.952

17 16.941

18 17.938

19 18.939

20 19.934

Average Correction

Standard Deviation



Correction Values Leadline 20_03_05
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Checked by: BC

Lead Line Corrector
(c = b - a)

0.015
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8 7.949

10.937

9
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11

6 5.965

4 3.979

5 4.974

Field unit: FA

1 1.015

Measured by: BC/ACA Recorded by: BC

Graduated Marking
(a)

Chief of Party: CO Andrew Beaver/NOAA Ship Fairweather

Lead Line / Sounding Pole Unit of Measure:  Meters

Method of Calibration:                   X� Steel tape          � Permanent graduation marks          �  
Other

Lead Line / Sounding Pole Identification Number: Leadline 30_01_05
(Unique Identifier, with equipment type, date made, etc. )

Date of Calibration: 

8.942

2 1.992

3 2.991

7 6.963

Calibration Measurement
(b)

Location: Ketchikan, Alaska

Lead Line & Sounding Pole Calibration Report

14

12 11.923

13.907

13 12.921

9.937



Lead Line Corrector
(c = b - a)

Graduated Marking
(a)

Calibration Measurement
(b)
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20 19.91
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22 21.882

28 27.862

23 22.879
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 Average Correction

25 24.872

30 29.857

26 25.868

27 26.862

  

 Standard Deviation



Correction Values Leadline 30_01_05
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Conformity Certificate
Customer:

Reference:

Part No:

Serial No:

Description:

Comments:

Brooke Ocean Technology Ltd.

04653-0449M4337 PO#:Job#:

Smart SV & Pressure

4987

Direct measurement of sound velocity and pressure.

Technologist

Certification Date:
Justin Romito

This stainless steel, right angle end cap instrument operates as a stand
alone unit with a fixed 19200 baud rate, RS-485 communications interface.
Maximum depth, 1000 meters.

12-08-2004

APPLIED MICROSYSTEMS LTD. CERTIFIES THAT THE ABOVE DESCRIBED 
EQUIPMENT HAS BEEN TESTED IN ACCORDANCE WITH THE CONDITIONS AND 
REQUIREMENTS OF THE CONTRACT/PURCHASE ORDER. UNLESS OTHERWISE 
NOTED ABOVE, THE EQUIPMENT CONFORMS IN ALL RESPECTS TO THE 
SPECIFICATIONS AND/OR RELEVANT DRAWINGS.

50 Thornhill Drive, Unit 11
Dartmouth

________________________



Smart SV & Pressure  4987

Smart SV Calibration
Job Information

Date 11-30-2004
Job Number 4337
Customer Brooke Ocean Technology Ltd.

Sensor Information

Manufacturer AML
Model Number Time of Flight
Serial Number 166-2
Range 1400 to 1550 m/s
Channel 2
Calibrated By JR
Standards Smart T 9998

Deviation vs. Sound Speed (m/s)

Delgrosso Pure Water Sound Speed (m/s)

+0.2

+0.1

 0.0

-0.1

-0.2

1400 1425 1450 1475 1500 1525 1550

A = 1.532314E+03
B = -1.179385E+02
C = 1.073808E+01
D = -1.335136E+00

=A+B*((N-NL)/(NH-NL))+C*((N-NL)/(NH-NL))^2+D*((N-NL)/(NH-NL))^3

RMS = 0.0244 

Coefficients

Applied Microsystems Ltd.
2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6

Phone: (250) 656-0771   Fax: (250) 655-3655
Canada & USA: 800-663-8721

Email: info@AppliedMicrosystems.com  Web: http://www.aml.bc.ca



Smart SV & Pressure  4987

Smart Pressure Calibration
Job Information

Date 12-06-2004
Job Number 4337
Customer Brooke Ocean Technology Ltd.

Sensor Information

Manufacturer Keller
Model Number PA-10TAB/100BAR/8838.4
Serial Number YZ136
Range 1000 Dbar
Channel 1
Calibrated By JR
Standards Budenburg Deadweight

Deviation ( % of full scale ) vs. Pressure ( dbars )

Pressure ( dbars )

+0.1

+0.05

 0.0

-0.05

-0.1

0  200  400  600  800 1000

A = -1.529758E+03
B = -4.856953E-01
C = -3.189672E-03
D = 3.215278E-04
E = 4.733318E-02
F = 2.070545E-05
G = 4.684017E-07
H = -1.831440E-08
I = 3.933418E-08
J = -1.141085E-10
K = -9.489968E-12
L = 2.280363E-13

=A+B*T+C*T^2+D*T^3+(E+F*T+G*T^2+H*T^3)*Raw+(I+J*T+K*T^2+L*T^3)*Raw^2

RMS = 0.0963 

Coefficients

Applied Microsystems Ltd.
2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6

Phone: (250) 656-0771   Fax: (250) 655-3655
Canada & USA: 800-663-8721

Email: info@AppliedMicrosystems.com  Web: http://www.aml.bc.ca



MVP cfg - no_con_needed.txt
Subject: [Fwd: Re: AML SV+P .cfg file]
Date: Tue, 18 Apr 2006 15:49:46 +0000
From: "grant froelich" <grant.froelich@noaa.gov>
To: chiefst fairweather <chiefst.fairweather@noaa.gov>,
     foo fairweather <foo.fairweather@noaa.gov>,
     mike castle <mike.castle@noaa.gov>

--
-----------------------------------
Grant Froelich
Senior Survey Technician
NOAA Ship FAIRWEATHER
(907)254-2842 Cell
(808)659-0054 At Sea
----------------------------------

    ---------------------------------------------------------------------

Subject: RE: AML SV+P .cfg file
Date: Tue, 18 Apr 2006 09:45:18 -0300
From: Murray Eisan <meisan@brooke-ocean.com>
To: "'grant froelich'" <grant.froelich@noaa.gov>
CC: "'Darrell Groom'" <dgroom@brooke-ocean.com>

Hi Grant,

The calibration coefficients have been applied to the sensor at AML. The MVP
software logs the corrected data being outputted from the sensor. The AML
configuration file does not need to be applied to the MVP software.

Regards,

Murray Eisan

  ------------------------------------------------------------------------

From: grant froelich [mailto:grant.froelich@noaa.gov]
Sent: Monday, April 17, 2006 2:02 PM
To: support@brooke-ocean.com
Subject: AML SV+P .cfg file

Hello,

We recently sent our AML SV+P sensor out for calibration and when it
returned we also received a .cfg file.  Is this something that the MVP
software needs to correct the sound velocity files produced? If so, how is
that done?

thanks
grant

--
-----------------------------------
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TESTREPORT

DATE: Febmary 20, 2006

fO #: 06261-0578
CONTACT: Ma* Smit}

TIIIS IS TO CERTIFY T}IAT THE ABOIE TESTING T{AS PERFOR]4ED ACCORDING
TO RDQUIRE}ENTs SET EORTI{ ]N THE REIIERBNCED PURCHASE ORDER IN A
}.IANNER CONSISTINT WTIH ST,ANDARD PRAC1ICES AND iqNY SPECIfICAfIONS
REFERENCED I{EREIN.

INVENTORY #: I I27-TFI

Approved By;

Ne i l  R i ch te r  P .Enq ,
Managorr ESI

ENVI RONMENTAL SIMULATION LABS
Diviiion ot Composrrcr Atbrnh limited

HYDROSTATIC PR.ESSURE

TOBIREPORT #: ESL-0&025

CLIENT: Brooke Ocear Technology LTD.
50 Thomlill Drive, Unit t 1
Dartmouth, Nova Scotia B3B lsl

MODEL #! TSW-6-5000-PE30
CALIBRATION DUn: July d 2006

Tested by:

a*J&/-
Conrad Tu:Lk cET

Lab Technologist

TEST ARTICLE ITESCRIPTION; Free Fall Cone Peneraror
-tlodel Nor FFCPT-35-I

STANDARD USED: Autoola\e Entineefs 0-5000 PSIG Pressuro Transducer

Thc IUT was placcd itl tho 1"200 PSIC Prcssurc Vessel, Invcntory # I l42,TFl- The pressure was
increased to I,000 psig and maintained for one ( 1) hour. The pressure was then relieved and the ruT
rEmoved for inspeqtion. Brooke Ocean Teohnology personnel perfofined an onsite insp€ction for ary
signs of\rater infiltration, none was fourd. The ruT was retumed to Brooke Ocean 't'cchnologv for
final inspeotion.

p . e

EnvirJnmc al Stllruls[oo Lsborstoty l0l -C Rcxorch Drive- Dutunordl NS D2Y 4T6 (90b 464-t22n









 

 
 

 
Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4585













 

 
 

 
Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4616













 

 
 

 
Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4617

























TSG-Data.txt
 
S>ds    
SBE45 V 1.1  SERIAL NO. 0117508, 1.52891,  10.3145, 1489
not logging data                
sample interval = 1 seconds898,  10.3150, 1489.601    
output conductivity with each sample18.5508, 1.52905,  10.3155, 1489.601
output salinity with each sample    
 18.5509, 1.52912,  10.3160

S>dc
SBE45 V 1.1  0117
temperature:  03-dec-05
    TA0 = -2.052604e-04
    TA1 = 3.017581e-04
    TA2 = -4.020330e-06
    TA3 = 1.929919e-07
conductivity:  03-dec-05
    G = -1.029977e+00
    H = 1.264651e-01
    I = -1.493348e-04
    J = 2.835643e-05
    CPCOR = -9.570000e-08
    CTCOR = 3.250000e-06
    WBOTC = -3.180305e-06

S> 18.5870, 1.52912,  10.3071, 1489.703
 18.5872, 1.52913,  10.3071, 1489.704
 18.5874, 1.52914,  10.3072, 1489.705
 18.5875, 1.52919,  10.3075, 1489.706
 18.5876, 1.52920,  10.3076, 1489.706
 18.5874, 1.52920,  10.3076, 1489.705
 18.5870, 1.52919,  10.3076
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Appendix VI 
 
 
Maintenance and Periodic Testing 
 

CTD Care, Maintenance and Testing 
 
DLDG Daily DQA 



SV Maintenance

Date Project Maintenance Notes Results Location

3/29/2007 HSRR Performed DQA between 4616 and 
4617

Velocwin 8.83 installed 
on O-lab computer 
and 1010

OK
Blank Inlet - 
Ketchikan 
Shakedown

4/14/2007 O119 Ernest Sound Performed DQA between 4585 and 
MVP OK Fools Inlet

4/25/2007 O119 Ernest Sound Performed DQA between 4585 and 
4617 OK Menefee Inlet

5/2/2007 O119 Ernest Sound DQA between 4585 and 4617 OK Seward Passage

5/2/2007 O119 Ernest Sound Attempted DQA with MVP and 4616 see note in folder n/a Seward Passage

5/12/2007 O119 Ernest Sound DQA between 4585 and MVP OK S of Sunny Bay

5/14/2007 O119 Ernest Sound DQA between 4617 and 4616 OK S of Sunny Bay

5/22/2007 O119 Ernest Sound DQA between 4616 and 4585 OK S of Sunny Bay

5/22/2007 O119 Ernest Sound DQA between 4617 and MVP Failed.  Reattempt on 
5/24, Results OK N/A S of Sunny Bay

5/24/2007 O119 Ernest Sound DQA between 4617 and MVP OK Warm Springs Bay

6/2/2007 P183 Shumagin Is DQA b/w MVP and 4585 OK Big Koniuji

6/2/2007 P183 Shumagin Is DQA b/w 4617 and 4616 OK Big Koniuji

6/19/2007 P183 Shumagin Is DQA between 4616 and 4585 OK Big Koniuji

7/27/2007 P183 Shumagin Is DQA between 4617 and 4585 OK Sand Point

7/27/2007 P183 Shumagin Is DQA between 4616 and MVP
BOT file processed 
OK; Seacat error (too 
few points); reattempt

failed Sand Point

7/30/2007 P183 Shumagin Is DQA reattempted for 4616 and MVP
vbatt low on Seacat, 
changed out D 
batteries

OK Bendel Is

8/15/2007 P183 Shumagin Is 4617 and MVP OK Mist Harbor

8/15/2007 P183 Shumagin Is 4616 and 4585 OK Mist Harbor

8/24/2007 P132 NE PWS 4585 and MVP

POSMV wasn't on so 
BOT files did not have 
positions and could 
not be processed

failed Two Moon Bay

8/27/2007 P132 NE PWS 4616 and 4617 OK Two Moon Bay

8/27/2007 P132 NE PWS 4585 and MVP OK Two Moon Bay

9/12/2007 P132 NE PWS 4617 and 4585 OK Two Moon Bay

9/12/2007 P132 NE PWS 4616 and MVP OK Two Moon Bay

9/20/2007 P132 NE PWS 4616 and 4585 OK Two Moon Bay

9/20/2007 P132 NE PWS 4617 and MVP OK Two Moon Bay

10/8/2007 P132 NE PWS 4585 and MVP OK Sunny Bay

10/8/2007 P132 NE PWS 4616 and 4617 OK Two Moon Bay

10/25/2007 O168 Endicott Arm 4616 and MVP OK Sanford Cove

10/25/2007 O168 Endicott Arm 4617 and 4585 Sanford Cove

SV Maintenance & Testing 2007



Subject: [Fwd: [Fwd: DGPS: P-checks & Nav DQA]] 
Date: Mon, 12 Sep 2005 18:22:20 -0800 
From: "foo fairweather" <foo.fairweather@noaa.gov> 
To: chiefst.fairweather@noaa.gov 
 
    --------------------------------------------------------------------- 
 
Subject: [Fwd: DGPS: P-checks & Nav DQA] 
Resent-Date: Mon, 12 Sep 2005 20:17:27 GMT 
Resent-From: FOO.Fairweather@noaa.gov 
Date: Mon, 12 Sep 2005 20:29:01 +0100 
From: "FOO Rainier" <foo.rainier@noaa.gov> 
To: _NMAO MOP FOO Fairweather <FOO.Fairweather@noaa.gov>, 
     abigail higgins <abigail.higgins@noaa.gov> 
 
Abigail, 
 
I assume you're checking FOO-FA now, so sorry if you get this twice. 
Anyway, here's the email from Gerd from the spring about P-checks.  Looks 
like it was a question from Lynn which prompted it in the first place. 
 
Ben 
 
-------- Original Message -------- 
     Subject: DGPS: P-checks & Nav DQA 
        Date: Wed, 25 May 2005 17:01:38 -0400 
        From: Gerd Glang <Gerd.Glang@noaa.gov> 
Organization: NOAA Hydro Systems & Technology Programs (301-713-2653, x152) 
          To: holly.dehart.atsea@noaa.gov 
          CC: Jack Riley <Jack.Riley@noaa.gov>, "Lynnette V. Morgan" 
              <Lynnette.V.Morgan@noaa.gov>, "Holly A. Dehart" 
              <Holly.A.Dehart@noaa.gov>, Benjamin K Evans 
              <Benjamin.K.Evans@noaa.gov>, Guy Noll <Guy.Noll@noaa.gov> 
  References: <793c68e7.68e7793c@fairweather.nmao.noaa.gov> 
 
Hi Holly (I hear my train leaving), 
 
Your "atsea" e-mail keeps getting bounced back...so I'm copying Lynn on 
this. 
 
Short answer - No. 
 
USCG Beacons are subject to their own rigorous integrity monitoring.  If the 
beacon signal is being received w/ good signal strength, it should be valid 
for correcting your position (simple answer).  The Specs and Deliverables 
requirements assume this. 
 
What we need to do is check that our receivers are working properly and no 
bogus antenna offsets were entered.  Probably adequate to do this once per 
season as part of the system cert, or when you suspect a problem.   Our MB 
data (and side scan data) are spatially dense enough that any problems would 
be apparent in the data right away.  Also, the several GPS failures we've 
experienced this year have all been pretty catastrophic, i.e., there was no 
doubt the POS GPS had failed.  Bottom line, it's not in the current draft 
FPM, its not in the Specs and Deliverables.  Should be a reqt for the System 
Cert process. 
 



So the two things I would require: 
 
1)   During data acquisition, conscientious monitoring of all sensor data 
(POS controller window, POS CPU lights, USCG Beacon Receiver display/lights, 
Isis display, etc). 
2)  During daily post-processing, a systematic and careful review of the 
data - treat as a directed editing problem. 
 
Of course, we often fiddle with acquisition system configurations, both 
hardware and software, for one reason or another (or some gremlin gets into 
the system).  It would be prudent to have a system cert-like checklist to 
run thru on Monday mornings after a long inport to prompt the 
briefly-befuddled or newly-trained OIC and chase Mr. Murphy away.  Sort of 
like a pre-flight checklist.  You may recall, we once had a case on the WH 
where an entire launch day (+4 hrs OT) of data was hosed because the Isis 
config was messed up the night before, and the JO's (who shall remain 
nameless but were nevertheless well qualified) didn't pay attention to #1. 
 
(The complacent hydrographer will soon go aground - GFG). 
 
BTW - RA has SonarPro for SSS (haven't used it much lately).   NRTs use 
SonarPro. 
 
G2 
 
Holly DeHart atsea wrote: 
 
> Hi Gerd, 
> 
> Lynn was asking me about comparing differential beacons, where you 
> take coincident positions w/ two systems on different beacons.  Sounds 
> like WH's old p-check system.  Do we still need to do these?  If so at 
> what frequency?  They've been doing it weekly all season w/ no errors, 
> is this still necessary? 
> 
> Holly 
> 
> 
 
-- 
LT Ben Evans, NOAA 
Field Operations Officer 
NOAA Ship RAINIER (s221) 
NOAA Marine Operations Center, Pacific 
1801 Fairview Ave. E 
Seattle, WA  98102 



Thank you so much - this was indeed the project we were discussing.  Could you 
tell me, is that 0.14 total tide error is a one-sigma or two-sigma error 
estimate? 
 
Thank you for your time. 
 
~~ mike.g. 
 
Monica Cisternelli wrote: 
 
> I computed an error estimation for OPR-O119-FA-2007, between historic 
> Thoms Point and Ketchikan, and the total tide error came out to be 0.14 
> m ( including datum error). I am not sure if this is even the project 
> you are concerned about, but it is the only one where we did not include 
> an error estimation in our project instructions. So I guessed this is 
> the one your talking about. So please use this value rather than a 0.4. 
> Thanks 
> 
> Monica 
 
 
 
Thank you for the info Rick, it was ~exactly~ what I was looking for.. 
 
While it is a shame to watch our data collapse in the face of IHO Order 
1, it might just be the sad truth of Alaskan surveying:  given the tidal 
uncertainties, a definitive depth cannot be ascertained without an 
appreciable error envelope. 
 
I wish we could re-create your 14m IHO error in the field.  As I 
mentioned earlier, we were unable to survey past 48m and maintain IHO 
Order 1.  We'd used the exact error values suggested for the POS M/V and 
time latency suggested in HSTD-2;  Our offset erors are on the order of 
7 mm; Loading and Draft 3 and 4cm respectively; we low-balled the SV at 
1 m/s and left the Delta Draft, and MRU align errors as zero (since we 
had yet to compute the patch test).  This configuration blanked our 
swath in waters shoaler than 48m when filtered against IHO - but then, 
as you suggested, perhaps it is unrealistic to be expected to survey to 
IHO order 1 under these conditions.  If that's the case, I feel like 
there should have been a disclaimer presented to everyone during the 
west coast hydro training, "Hey gang, while we strive to satisty IHO, 
the reality is you won't be able to get there while surveying in the 
shallow waters.  How shallow?  Well, anything shoaler than the Statue of 
Liberty is tall (46.84m - base to torch)." 
 
The picture will not improve when the delta draft and MRU errors are 
added to the model. 
 
I have attached a copy of our TPE spread sheet.  Do any of the values 
appear inordinately high to you that keeps us from reaching your 14m 
glass ceiling (or would it be a glass floor)? 
 
Is RAINIER having better luck than we? 
 
Thank you for your time, all. 
 
Regards, 



 
~~ mike.g. 
 
Richard T Brennan wrote: 
 
> Hi Mike, 
> 
> Not sure if you saw my response to Ben, but I agree, the MRU alignment 
> error is too big.  My recommendation was that the guidance should say 
> "The MRU alignment error should be approximately the smallest unit of 
> change in the HIPS calibration window which produces no noticeable 
> change in the point cloud alignment."  I think this would yield a 
> similar result to the method you are employing and not require a field 
> party to have six people, or have six people look at their patch test. 
> 
> As for the zoning error, this value wraps up a lot of sins in one 
> place and thus I would not suggest altering this without consulting 
> CO-OPS.  The goal of populating the error model with the various 
> system uncertainties is not to tweak them until they are "within 
> spec", it is to give us an honest assessment of how good our 
> measurements are.  The zoning model does not account for changes in 
> the shape of the tide curve across the survey area (i.e. diurnal to 
> semi-diurnal, or semi-diurnal to mixed, etc...), differences between 
> the rate an area floods and ebbs, uncertainties in the datum, and 
> inaccuracies induced by the interpolation method itself.  While CO-OPS 
> may not be able to supply a definitive zoning error value for your 
> survey area, they do use some judgment based on experience, and 
> experience has shown that 0.4 is not an unrealistic value, 
> particularly in Alaska.  While 0.4m for zoning error is not unheard 
> of, it is larger than normal, so I would confirm with CO-OPS that this 
> is indeed the correct value.  While your data may appear to be 
> internally consistent (no stereotypical tide artifacts), errors 
> induced by uncertainties in the datum would not cause a visual 
> artifact.    That said my computations show that you should be able to 
> survey up to 14 m of water and still maintain IHO Order 1 with a 0.4m 
> combine tidal uncertainty (that is the rms of  measurement uncertainty 
> and zoning uncertainty).  I have attached a spreadsheet with my 
> numbers in it.  Let me know if you have any questions regarding these 
> values.  Hope this helps... 
> 
> Rick 
> 
> michael gonsalves wrote: 
> 
>> ** This e'mail is longer than the attention span of the average JO 
>> and ST - thus I present the summary at the beginning:  An MRU align 
>> error of 1.0 is too large; something on the order of 0.20 is a 
>> better estimate (want to know why ... then read on);  A tidal zoning 
>> of 0.40 is also too large, it makes it impossible to acquire IHO 
>> Order 1 data in waters shoaler than ~45m), I propose 0.10 as a 
>> better upper bound until CO-OPS commits to something better. 
>> ...and now for the message -- mog ** 
>> 
>> Wait, we can haggle over HSTD 2007-2? 
>> 
>> ITEM #1 - MRU Alignment 
>> FAIRWEATHER had identical problems to those described by LT Evans at 



>> the end of the previous field season.  An incorrect calculation led 
>> to MRU alignment errors ~0.5 degrees which led to 2/3 or our swath 
>> being rejected as not satisfying IHO Order 1. 
>> 
>> I believe the spirit of the error is to report your reliability in 
>> the operator's ability to perform a successful patch test.  RAINIER 
>> has struck upon the proper approach having several people 
>> independently perform the patch test.  At that point, the Standard 
>> Deviation of the patch test values can be used as a valid 
>> approximation of the MRU alignment errors.  This is the technique 
>> suggested by Dr. Calder to FA around this time last year.  The only 
>> caveat I would suggest is that the multiple evaluations of the patch 
>> test data must be performed in tandem; that is, all processors must 
>> agree on a value in the timing error before the group proceeds to 
>> calibrating for pitch (and so on).  Such a simultaneous approach is 
>> necessary due to the confounding of the various alignment errors 
>> (i.e. a pitch-induced artifact can be removed by adjusting timing). 
>> 
>> By the end of the field season, FA had settled on MRU align values 
>> of 0.25 for gyro and 0.15 for roll/pitch.  In my opinion, these 
>> values may still be on the conservative side.  But, with these 
>> values inserted into the hvf, filtering the data against IHO Order 1 
>> resulted in all the wacky outbeams being rejected while the smooth 
>> continuous bottom was preserved.  Any parameters that leads to 
>> "poor" data being rejected while retaining the "good" is a step in 
>> the right direction. 
>> 
>> The redundancy in having multiple eyes view a patch test can only be 
>> taken so far however.  Sea state, speed of the vessel, validity of 
>> sound velocity profile, whether that pitch line was run ~exactly~ on 
>> top of the sonar-conspicious target will dictate how valid a given 
>> set of patch lines are for accurately determining the sonar 
>> calibration.  It's like we're trying to calculate the average weight 
>> of any given Oreo by having a dozen people measure the weight of one 
>> specific Oreo.  Sure, you'll get a great estimate of the weight of 
>> Oreo-X, and sure Nabisco strives to make all Oreos equal -- but can 
>> that single (though repeated) measurement ~really~ be extrapolated 
>> to all cookies?  In magnitude, I would say yes (your single set of 
>> patch test values are valid), but I would say the error estimates of 
>> the patch values will be smaller than they really are.  Anyone feel 
>> like doing a week of patch tests to estimate the variability? 
>> 
>> SUMMARY #1:  1-degree is an inordinately large estimate of the MRU 
>> alignment errors.  Instead, compute the Std. Dev. of the values 
>> found during the patch test and those should give you a good low-end 
>> estimate.  Values in the ballpark of 0.25 for gyro and 0.15 for 
>> pitch/roll are reasonable estimates of a field units ability to 
>> accurately conduct a patch test. 
>> 
>> ITEM #2 - Tide values 
>> I'm curious how the field units are coping with the errors 
>> associated with tide measured and tide zoning.  The tide measured 
>> component is straight-forward and can be computed directly from the 
>> observed data (looking at past FA projects, 0.01m is a reasonable 
>> median).  However I feel the tidal zoing error of 0.01 to 0.40 is 
>> too large.  HSTD 2007-2 claims we will be given values in the Letter 
>> Instructions, but the reality of Alaskan survey work is there will 



>> seldom be enough historic data for CO-OPS to commit to a zoning 
>> error.  Speaking with the CST, we elected to high ball the error and 
>> use 0.40m when computing TPE (the thought process being, "Well ... 
>> it sure is a long way to the primary tide gauge." 
>> 
>> I do not know the exact equations involved when it comes to the 
>> assimilation of the various components of error in the TPE model, 
>> but a qualitative comparison can be made by varying the zoning error 
>> (ZE) and examining the changes in the Dp TPE for a subset of pings. 
>> Incrementally increasing the ZE causes the vertical TPE (Dp TPE) of 
>> a given ping at nadir to converge on twice the value of the ZE, 
>> regardless of the initial Dp TPE.  See attached picture. 
>> 
>> It is worth repeating:  regardless of the Dp TPE of a given sounding 
>> with a zero ZE, inputting a ZE of 0.40 will lead to a Dp TPE for 
>> that same sounding to change to 0.80. 
>> 
>> Using the IHO error estimate (Sqrt[a^2 + bd^2]), this would imply 
>> all soundings collected in waters shoaler than 48m will 
>> automatically be rejected as having not satisfied IHO Order 1.  I 
>> wish I had a cookie analogy I could insert here. 
>> 
>> As of now, FA is proceeding with a zoning error of 0.10, since the 
>> pings still appear to retain an essence of the other uncertainties 
>> associated with the pings (alignment, POS/MV, precise timing, 
>> etc.).  Once we begin acquiring data in earnest, we will likely 
>> re-evaluate if we're again suffereing from a lack of "IHO-ness". 
>> 
>> SUMMARY #2 - A zoning estimate of 0.40m is harsh and will render a 
>> surveying platform incapable of acquiring data in waters shoaler 
>> than 48m that will satisfy IHO Order 1.  FA is proceeding with a 
>> value of 0.10m and is standing by for changes.  Likely someone from 
>> CO-OPS would be in a better position to provide such an estimate 
>> vice a group of JO's with their fingers orange from eating Cheetos. 
>> Thus far, CO-OPS has punted claiming lack of data - but that doesn't 
>> help our error model. 
>> 
>> This e'mail is long and I have a sudden urge for junk food.  I will 
>> close with also stating I believe sound speed error estimates 
>> suggested in HSTD 2007-2 are larger than necessary; however, since 
>> it does not result in greater than half of my data being deleted ... 
>> I will champion that cause another day. 
>> 
>> Opinions?  I would love to hear them (I've got a hundred screen 
>> shots I'm ~dying~ to share). 
>> 
>> ~~ mike.g. 
>> 
>> foo fairweather wrote: 
>> 
>> > -------- Original Message -------- 
>> > 
 
         Subject: MRU allignment error estimates 
     Resent-Date: Wed, 11 Apr 2007 18:40:18 GMT 
     Resent-From: FOO.Fairweather@noaa.gov 
            Date: Wed, 11 Apr 2007 18:32:59 +0000 



            From: FOO Rainier <foo.rainier@noaa.gov> 
              To: hydro.geek@noaa.gov 
              CC: ChiefST Rainier <chiefst.rainier@noaa.gov>, Jake Yoos 
                  <Jake.Yoos@noaa.gov>, Olivia Hauser 
                  <olivia.hauser@noaa.gov>, Samuel Greenaway 
                  <samuel.greenaway@noaa.gov>, CO Rainier 
                  <co.rainier@noaa.gov>, _NMAO MOP FOO Fairweather 
                  <FOO.Fairweather@noaa.gov>, _NMAO MOA FOO Thomas 
                  Jefferson <FOO.Thomas.Jefferson@noaa.gov>, _OMAO MOA 
                  FOO Rude <FOO.Rude@noaa.gov>, Mark Van Waes 
                  <Mark.Vanwaes@noaa.gov> 
>> > 
>> > Good morning, 
>> > 
>> > I believe that the MRU alignment error estimates recommended by 
>> > HSTD 2007-2 are too high.  The directive suggests that the MRU 
>> > alignment fields in the TPE section of the HVF be set to a values 
>> > with "similar magnitude to patch test values,"  with recommended 
>> > default values of 1 degree for both gyro and roll/pitch alignment. 
>> > In accordance with this guidance, RA set the gyro MRU alignment 
>> > error estimate to 0.5 degrees, and the Roll/Pitch estimate to 1 
>> > degree for all Reson-equipped launches prior to the beginning of 
>> > data acquisition.  We immediately found that ~2/3 of our swath 
>> > width was rejected by the IHO Order 1 TPE filter. 
>> > 
>> > I've attached an Excel worksheet showing examples of this effect 
>> > for a Reson 8101 operating in 15-20m of water.  The left-hand plot 
>> > shows a representative example of TPE values as a function of beam 
>> > number with MRU alignment errors set to 0.5 and 1.0 degree as 
>> > described above.  The right-hand plot shows a similar sample (not 
>> > the exactly the same soundings, but the same line and depth regime) 
>> > with the MRU alignment error estimates values set to 0 (which is 
>> > what we previously used). 
>> > 
>> > Obviously, zero error for alignment measurement is unrealistic; 
>> > however, the recommended values appear to result in absurdly high 
>> > depth measurement error estimation.  It seems that the HSTD was 
>> > written with the understanding that the MRU alignment error 
>> > estimate should be an estimate of the alignment error itself, not 
>> > an estimate of the error in the measurement of that alignment.  I 
>> > believe this interpretation is incorrect.  The alignment error 
>> > estimate is already taken care of by the patch test bias values in 
>> > the Swath entry.  High bias values, if carefully measured, are not 
>> > necessarily incorrect.  Thus, entering the alignment errors as 
>> > alignment measurement errors can result in incorrect TPE 
>> > estimation, as in the example attached. 
>> > 
>> > It's certainly difficult to estimate the quality of a patch test, 
>> > but it seems to me that a more accurate estimate would be to use 
>> > the standard deviation of the values computed by the various 
>> > personnel computing the test.  This would decouple alignment 
>> > measurement precision from the alignment accuracy itself, and 
>> > assign each to its correct place in the data reduction and error 
>> > estimation process.  On RAINIER, we have ~6 people looking at each 
>> > vessel's patch test, so that gives us a reasonable sample size. 
>> > Preliminary results of our patch testing indicate that this will 
>> > produce much smaller (though non-zero) alignment measurement error 



>> > estimates.  At this point, I plan to use these values instead of 
>> > those recommended in HSTD 2007-2;  we will, of course, document 
>> > this in the reports of those patch tests included with the affected 
>> > DAPRs.  However, I wanted to make others aware this potential 
>> > problem- it took us a while to figure out why our swath width had 
>> > mysteriously shrunk.  I also recommend that HSD consider re-wording 
>> > the HSTD to suggest this approach to the estimation of this value. 
>> > 
>> > Thanks, 
>> > 
>> > Ben 
>> > 
>> > 
>> > -- 
>> > LT Ben Evans, NOAA 
>> > Field Operations Officer 
>> > NOAA Ship RAINIER (s221) 
>> > NOAA Marine Operations Center, Pacific 
>> > 1801 Fairview Ave. E 
>> > Seattle, WA  98102 
>> > 
>> > 
>> > 
>> > -- 
>> > 
>> > ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ 
>> > LT Jennifer Dowling, NOAA 
>> > Field Operations Officer 
>> > NOAAS FAIRWEATHER 
>> > 1010 Stedman Street 
>> > Ketchikan, Alaska 99901 
>> > 
>> > 907 255-1807 or 1809 Ketchikan phone 
>> > 907 255-1808 Ketchikan fax 
>> > 
>> > 808 659 0054 at sea phone 
>> > 
>> > foo.fairweather@noaa.gov 
>> > at sea email size limit: 200k 
>> > 
>> 
>>     -------------------------------------------------------------- 
>>                                [Image] 
>> 
> -- 
> 
> ----------------------------------------------------------------------- 
> LCDR Richard Brennan, NOAA 
>   Chief, Hydrographic Systems and Technology Program 
> 1315 East-West Highway,SSMC3 
> N/CS11, Station 7853 
> Silver Spring, MD, 20910 
> Work: 301-713-2653 x152 
> Cell: 443-994-3301 
> 
 
 



 
-------------------------------------------------------------------------------- 
 
 
 
Thank you for the info Rick, it was ~exactly~ what I was looking for..  
 
While it is a shame to watch our data collapse in the face of IHO Order 1, it 
might just be the sad truth of Alaskan surveying:  given the tidal 
uncertainties, a definitive depth cannot be ascertained without an appreciable 
error envelope.  
 
I wish we could re-create your 14m IHO error in the field.  As I mentioned 
earlier, we were unable to survey past 48m and maintain IHO Order 1.  We'd used 
the exact error values suggested for the POS M/V and time latency suggested in 
HSTD-2;  Our offset erors are on the order of 7 mm; Loading and Draft 3 and 4cm 
respectively; we low-balled the SV at 1 m/s and left the Delta Draft, and MRU 
align errors as zero (since we had yet to compute the patch test).  This 
configuration blanked our swath in waters shoaler than 48m when filtered against 
IHO - but then, as you suggested, perhaps it is unrealistic to be expected to 
survey to IHO order 1 under these conditions.  If that's the case, I feel like 
there should have been a disclaimer presented to everyone during the west coast 
hydro training, "Hey gang, while we strive to satisty IHO, the reality is you 
won't be able to get there while surveying in the shallow waters.  How shallow?  
Well, anything shoaler than the Statue of Liberty is tall (46.84m - base to 
torch)."  
 
The picture will not improve when the delta draft and MRU errors are added to 
the model.  
 
I have attached a copy of our TPE spread sheet.  Do any of the values appear 
inordinately high to you that keeps us from reaching your 14m glass ceiling (or 
would it be a glass floor)?  
 
Is RAINIER having better luck than we?  
 
Thank you for your time, all.  
 
Regards,  
 
~~ mike.g.  
 
Richard T Brennan wrote:  
 
Hi Mike,  
Not sure if you saw my response to Ben, but I agree, the MRU alignment error is 
too big.  My recommendation was that the guidance should say "The MRU alignment 
error should be approximately the smallest unit of change in the HIPS 
calibration window which produces no noticeable change in the point cloud 
alignment."  I think this would yield a similar result to the method you are 
employing and not require a field party to have six people, or have six people 
look at their patch test.  
 
As for the zoning error, this value wraps up a lot of sins in one place and thus 
I would not suggest altering this without consulting CO-OPS.  The goal of 
populating the error model with the various system uncertainties is not to tweak 
them until they are "within spec", it is to give us an honest assessment of how 



good our measurements are.  The zoning model does not account for changes in the 
shape of the tide curve across the survey area (i.e. diurnal to semi-diurnal, or 
semi-diurnal to mixed, etc...), differences between the rate an area floods and 
ebbs, uncertainties in the datum, and inaccuracies induced by the interpolation 
method itself.  While CO-OPS may not be able to supply a definitive zoning error 
value for your survey area, they do use some judgment based on experience, and 
experience has shown that 0.4 is not an unrealistic value, particularly in 
Alaska.  While 0.4m for zoning error is not unheard of, it is larger than 
normal, so I would confirm with CO-OPS that this is indeed the correct value.  
While your data may appear to be internally consistent (no stereotypical tide 
artifacts), errors induced by uncertainties in the datum would not cause a 
visual artifact.    That said my computations show that you should be able to 
survey up to 14 m of water and still maintain IHO Order 1 with a 0.4m combine 
tidal uncertainty (that is the rms of  measurement uncertainty and zoning 
uncertainty).  I have attached a spreadsheet with my numbers in it.  Let me know 
if you have any questions regarding these values.  Hope this helps...  
 
Rick  
 
michael gonsalves wrote:  
 
** This e'mail is longer than the attention span of the average JO and ST - thus 
I present the summary at the beginning:  An MRU align error of 1.0 is too large; 
something on the order of 0.20 is a better estimate (want to know why ... then 
read on);  A tidal zoning of 0.40 is also too large, it makes it impossible to 
acquire IHO Order 1 data in waters shoaler than ~45m), I propose 0.10 as a 
better upper bound until CO-OPS commits to something better.   ...and now for 
the message -- mog **  
Wait, we can haggle over HSTD 2007-2?  
 
ITEM #1 - MRU Alignment  
FAIRWEATHER had identical problems to those described by LT Evans at the end of 
the previous field season.  An incorrect calculation led to MRU alignment errors 
~0.5 degrees which led to 2/3 or our swath being rejected as not satisfying IHO 
Order 1.  
 
I believe the spirit of the error is to report your reliability in the 
operator's ability to perform a successful patch test.  RAINIER has struck upon 
the proper approach having several people independently perform the patch test.  
At that point, the Standard Deviation of the patch test values can be used as a 
valid approximation of the MRU alignment errors.  This is the technique 
suggested by Dr. Calder to FA around this time last year.  The only caveat I 
would suggest is that the multiple evaluations of the patch test data must be 
performed in tandem; that is, all processors must agree on a value in the timing 
error before the group proceeds to calibrating for pitch (and so on).  Such a 
simultaneous approach is necessary due to the confounding of the various 
alignment errors (i.e. a pitch-induced artifact can be removed by adjusting 
timing).  
 
By the end of the field season, FA had settled on MRU align values of 0.25 for 
gyro and 0.15 for roll/pitch.  In my opinion, these values may still be on the 
conservative side.  But, with these values inserted into the hvf, filtering the 
data against IHO Order 1 resulted in all the wacky outbeams being rejected while 
the smooth continuous bottom was preserved.  Any parameters that leads to "poor" 
data being rejected while retaining the "good" is a step in the right direction.  
 



The redundancy in having multiple eyes view a patch test can only be taken so 
far however.  Sea state, speed of the vessel, validity of sound velocity 
profile, whether that pitch line was run ~exactly~ on top of the sonar-
conspicious target will dictate how valid a given set of patch lines are for 
accurately determining the sonar calibration.  It's like we're trying to 
calculate the average weight of any given Oreo by having a dozen people measure 
the weight of one specific Oreo.  Sure, you'll get a great estimate of the 
weight of Oreo-X, and sure Nabisco strives to make all Oreos equal -- but can 
that single (though repeated) measurement ~really~ be extrapolated to all 
cookies?  In magnitude, I would say yes (your single set of patch test values 
are valid), but I would say the error estimates of the patch values will be 
smaller than they really are.  Anyone feel like doing a week of patch tests to 
estimate the variability?  
 
SUMMARY #1:  1-degree is an inordinately large estimate of the MRU alignment 
errors.  Instead, compute the Std. Dev. of the values found during the patch 
test and those should give you a good low-end estimate.  Values in the ballpark 
of 0.25 for gyro and 0.15 for pitch/roll are reasonable estimates of a field 
units ability to accurately conduct a patch test.  
 
ITEM #2 - Tide values  
I'm curious how the field units are coping with the errors associated with tide 
measured and tide zoning.  The tide measured component is straight-forward and 
can be computed directly from the observed data (looking at past FA projects, 
0.01m is a reasonable median).  However I feel the tidal zoing error of 0.01 to 
0.40 is too large.  HSTD 2007-2 claims we will be given values in the Letter 
Instructions, but the reality of Alaskan survey work is there will seldom be 
enough historic data for CO-OPS to commit to a zoning error.  Speaking with the 
CST, we elected to high ball the error and use 0.40m when computing TPE (the 
thought process being, "Well ... it sure is a long way to the primary tide 
gauge."  
 
I do not know the exact equations involved when it comes to the assimilation of 
the various components of error in the TPE model, but a qualitative comparison 
can be made by varying the zoning error (ZE) and examining the changes in the Dp 
TPE for a subset of pings.  Incrementally increasing the ZE causes the vertical 
TPE (Dp TPE) of a given ping at nadir to converge on twice the value of the ZE, 
regardless of the initial Dp TPE.  See attached picture.  
 
It is worth repeating:  regardless of the Dp TPE of a given sounding with a zero 
ZE, inputting a ZE of 0.40 will lead to a Dp TPE for that same sounding to 
change to 0.80.  
 
Using the IHO error estimate (Sqrt[a^2 + bd^2]), this would imply all soundings 
collected in waters shoaler than 48m will automatically be rejected as having 
not satisfied IHO Order 1.  I wish I had a cookie analogy I could insert here.  
 
As of now, FA is proceeding with a zoning error of 0.10, since the pings still 
appear to retain an essence of the other uncertainties associated with the pings 
(alignment, POS/MV, precise timing, etc.).  Once we begin acquiring data in 
earnest, we will likely re-evaluate if we're again suffereing from a lack of 
"IHO-ness".  
 
SUMMARY #2 - A zoning estimate of 0.40m is harsh and will render a surveying 
platform incapable of acquiring data in waters shoaler than 48m that will 
satisfy IHO Order 1.  FA is proceeding with a value of 0.10m and is standing by 
for changes.  Likely someone from CO-OPS would be in a better position to 



provide such an estimate vice a group of JO's with their fingers orange from 
eating Cheetos.  Thus far, CO-OPS has punted claiming lack of data - but that 
doesn't help our error model.  
 
This e'mail is long and I have a sudden urge for junk food.  I will close with 
also stating I believe sound speed error estimates suggested in HSTD 2007-2 are 
larger than necessary; however, since it does not result in greater than half of 
my data being deleted ... I will champion that cause another day.  
 
Opinions?  I would love to hear them (I've got a hundred screen shots I'm 
~dying~ to share).  
 
~~ mike.g.  
 
foo fairweather wrote:  
 
-------- Original Message --------    
  
  
 Subject:  MRU allignment error estimates  
Resent-Date:  Wed, 11 Apr 2007 18:40:18 GMT  
Resent-From:  FOO.Fairweather@noaa.gov  
Date:  Wed, 11 Apr 2007 18:32:59 +0000  
From:  FOO Rainier <foo.rainier@noaa.gov>  
To:  hydro.geek@noaa.gov  
CC:  ChiefST Rainier <chiefst.rainier@noaa.gov>, Jake Yoos <Jake.Yoos@noaa.gov>, 
Olivia Hauser <olivia.hauser@noaa.gov>, Samuel Greenaway 
<samuel.greenaway@noaa.gov>, CO Rainier <co.rainier@noaa.gov>, _NMAO MOP FOO 
Fairweather <FOO.Fairweather@noaa.gov>, _NMAO MOA FOO Thomas Jefferson 
<FOO.Thomas.Jefferson@noaa.gov>, _OMAO MOA FOO Rude <FOO.Rude@noaa.gov>, Mark 
Van Waes <Mark.Vanwaes@noaa.gov>  
 
Good morning,  
 
I believe that the MRU alignment error estimates recommended by HSTD 2007-2 are 
too high.  The directive suggests that the MRU alignment fields in the TPE 
section of the HVF be set to a values with "similar magnitude to patch test 
values,"  with recommended default values of 1 degree for both gyro and 
roll/pitch alignment.  In accordance with this guidance, RA set the gyro MRU 
alignment error estimate to 0.5 degrees, and the Roll/Pitch estimate to 1 degree 
for all Reson-equipped launches prior to the beginning of data acquisition.  We 
immediately found that ~2/3 of our swath width was rejected by the IHO Order 1 
TPE filter.  
 
I've attached an Excel worksheet showing examples of this effect for a Reson 
8101 operating in 15-20m of water.  The left-hand plot shows a representative 
example of TPE values as a function of beam number with MRU alignment errors set 
to 0.5 and 1.0 degree as described above.  The right-hand plot shows a similar 
sample (not the exactly the same soundings, but the same line and depth regime) 
with the MRU alignment error estimates values set to 0 (which is what we 
previously used).  
 
Obviously, zero error for alignment measurement is unrealistic; however, the 
recommended values appear to result in absurdly high depth measurement error 
estimation.  It seems that the HSTD was written with the understanding that the 
MRU alignment error estimate should be an estimate of the alignment error 
itself, not an estimate of the error in the measurement of that alignment.  I 



believe this interpretation is incorrect.  The alignment error estimate is 
already taken care of by the patch test bias values in the Swath entry.  High 
bias values, if carefully measured, are not necessarily incorrect.  Thus, 
entering the alignment errors as alignment measurement errors can result in 
incorrect TPE estimation, as in the example attached.  
 
It's certainly difficult to estimate the quality of a patch test, but it seems 
to me that a more accurate estimate would be to use the standard deviation of 
the values computed by the various personnel computing the test.  This would 
decouple alignment measurement precision from the alignment accuracy itself, and 
assign each to its correct place in the data reduction and error estimation 
process.  On RAINIER, we have ~6 people looking at each vessel's patch test, so 
that gives us a reasonable sample size.  Preliminary results of our patch 
testing indicate that this will produce much smaller (though non-zero) alignment 
measurement error estimates.  At this point, I plan to use these values instead 
of those recommended in HSTD 2007-2;  we will, of course, document this in the 
reports of those patch tests included with the affected DAPRs.  However, I 
wanted to make others aware this potential problem- it took us a while to figure 
out why our swath width had mysteriously shrunk.  I also recommend that HSD 
consider re-wording the HSTD to suggest this approach to the estimation of this 
value.  
 
Thanks,  
 
Ben  
   
 
--  
LT Ben Evans, NOAA 
Field Operations Officer 
NOAA Ship RAINIER (s221) 
NOAA Marine Operations Center, Pacific 
1801 Fairview Ave. E 
Seattle, WA  98102 
 
 
 
--  
 
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ 
LT Jennifer Dowling, NOAA 
Field Operations Officer 
NOAAS FAIRWEATHER 
1010 Stedman Street 
Ketchikan, Alaska 99901 
 
907 255-1807 or 1809 Ketchikan phone 
907 255-1808 Ketchikan fax 
 
808 659 0054 at sea phone 
 
foo.fairweather@noaa.gov 
at sea email size limit: 200k 



Date UTC Time DLDG reading Sea Level Gauge ID Results
Pressure

08-31-2006 20:44:14 14.39 993 68332 Good
09-01-2006 21:46:49 14.51 1007 68332 Good
09-05-2006 19:14:18 14.67 1020 68332 Good

Diver Least Depth Gauge DQA 2006
OPR-P158-FA-06 Approaches to Cordova, Alaska

**Gauge 68322 stopped working after the 5 September reading and no new DLDG were 
obtained prior to the end of the field season**
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